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Alan  
Dexter

SUMMER IS OFTEN a quiet time for PC 
hardware, but this year things are 
different. We’ve had a slew of important 
releases hit our test benches all at 
once, and it could just be that the PC 
scene will never be the same again 
after this summer. Serious words, 
but reasonable when you’re talking 
about a new PCIe bus that will usher 
in the promise of incredible storage 
performance and improved graphics.

In case you’ve been hiding under 
a rock, AMD has released a new 
processor family as well as its much 
anticipated Navi GPUs this month, and 
(spoiler alert!) they’re both impressive. 
Admittedly, it’s the CPUs that really 
loosened our collective jaws, but thanks 
to Nvidia also releasing new GPUs, 
AMD was forced to drop the prices of 
its first Navi cards, so they represent 
much better value than expected.

Of course, Nvidia’s new “super” 2060 
and 2070 are interesting in their own 
right, but they highlight once again that 
competition is good for us, the end user. 
Manufacturers dropping prices to make 
their products more tempting always 
goes down well. The same is true in the 
CPU space—Intel is guilty of resting on 
its laurels, but now it genuinely needs 
to respond, or it’ll find itself lagging 
further and further behind. Price drops 
from Intel in lieu of new thread-happy 
chips aren’t out of the question. 

One area where AMD has come on 
in leaps and bounds over the original 
Ryzen is on the memory front. It’s no 
secret that while the original Ryzen 
was an impressive shift in gear from 
Team Red, memory support at launch 
was patchy. It improved over time, to be 
sure, but that was one area where Intel 
definitely had a lead in terms of ease 

of use. These new Ryzen chips have no 
such problems; in fact, AMD is pushing 
memory harder than Intel right now.

Which brings us nicely to the whole 
subject of RAM, and our main cover 
feature. What is the optimal amount of 
memory for any given system? What’s 
more important: capacity, frequency, 
latency, or price? We show you how 
to improve this often overlooked 
subsystem, while ensuring you don’t 
waste money where it isn’t needed.

Our other main feature looks at what 
5G will mean to you, and where our PCs 
fit in—it isn’t just about cell phones 
anymore. With promises of connections 
in the remotest of places, super-low 
latencies, and the kind of bandwidth 
that is normally the preserve of fiber, 
5G promises a lot. But can it deliver? 
Turn to page 44 to find out.

Another interesting new release is 
the Raspberry Pi 4. The tiny computer 
has seen many improvements over the 
years, but the most recent iteration 
really shifts up a gear, with a speedier 
CPU, improved memory, better buses, 
and support for dual displays up to 4K. 
It is genuinely becoming a viable budget 
desktop machine. We also show you 
how to build a NAS, get up and running 
with Docker, protect your network with 
an SSH honeypot, and much more.

I hope you enjoy the issue!

SECOND-GENERATION  
ZEN IS A GAME CHANGER

Alan Dexter is Maximum PC’s executive  
editor and a punisher of hardware. He’s been 
a tech journalist for over 20 years, and has no  
problem upsetting the PC industry as a whole.
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Zen 2 server chips meet every expectation

AMD’s Epic EPYC
that Intel’s top Xeon is $10,000 
or so, Rome is competitive as 
well as fast; we expect nothing 
less from AMD these days. 
There’s still a fight ahead, 
though. The Xeon has specific 
advantages, such as cache 
and memory latencies, which 
help some applications that 
need quick responses, such 
as databases and analytics. 
Intel has considerably more 
resources, too—it actually has 
more software engineers than 
AMD has employees in total.

One reason why Rome looks 
like such a serious contender 
is that the chip it was designed 
to go head to head with, Intel’s 
Ice Lake Xeon, isn’t ready yet, 
so it will debut against the 
established Cascade range, 
which still uses the Skylake 
architecture on a 14nm 
process. So, will AMD sell 
them by the bucketload, and 
capture the market? No. It’s 
not that simple. There’s more 
to capturing market share 
than being competitive. AMD 
hopes to reach a 10 percent 
share of the server market by 
2020, which looks likely. Dell, 
for example, plans to triple 
its AMD offerings. Depending 
on which figures you use, the 
company currently has about 
5 percent. If things go well, 

it could be looking at up to 
15 percent within two years. 
Quite a feat, given AMD started 
practically from scratch with 
its first-gen EPYC. AMD has 
captured some trophies, 
too, including supplying 
Rome chips for what will be 
the world’s most powerful 
supercomputer, Frontier, 
being built at the Oak Ridge 
National Laboratory. Rome 
will be another headache for 
Intel, one with a financial edge. 

Meanwhile, the Zen 2 Ryzen 
3000 series has started to 
reach paying customers—
and us, too. See what we 
make of it on page 72. One 
unexpected hitch has been 
with the game Destiny 2, which 
fails completely, hanging on 
launch. This required the rapid 
distribution of a BIOS fix to sort 
out. Those hoping to overclock 
their 3000s are going to be a 
little disappointed; there’s not 
much headroom on the first 
batch. AMD likes to squeeze as 
much as it can out of any given 
chip, and sell it running at as 
close to its maximum potential 
as possible. Unlike Intel, which 

has a habit of moving chips 
about a bit to fill gaps in its 
range. Ryzen 3000 sales have 
been buoyant—Amazon’s best 
sellers list puts the Ryzen 9 
3900X at its head, and AMD 
occupies seven of the top ten 
slots. It’s not exactly a good 
indicator of actual sales, given 
how important corporate 
buyers are, but it shows what 
people go for when they have a 
free choice.

Elsewhere, an internal 
memo at Intel has been 
leaked online, which makes 
interesting reading. It gives 
a potted history of the two 
companies’ rivalry, and what 
Intel can do to check AMD’s 
resurgence. The author admits 
that Intel hasn’t faced such 
a challenge since the early 
2000s. It’s clear the company 
knows where it has failed, and 
what to do to recover. Intel 
is 10 times the size of AMD, 
and dedicated to staying that 
way. The good news is that 
such competitiveness leads to 
innovation—we haven’t seen 
chip designs forge ahead like 
this in years. –CL

FOLLOWING the launch of 
AMD’s Zen 2 desktop chips, the 
next step is Zen 2 server chips, 
EPYC. Get this right, and there 
are fortunes to be made, and 
AMD looks to have got it right. 
Its new EPYC 7002 series, code 
name Rome, is due very soon, 
and numerous details have 
leaked out. The initial range 
apparently runs to 19 variants, 
from eight-core entry chips 
at under $500, through to 
64-core monsters, which pack 
eight of AMD’s eight-core Zen 
2 chiplets into one processor. 
They all carry a decent amount 
of L3 cache, from 32GB up to 
a laudable 256GB. TDPs run 
from a quite cool 120W to a 
warm but not overly hot 225W. 

We thought it was going 
to be fast, now we know. An 
unverified submission to the 
SiSoft database of an EPYC 
7702P, one step down from 
the halo 7742, put it at the top 
of the rankings. It looks as if 
AMD’s demonstrations earlier 
in the year, where a prototype 
chip humbled a dual-chip 
Xeon Platinum 8180M system, 
weren’t all spin. Rome will be 
priced keenly, for server chips: 
The range tops out at under 
$8,000, with the single-socket 
64-core chip costing $4,900. 
All unconfirmed as yet. Given 

It looks as though AMD’s 
earlier demonstrations of a 
prototype weren’t all spin.

AMD’s second-

gen EPYC chips 

are very strong—

and potentially 

very lucrative.
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FACEBOOK PAYS 
$5 BILLION

New packaging tech

TRIUMPHS TRAGEDIES
AMAZON SPACE PROGRAM
The company plans to launch 
3,236 satellites and build a 
global high-speed Internet 
network, code-named Kuiper.

TAKE ON DEEPMIND
The AI machine’s AlphaStar will 
star as an opponent on some 
StarCraft II servers. 

NEW APOLLO MISSION
A computer restorer has 
managed to get an Apollo 
Guidance computer to mine 
bitcoin—very, very slowly.

UNPACK AT YOUR PERIL
A researcher has built a new 
zip bomb that doesn’t use 
recursive data, and packs 
4.5PB in a 46MB file.

6,000 EXABYTES LOST
A power failure at five of 
Toshiba’s memory foundries 
cost six weeks’ production; 
prices are expect to rise.

COMPULSORY MALWARE
In parts of China, border guards 
install malware on visitors’ 
phones to extract personal data.

A monthly snapshot of what’s good and bad in tech  

Tech Triumphs and Tragedies

MACBOOK KEYBOARDS have a tendency to break. 
The problem first appeared on 2015’s MacBook, 
but it took Apple until June 2018 to admit there 
was a problem and start paying for repairs. The 
butterfly switch mechanism used means even a relatively small piece of 
dirt or debris that works its way under a key can cause it to stop working. It 
seems Apple is finally going to change the mechanism to the scissor design 
it used before 2015. Apple hasn’t officially announced this yet, but it has 
applied for patents for a new scissor switched keyboard. Why no official 
announcement? Because the new design isn’t ready yet, and Apple has just 
refreshed its MacBook Air and MacBook Pro models, which have the butterfly 
keyboards. Thankfully, they’re eligible for free repairs if things go wrong. –CL

Butterfly design could go

APPLE TO FINALLY 
FIX KEYBOARDS?

AS IT THREATENED, the Federal Trade Commission has 
hit Facebook with a $5 billion fine for its infringements 
of privacy (handing out the personal data of 50 million 
people to a third party). As part of the ruling, Facebook 
has to review and document the way it handles data.

Bad news for Facebook? Not really. It’s a large sum, the largest ever imposed by 
the FTC on a technology company, but Facebook had been expecting it, and budgeted 
accordingly. The company had set aside over $3 billion, and has cash reserves of 
over $40 billion. Investors weren’t worried either; the stock price rose by 1.8 percent 
immediately after the announcement. If anything, the ruling has shown that Facebook 
is too powerful to be affected by such actions. However, there are signs that Congress 
and the Senate are running out of patience. Facebook is being quizzed by the Senate’s 
Banking Committee over its forthcoming digital currency, Libra, and it has not been 
friendly. Libra is a big deal for Facebook, and legal disruption here could hurt. –CL

FINE DOES LITTLE DAMAGE

THE PHYSICAL CONSTRUCTION of chips is 
becoming increasingly important. You can 
only shrink a chip so far before the basic 
laws of physics interfere. AMD’s Ryzen 
3000 series has introduced the chiplet 
design to the mainstream. Intel has been 
working on similar tech for years, has 
bought companies working in this field, 
and invested billions. At the SemiCon West 
trade show, it showed off the results: three 
new technologies for packaging chips. 

Intel already uses EMIB (Embedded 
Multi-die Interconnect Bridge) and 
Foveros (chip-stacking technology). EMIB 
is a way to put a number of chips together 
on one package, using a interposer layer 
embedded into the substrate, while 
Foveros is a method of stacking chips on 
top of each other. EMIB is used on Kaby 
Lake G chips, and Foveros is due to appear 
soon on early mobile Ice Lake chips.

Intel has developed a way of combining 
these two methods into a new process, 
putting multiple layers of multiple chips 
on a substrate, each chip able to connect 
horizontally and vertically. This is co-
EMIB, combined EMIB. It uses two other 
techniques: MDIO (a physical interface for 
chip stacking) and ODO (Omni-Directional 
Interconnect, a new process to build 
interconnects in any direction). And, yes, 
this is starting to sound like an electrical 
engineering class. What’s important is 
that it enables Intel to piece together chips 
from slices of silicon made using different 
processes, arranging each element to 
best advantage, and the entire group can 
exchange data on-chip at high speed.

You could say that Intel is talking about 
this now because it has no new processors. 
However, as traditional design methods 
reach the buffers, processor packaging 
is going to be a very big thing, and Intel 
has made impressive strides. There are 
problems, specifically the distribution of 
power, and the heat it generates, which 
is why the designs are appearing on low-
power mobile parts first, but it is the 
future, and Intel has some class-leading 
technology in the pipeline. –CL 

INTEL’S CHIP 
SANDWICH
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HOME AUTOMATION is rapidly becoming 
a battleground between the tech giants, 
notably Google and Amazon. Smart 
speakers are now firmly established as 
part of the digital furniture, but Amazon 
has plans to go further—its Lab126 is said 
to be working on a home robot, code name 
Vesta. Prototypes have been described 
as waist height, wheeled, and navigating 
using an array of cameras. It has been 
demonstrated responding to voice control 
by being summoned. 

What you do with it is another question. 
A mobile smart speaker is moderately 
useful, but it has to be easier to just buy a 
couple more Echo Dots. And if you’ve ever 
wondered why the Echo Dot is so cheap, 
it’s because people with smart speakers 
spend more on Amazon. Researchers 
have estimated that regular Amazon 
Prime users spend $1,300 a year on 
Amazon goods and services, while those 
with a smart speaker spend $1,700. 

Currently, the best home robots 
are either toys or dedicated to a single 
task, such as being a vacuum cleaner. 
Something that is truly multi-purpose, 
and genuinely useful, has evaded us as 
yet. The Asus Zenbo is one such attempt—
it isn’t cheap, costing $600-$900, and it 
doesn’t do much more than be a smart 
speaker and digital camera that can 
follow you around (although you’ll have to 
open doors for it unless they are “smart,” 
too). The Zenbo is licensed for US sale, 
but hasn’t made it beyond Taiwan as yet. 
Despite early design awards, and the first 
batch selling out quickly, interest and 
backing has waned. Amazon has made 
no public announcements on its robot 
project, although something is brewing 
at Lab126, because engineers have been 
pulled from other projects to work on it. 
This could be fun. –CL

The sci-fi trope could be 
coming to live with you

AMAZON 
PLANNING A 
HOME ROBOT

Raspberry Pi 4 
Practically a PC
The Raspberry Pi has reached its 
fourth major incarnation, and has 
received a bump in power with 
the quad-core Cortex processor 
now running at 1.5GHz. There’s 
dual-HDMI with support for 4K 
at 60Hz. It also gets a pair of USB 
3.0 ports, so you can easily attach 
some speedy peripherals. The Pi 
has now reached the point where 
it can be used to build a workable, 
if basic, desktop machine for 
under $100. Twenty-five million Pi 
boards have been sold so far. Quite 
a feat for something designed 
as a teaching aid for computer 
science students. You’ll want the 
4GB model if you plan to use it for 
streaming video or browsing the 
net. Read our review, page 79. –CL

DisplayPort 
Hits 16K
The Video Standards Authority has 
made the biggest update to the 
DisplayPort standard since it was 
defined in 2007, with version 2.0. 
Max resolutions have been pushed 
to 16K, and bandwidth has tripled 
to 80Gb/s. This equates to running 
two 8K 120Hz HDR screens at 
once. We have higher refresh 
rates, and expanded HDR support 
across the board, as well as data 
mapping. Everything is backward 
compatible. This is just in time: 
Monitors are starting to go beyond 
4K; Apple has 6K screens, and 
others have gone beyond that. TVs 
have reached 8K. We can expect 
compliant monitors in the next 
round of model refreshes, starting 
early next year. –CL

Switch Lite This Fall
NINTENDO HAS A NEW VERSION OF ITS SWITCH CONSOLE, and it’s not what pundits 
were expecting. The Switch Lite is a smaller, all-in-one handheld version, with built-
in controllers. Gone is the Switch’s innovative two-in-one design, and it’s back to 
basics. Nintendo’s two biggest-selling consoles ever, the DS and Game Boy, were 
handheld, and only the PS2 has sold more than the DS. The Switch Lite is pitched as 
an upgrade for the 150 million people who want their Nintendo gaming handheld.

The Lite is, of course, lighter and smaller: The 720p screen drops from 6.2-inch 
to 5.5-inch. It’ll play any Switch game that supports handheld mode. However, you 
won’t be able to play games that require motion detectors, although it will sync to 
Joy-Con controllers. There’s no TV output, HD rumble, or kickstand. The innards 
are as its big brother, though, with 32GB of expandable storage, and custom Nvidia 
Tegra silicon. The battery is a bit smaller, and said to be good for three to six hours.

The integrated controller has raised worries about reliability. The Switch’s Joy-
Con controllers had a nasty habit of developing “Joy-Con drift,” where it continuously 
registers a movement. Infuriating, but at least you could replace the controller. Let’s 
hope the new version has seen a spot of re-engineering, or is at least easy to fix.

Nintendo’s Switch has been a huge hit, selling over 34 million units since its launch 
in March 2017. A technically improved Switch 2 has been rumored for some time, but 
not this year, it seems. The Switch Lite can be yours for $200 this September. –CL

Nintendo’s Switch Lite 
will cost $100 less 
than the original, and 
come in yellow, gray, 
or turquoise.
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Jarred Walton

TECH TALK
Jarred Walton

TECH TALK

Jarred Walton has been a  
PC and gaming enthusiast  
for over 30 years.

Chip Yields, Binning, and 
the Silicon Lottery

That “nearly” is important. Small impurities in the 
wafers can lead to errors or non-functional parts. 
It’s not just impurities, though; the crystalline 
structure of the wafer also varies slightly. Chips 
from the center of a wafer tend to be “better” than 
those near the edge, so they may require less 
voltage to hit the same clock speed, or may run at 
higher clock speeds at the same voltage.

Because of the complexity of modern CPUs and 
GPUs, rather than having one failed circuit ruin the 
whole chip, redundancies are built into the design, 
and it’s possible to disable portions of a chip. Take 
AMD’s new Ryzen CPUs, where everything from 
the Ryzen 5 3600 up through the Ryzen 9 3950X is 
built using the same eight-core CCD (core chipset 
die) that measures 74mm2. The 3600/3600X and 
3900X all use CCDs with only six cores enabled, 
while the 3700X/3800X and upcoming 3950X use 
CCDs with all eight cores enabled. Why would AMD 
disable two CPU cores in each CCD on some parts? 
To improve chip yields and overall profitability.

Each silicon wafer contains potentially hundreds 
of chips, but not every chip from a wafer behaves 
the same. After the initial manufacturing process, 
each wafer gets cut into chips. These are tested 
to determine how good each is in a process called 
binning. Some may work perfectly, others may be 
effectively useless, while many fall somewhere in 
between. The percentage of functioning chips is the 

THE PRIMARY BUILDING BLOCK of modern computers 
is the silicon microchip, made from 300mm silicon 
wafers, cut from a large silicon crystal cylinder. The 
monolithic crystals are grown from a seed crystal 
dipped into a molten vat of nearly pure silicon.

yield. Most companies don’t report 
their yield, though rumors and 
estimates suggest that Intel’s first-
gen 10nm process had yields in 
single digits: Less than 10 percent 
of the potential 10nm processors 
were viable—and that’s after Intel 
disabled the Gen10 graphics, 
and with a small dual-core die. 
In contrast, it’s estimated that by 
harvesting partially functioning 
dies, yields for AMD’s new Zen 2 
parts may be 85 percent or higher.

This is important as each wafer 
has a relatively fixed cost—perhaps 
$7,000–$10,000. This is also why 
smaller chips are preferable to 
larger ones, as more can fit within 
the space of a wafer. A small 74mm2 
chip like Zen 2 has a potential of 
nearly 800 chips per wafer, while 
Intel’s 10-core Skylake-X chips 
are around 322mm2 and only fit 
about 170 per wafer. With a defect 
density of 0.1 per cm2, the 10-core 
Skylake-X might lose up to a third 
of the potential chips (without 
harvesting), while the Zen 2 CCD 
would only have about 8 percent 
defective chips.

Binning addresses multiple 
aspects. Firstly, there’s the 
harvesting of partially functioning 
dies—so your RTX 2060 that uses 
the same TU106 GPU as the 2070 
only has 30 out of a potential 36 SMs 
enabled, as well as two memory 

controllers disabled. Binning also 
determines the ideal voltage and 
frequency, and sometimes a chip 
that is otherwise fully functional 
might get downgraded because 
it can’t run at the desired speed. 
AMD’s RX 5700 and RX 5700 XT use 
the same Navi 10 GPU, but besides 
having 256 fewer cores, the 5700 is 
clocked about 150–200MHz lower.

The best chips are sold as the 
fastest, most expensive parts, 
while the functional but not quite 
as good chips are sold as lower 
tier parts. However, the gap 
between the “best” and “worst” 
functional chips from a wafer 
may be quite small. But for newer 
manufacturing nodes like TSMC’s 
7nm or Intel’s upcoming 10nm, the 
gap is more likely to be larger. So, 
you won’t hit the same clock speeds 
on second or third tier products, 
no matter how hard you try to 
overclock. Unless you’re lucky, and 
win the silicon lottery with a great 
chip sold as a second-tier part.

Some chips may work perfectly, 
others may be useless, many 
fall somewhere in between. 

Intel’s 10nm process has changed 

significantly to improve yields for 

the upcoming Ice Lake CPUs.
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Much Ado About 32
CANONICAL RECENTLY MADE WAVES in the Linux 
gaming community by announcing that it would 
be dropping 32-bit support from Ubuntu 19.10, 
to which Valve announced that it would cease 
supporting Ubuntu. What’s the big deal?

Canonical planned to mothball 
32-bit support for reasons of 
security and stability.

If you’re under a certain age, you might not 
remember purchasing a 32-bit system or CPU for 
a build. The last 32-bit system I bought was my 
Asus EeePC—which has an Intel Atom N270—back 
in 2009. For most PCs still running today, there’s 
a darn good chance that it’s a 64-bit system. Hell, 
even a Raspberry Pi or your smartphone is 64-bit.

That’s a good thing: Most desktop systems 
today come with at least 8GB of RAM. Most laptops 
you can buy rarely have less than 8GB as well. 
Because of the limited address range available 
to 32-bit CPUs, most OSes don’t have more than 
4GB of addressable memory on a 32-bit system. 
The advance of 64-bit systems has been partly 
responsible for systems with large filesystems, 
large amounts of memory, and larger file sizes.

If you’re not up on your computer science, here’s 
a quick refresher: A 64-bit system is said to have 
264 bits for its largest integer value, equivalent to 
about 8 bytes per integer. In comparison, a 32-bit 
integer is 232 bits, or about 4 bytes. A 16-bit integer 
has 216 bits, or two bytes.

So the question comes up: If the world of 
consumer electronics is effectively 64-bit, why on 
earth does 32-bit support matter?

The simple answer is that some programs or 
libraries are still distributed as 32-bit. While 64-
bit systems can run 32-bit programs, it requires 
some translation, because of the differences 
in memory addresses and other programming 
nuances. This is why a 64-bit Linux system 

requires a slew of 32-bit libraries 
to run a 32-bit program. The 
collection of libraries needed for 
32-bit compatibility is essentially 
a copy of 64-bit versions that may 
already be on the system. This 
means that you could potentially 
double the storage requirements 
for the system’s libraries at worst, 
and increase the complexity of the 
installed system at best.

What started the hullaballoo in 
the Ubuntusphere was the notion 
that 32-bit packages and libraries 
are rarely used, and by extension, 
rarely patched or updated. (Again, 
few people actually run native 32-
bit systems.) Because there aren’t 
that many eyes looking at the 32-

bit packages or code, Canonical 
planned to mothball 32-bit support 
for reasons of security and 
stability. In a blog post, Canonical 
specifically cited Spectre and 
Meltdown as vulnerabilities that 
have no mitigation in 32-bit.

The original announcement 
drew concern from gamers and 
creatives (using Ubuntu Studio) 
who rely on 32-bit compatibility 
to run key pieces of software. 
Valve noted in a post that Steam 
and many of the Steam games 
available for Linux are 32-bit. 
WINE, the Windows compatibility 
layer for Linux, also makes heavy 
use of 32-bit libraries. 

Canonical’s response was to 
continue providing access to 32-bit 
libraries, but with a warning that it 
could not guarantee the security 
of a system when running them. 
Canonical said that Ubuntu will 
work with app developers to deploy 
32-bit programs in containers, with 
all the required libraries bundled 
with them. That way, a user doesn’t 
have to maintain and update 32-bit 
libraries from a repo. This will 
shift the responsibility for keeping 

a library updated from the user 
to the app developer. 

While 32-bit systems 
are a thing of the past 
for most of us, there’s 
still a large number of 
32-bit applications. Until 

every legacy program 
is rewritten or compiled 

for 64-bit, we need extra 
libraries to run them. 

Old programs never die, 
they just require additional 

compatibility layers to keep 
them running.

Alex Campbell is a Linux geek 
who enjoys learning about 
computer security.
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8 MOST EXCITING FEATURES OF THE RASPBERRY PI 4

NATIVE GIGABIT 
ETHERNET
Previous Raspberry Pi models 

were capped at 300Mb/s, but the Pi 4 
can now supply the full bandwidth.

BLUETOOTH 5.0
Not much to talk about here. 
Bluetooth 5.0 goes faster, 

further, and draws less power than 
its predecessor, Bluetooth 4.2.

UPDATED 
VIDEO 
DECODE
Resolution 
isn’t the only 
thing that’s 
improved; the 
new hardware 
decode of HEVC 
video supports 
up to 60fps, 
double the 
Raspberry Pi 3.

UP TO 4GB 
OF DDR4

The Raspberry 
Pi 3 had 1GB 

of RAM at 
LPDDR2, while 

this model 
comes in 

three flavors: 
1GB, 2GB, or 

4GB, all at 
crisp LPDDR4 

speeds.

1.5GHZ 
QUAD-CORE 
CPU
A new 64-bit 
ARM Cortex-A72 
processor from 
Broadcom 
promises 
maximum 
performance 
figures up to 
three times 
as fast as 
the previous 
Cortex-A53 CPU.

MICRO 
HDMI 

PORTS
With two 

Micro HDMI 
ports, the 

Raspberry Pi 
4 can support 
two monitors 

in 1440p, or 
one monitor 

in 4K.

USB 3.0
The number of USB ports 

hasn’t changed, but 
they’ve been upgraded: Two of the 

four ports now support USB 3.0.

USB-C POWER
While the voltage might still be 

capped at 5V, the Raspberry 
Pi 4 swaps from Micro-USB to a 

USB-C power connector.
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THIS MONTH THE DOCTOR TACKLES...

↘ submit your questions to: doctor@maximumpc.com

> Linux on the Go
> AMD Upgrades
> Cryptic BSODs

Mobile Linux
Dear Doctor, I am trying 
to install Ubuntu on my 
HP Stream Notebook. The 
problem I’m having is that 
I can’t get the notebook to 
boot from my USB drive. 
Please help! –Matthew Parr

THE DOCTOR RESPONDS: It 
sounds like you’ve already 
downloaded Ubuntu and 
created a bootable thumb 
drive. But the notebook’s 
eMMC storage device is the 
first device it looks to at 
startup, so Windows loads 
before the UEFI even sees 
your USB key. The fix should 
be as simple as rearranging 
the firmware’s boot order.

With the USB drive plugged 
in, repeatedly tap F10 as the 
Stream powers on. If you’re 
successful, the HP Setup 
Utility should appear. If not, 
it’ll continue loading Windows 
and you’ll have to try again. 
Once the UEFI opens, go to 
the “Storage” tab and scroll 
down to “Boot Order.” Under 
“Legacy Boot Sources,” find 
the USB key and make sure it 
appears before “Hard Drive” 
in the list. Press F10 to accept 
the selection. Now tab over 
to the “File” menu and choose 
“Save Changes and Exit.”

The next time you boot up, 
your notebook should start 

with the thumb drive you 
prepared. Just remember 
to switch your hard drive 
back to the first position once 
Ubuntu’s installer finishes.

Next-Gen AMD
Hi Doc, I am finally upgrading 
to Windows 10, but I want 
to mirror my current setup, 
and have some concerns. I 
use the C: drive as system 
storage, while the D: drive 
is a data disk. I remember 
having to manipulate the 
registry to stop software 
automatically installing to C:, 
so the drive could be smaller. 
Is this the case with Win 10?

I’m also considering 
building a new system and 

have a question about AMD’s 
Ryzen processors. Is it worth 
waiting for the company’s 
next generation of chips and 
X570 chipset, or should I 
move forward with its X470-
based platform and a Ryzen 
7 2700X that I upgrade later? 
This machine will be tasked 
with moderate gaming, 
moderate photo editing, and 
all my other everyday tasks.

Also, what components 
would be potentially affected 
by the AMD X570 chipset? 

  –Thom Mason

THE DOCTOR RESPONDS: Be 
careful with registry-based 
modifications that change 
the location of your Program 

Files folder. Although there 
are numerous tutorials 
online explaining how to 
alter Windows 10’s default 
installation directory, most 
of them are also loaded with 
comments complaining about 
unanticipated side effects. 
Microsoft even has a Windows 
support page stating it 
doesn’t support changing 
the location of the Program 
Files folder by modifying 
the ProgramFilesDir 
registry value.

If you want to free up 
space on your C: drive, try 
less invasive relocations. The 
Doc moved his Documents 
folder to a networked storage 
appliance by right-clicking 
it, selecting “Properties,” 
tabbing over to “Location,” 
and redirecting the contents 
to his E: drive. That saved 
almost 250GB on his priciest 
SSD. You can also change the 
default install directory of 
applications downloaded from 
the Microsoft Store by clicking 
“Start > Settings,” then 
“System.” Select “Storage” 
from the left-hand pane, 
then scroll down to “Change 
where new content is saved.” 
In that submenu, you have 
the option to redirect new 
apps, documents, music, and 
so on. This works best if you 
configure it on a fresh copy of 

HP’s low-cost Stream notebooks include Windows 10, but make 

excellent candidates for a lightweight OS, such as Ubuntu, too.

quickstart
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Windows, because it doesn’t 
apply retroactively.

Talking of new installations, 
AMD’s third-gen Ryzen CPUs 
will be available by the time 
you read this, and they’re 
definitely worth the step 
up from prior models. Not 
only do you get more cores 
for your money, but 7nm 
manufacturing means the 
latest processors still fit into 
friendly power envelopes. 
Improved instruction-per-
cycle throughput, larger 
caches, and lower memory 
latencies are all reasons to 
consider an upgrade.

The X570 chipset is the first 
with PCI Express 4.0 support. 
AMD’s Radeon RX 5700 and 
5700 XT graphics cards are 
already compatible with its 
higher transfer rates, as are 
several just-released SSDs. 
As new graphics, storage, and 
networking processors are 
released, many will exploit the 
increased throughput PCIe 4.0 
offers to squash bottlenecks 
that PCIe 3.0 imposed. Beyond 
a faster bus, X570 offers up to 
eight USB 3.1 Gen 2 ports, and 
there’s no such thing as too 
much USB connectivity.

Fix or Upgrade?
Doc, I built my PC in 2014, 
using an Asus Z97-PRO, an 
Intel Core i7-4790K, 16GB of 
memory, a recycled Radeon 
HD 5570, and a PC Power 
& Cooling Silencer 750W 
PSU. I run six hard drives, 
two of which are set up as 
RAID 1. My boot drive is a 
1TB Samsung 850 EVO.

I’m having some issues 
with the system. When it 
reboots, the PC hangs on 
Asus Q-Code 64. Per the 
manual, that corresponds 
to “CPU DXE initialization 
is started,” which isn’t 
particularly descriptive. If 
everything locks up for two 
or three minutes, I hit the 
reset button and start again. 
Sometimes I have to repeat 
this process a couple of 
times before I get to the boot 
screen. Unfortunately, I think 
this machine is on its way out 
to pasture. Do you have any 
ideas about what could be 

wrong, or would I be better 
off starting a new build?

If I go with something new, 
I’d like a modern machine 
built on an Intel processor. 
What would you recommend 
in the 4790K’s original price 
range from the current Core 
i7 or Core i9 family? I’ll also 
need a motherboard able 
to support the new chip—
something comparable to my 
Asus Z97-PRO.

I’m not into gaming, so I 
think that any modern CPU’s 
integrated graphics will be 
way ahead of my Radeon 
HD 5570, and the only 
overclocking I’m interested 
in is what the motherboard 
can do automatically. I run 
nanoCAD and Office 2019, 
plus Plex for TV viewing 
over Wi-Fi. The most 
important software I run is 
Virtual Weather Station for 
reporting readings to the 
National Weather Service 
private weather station 
program, so uptime is of the 
utmost importance (I can go 
41 hours before I start losing 
weather station data).

At the very least, I’m 
looking for a new ATX 
motherboard, a processor, 
and at least 16 to 32GB of 
memory. I wanted to wait 
another year for Intel to get 
its act together on 10nm 
manufacturing, but I might 
not have a choice if my 
system can’t be fixed. Any 
recommendations you can 
make would be appreciated.

   –Edward Carl Knack

THE DOCTOR RESPONDS: Your 
system is locking up during its 
Driver Execution Environment 
phase, which consists of 
several steps, and is thus 
difficult to troubleshoot. There 
are, however, several options 
you can try.

Are you running the 
motherboard’s latest BIOS? 
The first version dropped in 
May 2014, while the newest 
build was published in 2018. 
Asus’s release notes for 
almost every update state 
“Improve system stability.” 
There’s a fair chance that 
whatever is causing your 

system to hang was addressed 
along the way.

If that doesn’t help, test 
your memory modules 
by removing one, then, if 
necessary, swapping them. 
Check if the DIMMs are 
configured to operate at a 
more aggressive data rate 
than they officially support. 
Even if not, try dialing them 
down to a more conservative 
setting and see if stability 
improves. Continue by 
disconnecting USB-attached 
devices, one by one, to see if 
they’re interfering with your 
system’s initialization process.

Hopefully, one of those tips 
helps breathe enough life into 
your system that you can wait 
the year you planned. But if 
you decide to pursue a new 
build anyway, it sounds like 
you could get by with relatively 
mainstream components and 
save significant money. Intel’s 
Core i5-9600K does a great job 
balancing reasonable pricing 
with screaming performance 
from six execution cores 
and a boost frequency of up 
to 4.6GHz. Its UHD Graphics 
630 engine is nothing to write 
home about, but if you have no 
real need for 3D graphics, it 
should suffice.

Decoding BSODs
Hello Doctor, I am a long-
time subscriber and owe 
much of my building skills 
to Maximum PC. One of my 
newer systems is running 
Win 10 Pro, a Core i7-7820X 
CPU, 64GB (four 16GB sticks) 
of Corsair Vengeance DDR4 
memory in an SO-DIMM form 
factor, an ASRock X299E-ITX/
ac mobo, a GeForce GTX 1060 
6GB, and a 1TB Samsung SSD 
960 Pro. All that hardware is 

stuffed into a Lian Li PC-Q37 
mini-ITX case.

Everything was good 
until a few weeks ago. I 
ran a search using Chrome 
and was hit by a BSOD. As 
Windows 10 typically bounces 
right back after a restart, 
I figured it was a fluke. I 
haven’t figured out what 
happened, though. I use the 
rig for video rendering, and I 
don’t game. I’ve had no other 
issues. I simply cannot use 
Chrome without crashing.

I’ve tried deleting and 
reinstalling Chrome via safe 
mode. I ran virus scans. I 
wiped the drive, reformatted, 
and reinstalled Windows. 
I even stripped the system 
down and reseated all the 
hardware. The problem 
persists. Sometimes the 
PC freezes right away when 
I try to open Chrome and I 
get a blue screen that says 
“WHEA_UNCORRECTABLE¬_
ERROR.” My research 
suggests this is a hardware 
error. I updated Windows, all 
of my drivers, I checked for 
BIOS updates, and have not 
overclocked the CPU or GPU. 
The only workaround I’ve 
found is to install Chrome 
Portable in a thumb drive 
and execute the browser that 
way. Consider me stumped!

  –Stacey Bisceglia

THE DOCTOR RESPONDS: It’s 
unfortunate that Microsoft’s 
“WHEA_UNCORRECTABLE_
ERROR” message isn’t more 
descriptive. However, the fact 
that Chrome Portable works 
when the installed version 
doesn’t suggests that there’s a 
setting difference. Open both 
versions and type “chrome://
settings,” scroll down and 
expand the “Advanced” link, 
then check to see if “Use 
hardware acceleration when 
available” is selected. If it 
is on one and not the other, 
match them up to the build 
that doesn’t crash. The Doc 
wonders if a recent graphics 
driver update is causing 
problems that manifest when 
Chrome tries to leverage your 
GPU. Rolling back to an older 
driver might help, if so. 

The latest Ryzen CPUs provide 

a big performance boost in 

single-threaded tasks, making 

them a worthwhile upgrade.
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Desktop memory is becoming 
more affordable; Christian 
Guyton examines what that 
could mean for you

best RAM upgrades



RAM IS A CORE COMPONENT of any computer. With 

DDR4 now well and truly entrenched in the memory 

market and DDR5 on the horizon, manufacturers 

are looking out in different directions: massive 

64GB and 128GB sets running across eight 

channels, and faster speeds than ever seen before. 

Frequencies only continue to rise, with companies 

such as HyperX and Corsair pushing commercially 

available sticks at well over 4,000MHz.

But it ain’t cheap. RAM price-per-GB skyrocketed 

between 2016 and 2018, although recent trends 

have shown that DDR4 kits have slowly lowered 

in price from the latter half of 2018. RAM offering 

3,000MHz and above remains expensive, with a 

seemingly endless list of brands and product lines 

to choose from. It’s daunting. The vast majority of 

modern memory comes packaged with integrated 

heatsinks, with many sporting multicolored LEDs 

to boot. Some beefier packs even come with their 

own coolers, mounting awkwardly above the DIMM 

sockets. With an open mind and an even more open 

wallet, it’s easy to spend a silly amount of money.

Choosing RAM in this day and age can be a 

laborious process, but fear not—as always, 

Maximum PC has got your back. Over the next 

few pages, we’re going to break down the 

technology and nuances behind random-access 

memory, and discuss which kits are best for which 

builds. A discerning eye is important when buying 

RAM; what you pay for is not always what you get.
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Size Does Matter

8GB
If you’re looking for a standard PC, 

8GB of RAM is the way to go. Capable of 

handling any office work and low-end 

gaming, 8GB of dual-channel memory 

will serve any basic build well. It’s 

worth bearing in mind that if your GPU 

doesn’t have much VRAM, some games 

attempt to cache large texture files to 

the system’s DRAM. If you’re running 

an older graphics card with less than 

4GB of video memory, 16GB of memory 

could be a better call. This only applies 

for more graphically demanding games, 

though; if your poison is lightweight 

indie gaming, 8GB is plenty. Older 

triple-A titles ought to be fine, too, 

if you’ve got an appropriate GPU to 

back you up. Make sure you go for dual-

channel; a single stick of 8GB DDR4 will 

work, but the performance difference 

will be more noticeable in games.

16GB
For mid-range gaming supported by a 

decent GPU, 16GB of DDR4 is a necessity. 

Games are becoming increasingly 

demanding when it comes to RAM; if 

you’re looking to play in anything higher 

than 1080p, 16GB may not always be 

enough. The uptick in multiplatform 

games being ported to PC has resulted 

in a lot of poorly optimized triple-A titles 

hitting our screens, too, which have a 

tendency to gobble up RAM. 16GB should 

be able to cope with other tasks, though; 

image manipulation and intermediate 

video-editing work shouldn’t be an 

issue. You’ll likely have two options: 4x 

4GB or 2x 8GB. Doing your research is 

worthwhile; one kit might appear better 

value for its performance, but if your CPU 

and mobo are only going to support dual-

channel memory, you won’t be able to 

reap the benefits of a quad-channel kit.

4GB
Consider this a bare minimum. If 

you’re building on a seriously tight 

budget, or just looking for a basic PC 

for office work (think word processing, 

not giant spreadsheets), 4GB of basic 

DDR4 will do. As memory frequency has 

less of an impact on Intel processors 

than AMD ones, we recommend opting 

for slower RAM, such as DDR4-2133, 

paired with a cheap Intel Core CPU. This 

memory won’t cost much—a stick of 

4GB RAM shouldn’t run you much more 

than $20 right now. Dual-module kits 

are also an option, using two 2GB sticks 

to improve performance, but these can 

cost more, and the difference is likely to 

be minimal. Rigs such as this also make 

for affordable home theater PCs or 

cryptocurrency mining units, although 

some cryptos can be CPU-intensive, so a 

slightly better processor is a good idea.

WHEN LOOKING AT MEMORY KITS, there are three key elements to 
consider: capacity, speed, and latency. We’re going to take a look 
at capacity first, as it tends to be the biggest deciding factor when 
choosing your RAM. Industry regulation from standardization body 
JEDEC (more on that later) means that memory only comes in 
certain multiples: 2GB, 4GB, 8GB, and so on, doubling each time.

For consumer use, the standard maximum capacity of DDR4 
chips is 1GB, due to limitations in transistor size, although a 
theoretical 2GB per chip is possible, so the largest commonly 

available capacity per DIMM slot is 32GB. 64GB sticks are available, 
but not for general consumer use; they’re more likely to be found 
in server farms. With a mobo supporting full memory capacity, the 
current maximum available for desktop systems is 128GB.

Of course, 128GB is far more than the average PC will ever need. 
RAM should be chosen based on the requirements of the system; it 
can be one of the more expensive components of a fresh build, and 
it’s easy to overspend on capacity that isn’t required. With that in 
mind, here’s our guide to how much RAM your system should need.

best RAM upgrades
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THE CONCEPT of random-access memory 
has been around since the 1940s, although 

it didn’t exist in its current form 
until 1968. When we talk about 

RAM here, we mean DRAM—
dynamic RAM—the kind of memory 

you’re probably familiar with: Sticks 
that plug into your motherboard and 

use binary capacitors and transistors 
to temporarily store readable data. Early 
RAM worked differently, using electrically 
charged spots on cathode ray tubes or 
networks of magnetized metal rings. 
The core principles remain the same, 
though—the points of positive or negative 
data could be read in any order, therefore 
denoting them as “random access.”

The current model of RAM, using 
transistors to store data as combinations 
of charges, came into commercial use 
in 1970 with the Intel 1103 chip. This 
memory requires a constant supply of 
electricity, with the minuscule charges on 
the thousands of transistors needing to be 
refreshed hundreds of times per second. 
Unlike storage memory (such as that 
found on traditional SSDs and HDDs), RAM 
is volatile; once the computer is powered 
off, the charges dissipate, and any data is 
lost. While non-volatile RAM does exist, it 
tends to be too slow for normal memory 
needs, and can suffer from other issues.

Modern DRAM uses solid-state memory 
on silicon circuitry, unlike the ceramic and 
magnetic components of the Intel 1103. It 
functions in much the same way, though, 
losing data once the power is turned off. 
Nowadays, RAM is used for a wide variety 
of computing functions, most commonly 
for graphical tasks, be that rendering 3D 
objects in real time in a game, or editing 
video footage. DRAM is found in more than 
just the heatsink-equipped silicon sticks 
you can buy in varying sizes and kits; it 
operates inside modern graphics cards, 
games consoles, even calculators.

32GB
Some RAM kits have got significantly 

cheaper over the past year. In early 

2018, 32GB of DDR4 could set you back 

$400 or more, but prices have dropped 

by around half since then. At the 

moment, a kit of four 8GB sticks should 

only set you back $100-$200, even at 

higher speeds, such as 3,600MT/s. With 

this new affordability in mind, 32GB (or 

more) becomes a more distinct option. 

If you’re looking to edit 4K video, use 3D 

rendering programs, or play high-end 

games at maximum graphical settings, 

you’ll want at least this much memory 

to play with. For gaming purposes, 32GB 

will be overkill for most modern games, 

but also serves to future-proof your 

system. Again, if you’re rocking four 

8GB modules, as opposed to two 16GB 

ones, make sure that you’ve got support 

for quad-channel memory.

64GB+
It wasn’t that long ago that the notion 

of putting 64GB in a desktop PC was 

faintly ridiculous, in terms of both cost 

and necessity. Today, though, 64GB 

of high-speed RAM (over 3,000MT/s) 

can cost as little as $250, making 

it feasible in a high-end system for 

gaming or editing tasks. While 32GB 

modules are available, we recommend 

a quad-channel kit of four 16GB sticks; 

dual-channel runs the risk of RAM 

bottlenecks. 64GB will give any system 

serious oomph, but if you have money 

to burn, 128GB is an option too. It’s hard 

to see where this would be required—

advanced high-res videography, 

perhaps—but the option exists. DDR5 

promises to up that maximum to 256GB, 

which will likely only serve a niche role 

for heavy data analysis tasks and video 

processing in 8K and beyond.

Stepping Back
Through Time
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Say hello, Grandpa… This is the Intel 

1103 chip, the precursor to modern 

DRAM as we know it.
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Speed Racers
WE KNOW, MEMORY SPEED can be complicated. Speed and 
frequency are often treated as interchangeable statistics, 
because they are directly tied to each other; RAM, like many other 
components, operates at a specific frequency. This frequency 
represents the number of times per second an individual 
transistor gate can open and close. With memory operating at, 
say, 1,000MHz, these transistors can cycle at a fairly nippy 1,000 
million times per second. 

If you’re the memory-savvy type, though, you might be 
more familiar with the MT/s figure than MHz. Shorthand for 
megatransfers per second, MT/s was introduced as a metric 
for memory speed when DDR (double data rate) was first 
produced, because the newer format of memory was able 
to process data at twice the speed by registering an additional 
data transfer on the rise and fall of the clock. Frustratingly, many 
manufacturers chose to ignore this standard, meaning that 
current-generation memory quotes frequency figures that are 
double their true operating frequency. If you examine memory 
speed using system status analysis software, such as CPU-Z, 
you’ll find that your 3,000MHz memory is actually running at 
around 1,500MHz. MT/s is technically the more accurate figure, 
but MHz is more widely used.

Obviously, more speed is better. Commercially available 
memory speeds have been rising steadily over the last few years, 
with the current DDR4 standard reaching as high as 4,800MHz 
(or MT/s, to be more precise). Higher speeds reduce your real-
world memory latency, and enable the transferral of more data 
within a set period of time. This enables superior performance in 
rendering functions and other tasks, although not all processors 
are affected equally; if you’re rocking an Intel CPU, you’ll find that 
increasing your memory speed will have a far smaller impact 
than on an AMD processor. For now, then, capacity remains more 
important than frequency.

Memory speed does impact another important feature of 
your RAM, however. The channel bandwidth of any memory kit 
is determined by memory speed; for those not in the know, the 

bandwidth is the maximum amount of data that can be transferred 
between the memory and CPU within a set period of time. This is 
calculated by multiplying the transfer speed (in T/s), the system 
memory bus (in bits), and the number of channels the memory is 
capable of accessing simultaneously. So, for a set of dual-channel 
DDR4-3000 memory running with a CPU using a 64-bit bus, the 
channel bandwidth would be 3,000,000,000 x 64 x 2, which is 
384,000,000,000 bits per second. A gigabyte per second equals to 
8 billion bits per second, so we end up with the far more palatable 
figure of 48GB/s. This is the absolute maximum data rate that this 
system could achieve; attempts to do anything demanding faster 
transfers than this would result in memory bottlenecking.

Assuming that you’re not going to meddle too much with your 
CPU, that means that data transfer is determined by more than 
just memory speed. When choosing what RAM to put in your 
system, consider the advantages of a quad-channel kit over 
dual-channel (provided your CPU supports it of course—most 
mainstream CPUs are resolutely dual-channel). To be fair, dual-
channel memory support represents a good standard for the 
average system, but quad-channel support effectively double 
your channel bandwidth, so if you’re using your system for tasks 
that demand massive data transfers (such as 4K+ video editing, or 
large-scale texture production), four can be the golden number.

Channel support is tied to your motherboard, too. Many 
high-end boards support quad-channel memory, but if you’re 
considering a memory upgrade for a slightly older system, do 
bear in mind that your motherboard might only support dual-
channel. Four DIMM slots is no guarantee of quad-channel 
support; many four-slot boards have two primary slots (which 
logically should be A1 and B1, but are sometimes A1 and A2 or 
A2 and B2, depending on the manufacturer), which provide full 
dual-channel speeds. This works both ways: Plug in only one 
stick of dual-channel memory and you’ll get half the channel 
bandwidth. Smaller motherboards, such as the ITX format, have 
only two slots with dual-channel support, due to their layout 
specifications, even on X299.

Consult the mobo 

manual if you’re 

not sure which 

slots to prioritize.

best RAM upgrades
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Quality Control

Latency & Timings

THE JOINT ELECTRON DEVICE ENGINEERING COUNCIL (JEDEC) is 
the body responsible for maintaining industry standards when 
it comes to numerous solid-state components, including RAM. 
With over 300 members, including Microsoft, Intel, and Apple, 
JEDEC pools resources to push hardware development forward.

Its most important contribution to RAM standards is the 
adoption of a unified connection format for motherboards 
(the DIMM slot) to ensure compatibility, but that’s not all. 
Standards for data transfer rates and latencies are determined 
by JEDEC, so consumers choose between speeds such as DDR4-
3000 and DDR4-3200, instead of 3060, 3111, 3187, and so on. It’s 
simple enough in principle, but these constraints ensure memory 
is easily put into straightforward brackets for our convenience.

JEDEC’s members are also responsible for producing new 
hardware within the RAM universe. The up and coming memory 
standard is DDR5, which was ratified in March 2017 (not to be 
confused with GDDR5, a memory standard for GPUs). Some 

manufacturers (such as SK Hynix) have confirmed that their 
DDR5 memory is complete, and desktop DRAM modules should 
be available later this year. This next-gen memory will be able to 
reach higher speeds than any units from DDR4, and draw less 
power per module, thanks to integrated voltage regulators.

While it might sound like a minor improvement, this shift in 
standards has implications beyond RAM design. With voltage 
controlled on the memory sticks, motherboards will no 
longer require voltage regulators for RAM, which will enable 
manufacturers to focus on other features, but could cause 
compatibility issues in the not-too-distant future. DDR5 will 
double the bandwidth available, so 128GB may become more 
mainstream, and 256GB builds will become a possibility for 
high-end tweakers. Memory speeds will hit a staggering new 
maximum at 6,400MT/s, the fastest available within DDR5.

Memory speed isn’t the only 

thing that affects your RAM. 

Latency and memory timings 

encompass a huge variety 

of key statistics that affect 

memory performance, and 

many of those numbers will 

be meaningless unless you’re 

a die-hard hardware-head. 

The one to look out for is CAS 

(column address strobe) 

latency, which is an indicator 

of how quickly the RAM stick 

responds to a memory call.

Bear with us, because it’s 

going to get mathematical. 

CAS latency by itself isn’t 

necessarily a helpful figure—

in order to get a genuinely 

useful number, there’s a 

formula you need to use. 

Real-world latency = (2,000/

RAM speed) x CAS latency, 

with speed measured in MT/s 

and latency measured in 

nanoseconds. So, if you’ve 

got a memory kit that runs 

at 3,000MT/s and has a CAS 

latency of 16ns, the kit’s 

real latency is 10.6ns.

However, faster memory 

tends to come with greater 

CAS latencies, so the actual 

performance gains can be 

minimal, even when you seek 

out higher frequencies. The 

ideal memory kit has a high 

frequency and a low CAS 

latency, and overclocking 

is an option, but there’s a 

lot of potential messiness 

there. If you’re running an 

Intel system, variation in 

speed isn’t going to make 

much difference; real-

world latency in DDR4 and 

beyond is starting to become 

increasingly homogenized, 

regardless of frequency, so 

buying high-speed RAM can 

become a waste of money. 

The impact on some tasks is 

more notable; gaming and 3D 

rendering is less affected by 

memory speed than large-

scale data analysis.

JEDEC doesn’t actually require heatsinks to be integrated on RAM.

Problems? Chances 

are it’s your RAM. 

Try manually setting 

the frequency and 

timings in the BIOS.
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IN THE EARLY YEARS of commercial RAM, 
before the turn of the century, there was 
a serious disparity between CPUs and 
memory. Referred to as the “memory 
wall,” a problem arose where CPUs were 
developing faster than RAM technology, 
with RAM speed only increasing by 
10 percent in the 14 years leading up to 
2000, while CPU speeds increased by 
approximately 55 percent. For a long time, 
it looked like memory speed limitations 
might cause a significant bottleneck in the 
improvement of computer performance.

Since then, CPU speed increases have 
slowed, due in part to physical design 
barriers around heat dissipation and 
die size in new chip designs. With the 
improvement of caching tech to speed 
up key processes and bridge the gap 
between CPU and RAM speed, it looks 
like the “memory wall” might be a fallacy.

We’ve mentioned 

that memory 

specs have 

different impacts 

on Intel and AMD 

processors. In 

broad terms, 

memory speed 

hasn’t historically 

made much 

difference 

to processor 

performance, but 

with AMD’s Ryzen 

series of CPUs, 

that norm changed 

in a big way. Due 

to conventional 

processor 

architecture, Intel 

CPUs (currently 

the Core series) 

only see minimal 

gains from 

memory speed; a 

couple of percent 

at best in the 

vast majority 

of benchmark 

functions.

With Ryzen, 

though, AMD 

did something 

different: The 

interface that 

connects the 

processor cores 

together—called 

the Infinity Fabric, 

if you subscribe to 

funky hardware 

marketing 

jargon—is 

controlled from 

the integrated 

memory controller 

on the chip. What 

this means is that 

when supported 

by faster RAM, the 

memory controller 

can run faster, 

and transfer 

data between the 

cores at higher 

speeds, improving 

overall processor 

performance.

This was a 

stumbling block 

for Ryzen in 

the early days, 

because when the 

processor line first 

became available 

in 2017, memory 

was significantly 

more expensive. 

The effects of 

memory speed on 

Ryzen chips works 

both ways: Slower 

RAM can result in 

poor performance 

compared to 

similar Intel Core 

CPUs. As memory 

has become 

cheaper, though, 

Team Red looks 

more and more 

attractive. A few 

hundred additional 

MT/s can make 

a difference 

in processor 

performance of 

10 percent or 

more, which can 

be pumped up 

even higher when 

combined with 

CPU overclocking 

to produce some 

very impressive 

numbers.

RAM DOES MORE than simply boost your PC’s processing power. If 
you’re particularly software-savvy, you may be familiar with the 
concept of a RAM disk: a block of RAM that is used by your system 
as a temporary secondary storage drive. Using specific software 
(such as DataRAM RAMDisk), it’s possible to partition a segment 
of memory to be used as a drive. These virtual drives can be 
incredibly fast—far faster than conventional SSDs or HDDs—and 
theoretically have no limits on read/write times.

The main drawback of virtual RAM disks is that they lose all 
stored data when powered down, making them particularly 
vulnerable in the event of system crashes or power failure. 
They’re also an expensive way of producing storage space to 
work on files—RAM is simply more costly than physical drives. 
However, there are other advantages. RAM disks can be ideal 
for working with decrypted versions of encrypted files, and you 
can set up regular backups of your data to a physical drive to 
get around the risk of data loss on crashes. It’s possible to keep 
data stored on a persistent storage drive, set to recreate it on 

the RAM disk when the system boots. Most interestingly, RAM 
drives can be used to access compressed files without having to 
decompress them first, using systems such as cRAMfs on Linux. 
With memory capacity ever increasing, RAM disks may become 
more relevant in the not-too-distant future.

Other mechanics of RAM have been slowly integrated into 
modern operating systems for ease of use. Virtual memory, for 
example, involves the partitioning of hard drive space as a “paging 
file,” which is then used for storing excess data when the physical 
RAM is operating at capacity. Windows does this automatically, 
using the paging file as additional memory space to prevent 
program crashes. This function can be disabled in Windows 10 
to free up disk space, although it’s not recommended if you’re 
running anything less than 32GB, and does put you at greater risk 
of system instability. Modern BIOSes also incorporate “shadow 
RAM,” where ROM functions instead use DRAM locations to 
speed up access times. The benefits of doing this manually are 
minimal, though, particularly with modern ROM chips.

CPU
Differences

The Bottleneck

What Else Can My RAM Do?
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OFFICE WORK

Corsair Vengeance LPX 8GB 
(2x 4GB) @ 2,400MT/s $44

If you’re just keeping it 

simple, this is all you need—

8GB of RAM will comfortably 

handle light office work, be it 

spreadsheets or slideshows, 

and is more than capable of 

supporting your usual array 

of web-browsing activities. 

We would be a little wary of 

loading up on Chrome tabs, 

however, with only eight 

gigs behind you, but this 

should be able to carry you 

through everyday tasks. 

We contemplated going 

for Team’s slightly faster 

2,666MT/s model in the 

T-Force Vulcan line instead, 

but the price difference was 

minimal, and for baseline 

performance, 2,400MT/s is 

more than enough.

BASIC WORKSTATION

Team T-Force Vulcan 32GB 
(2x 16GB) @ 3,000MT/s $130

Even with low to mid-level 

photo and video-editing 

work, 32GB of memory is 

the way to go right now. It 

won’t necessarily be cheap, 

but the affordability of 

higher-capacity DDR4 kits 

has improved no end over 

the past year, perhaps due 

to the looming release of 

DDR5. This much memory 

will run rendering tasks well, 

and equip your system for 

high-definition videography. 

If you’re looking for a fast 

system to run tools such as 

Photoshop or After Effects, 

look no further. 2,400MT/s 

will be plenty for Intel 

systems; if you’re on an AMD 

machine, it may be worth 

splashing out for a little more.

To be honest, there are 

no wrong answers here. If 

you’re hankering after a PC 

for seriously demanding 

digital creative work—

whether that’s large-scale 

3D modeling or 4K video 

editing—the sky’s the limit 

when it comes to memory 

capacity. We’ve gone for a 

mid-range 64GB kit here, 

with a real-world latency 

of just 10ns, but if you’ve 

got the cash to splash, 

consider faster or even 

larger modules. Corsair’s 

Dominator Platinum series 

provides some excellent 

64GB and 128GB kits, for 

example. Make sure your CPU 

and motherboard support 

quad-channel memory 

bandwidth, as is the case with 

any four-module RAM kit.

WHATEVER PLATFORM you’re looking to build, memory is 
going to be an integral part of it. We’re going to break down the 
different potential purposes of new system builds, and assign 
the best RAM for the job in each scenario. RAM might have 
become cheaper over the last year, but it’s still all too easy to 
splurge when you don’t really need to.

Bear in mind that these are only loose recommendations; 
follow the specs as a guideline, rather than the manufacturer. 
As always, though, we advise you to stick with recognized 
brands, such as Corsair, Crucial, G.Skill, and HyperX. If you 
can’t find the manufacturer’s name listed anywhere in this 
magazine, tread lightly.

Best RAM Choices
For Your System

best RAM upgrades
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HyperX Predator 64GB  
(4x 16GB) @ 3,000MT/s $395



BASIC AMD GAMING

Ballistix Tactical 16GB  
(4x 4GB) @ 3,000MT/s $85

There’s nothing much to 

write home about here, but 

this Ballistix kit will do the 

job and do it well. Memory 

speed is less of a factor when 

you’re looking at RAM for 

Intel systems, so you can 

save yourself a few dollars 

by opting for a slightly more 

conservative frequency. 

The Ballistix Sport series is 

Crucial’s more affordable 

memory, but that doesn’t 

make it any less effective. 

It also runs at just 1.2 volts, 

meaning it has some of the 

lowest power draws found 

within the DDR4 standard. 

It also has a CAS latency of 

16, which means it keeps 

your real memory latency 

at 13.3ns.

BASIC INTEL GAMING

Ballistix Sport LT 16GB  
(2x 8GB) @ 2,400MT/s $70

Once again, we don’t need 

to push to boat out too much 

when it comes to memory 

speed in an Intel machine. 

Unlike the Dominator 

Platinum RGB kit, this set 

comes with two 16GB modules 

instead of 4x 8GB ones, so 

if you’re running a system 

with more than two DIMM 

slots, make sure you’re using 

the prioritized connectors 

for maximum speed. This is 

G.Skill’s own RGB offering, 

and they’re pretty sweet to 

look at. A CAS latency of 16 

means this might not be the 

fastest RAM around, but it’s 

an extremely good price for 

32GB. The extra capacity can 

come in handy for streaming 

memory-intensive games. 

HIGH-END INTEL GAMING

G.Skill Trident Z RGB 32GB 
(2x 16GB) @ 3,000MT/s $165

The Ballistix Tactical 

memory isn’t particularly 

exciting to look at (perhaps 

check out Corsair’s Dominator 

line if you’re looking for some 

more eye-candy-worthy 

modules), but it provides 

excellent performance for 

a sensible price. With a high 

frequency and a CAS latency 

of 16, this kit will pair nicely 

with a mid-range GPU for 

some straightforward 1080p 

or even 1440p gaming. It 

won’t necessarily be able 

to hit maximum settings in 

every game you play, but 

well-optimized titles will 

give you no problems. Should 

you decide to upgrade your 

GPU, a memory upgrade 

is worthwhile, too, and the 

Tactical or Elite series are 

good ones to stick with.

This is where it starts to get 

expensive. We’re cranking up 

the speed to make sure your 

AMD system’s latency stays 

low, and paying the extra 

price for 32GB ensures your 

build is future-proofed. Most 

games don’t use 32GB—16GB 

is usually recommended—but 

with GPU improvements, that 

could change. With this much 

capacity, there won’t be any 

danger of running low on 

available memory, even when 

you’re bashing your system 

with ultra 4K graphics. The 

Dominator Platinum RGB is 

a lovely looking kit, too, with 

fully addressable LEDs on 

every module.
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Corsair Dominator Platinum 
RGB 32GB (4x 8GB)  
@ 3,600MT/s $330
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Nick Peers reveals quick tips and tricks to give 
Windows a fresh look

OFF-THE-SHELF is good as far as it goes, but there comes a 

time when you want to put your personal stamp on something, 

and with Windows, you’ll be surprised by just how much control 

you can wield over its look and feel. We’ve dug out no fewer than 

60 tips to help you customize it to your personal satisfaction.

There’s a reminder of some familiar tips, but we’ve dug deeper 

to reveal buried settings and little-known techniques that can do 

more than simply change the background picture or apply a color 

scheme. Indeed, we open this feature by introducing two free 

tools that, between them, open up a wide array of customizable 

options that normally require you to be a maestro at Registry 

editing. You’ll tackle the desktop and its constituent parts: Start 

menu, Taskbar, and File Explorer. You’ll also discover how to 

replace parts of the desktop with more visually appealing (but 

no less practical) alternatives, transform the way you navigate 

your filesystem with a handy File Explorer add-on, and even 

make fundamental changes to the desktop itself, replacing the 

Windows ‘skin’ with an alternative, offering not just a new coat 

of paint, but a fresh approach to how you interact with Windows. 

Come on, let’s get those brushes out….
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01 Tools of the Trade
Many of the tips in this feature can 

be applied with the help of two powerful 
tweaking tools, so start by downloading 
both Ultimate Windows Tweaker (https://
bit.ly/uwt-10—you’ll find links to Windows 
7 and 8.1 versions here, too) and Winaero 
Tweaker (https://winaero.com/download.
php?view.1796). Once downloaded, extract 
the contents of the ZIP files—Ultimate 
Windows Tweaker runs as a portable app, 
and Winaero Tweaker gives you the option 
of installing it in portable form, too.

02 Quickly Access Windows’ 
Personalization Settings

To start customizing, right-click the 
desktop and choose “Personalize” to jump 
straight to “Settings > Personalization > 
Background.” From here, you can change 
your background to a picture, a solid color, 
or a slideshow of photos within a single 
folder on your PC. 

03 Customize Your  
Desktop Background

If you’re dissatisfied with Windows’ rather 
meager desktop background offerings, 
download and install John’s Background 
Switcher from https://bit.ly/johnbckswtch 
for more choice—after installation, you’re 
directed to the “Add” button, where you 
define sources for your photos. These 
can include specific folders on your PC as 
well as various online sources (including 
Dropbox and OneDrive folders, plus RSS 
feeds, Instagram, Google, and Flickr).

You’ll see several switching options 
at the bottom of the main window—pay 

attention to the “Picture Mode” drop-
down, where you can display multiple 
photos at once in various ways. There’s 
also a ‘“More” button for fine-tuning all 
aspects of this clever background tool.

04 Override Color Scheme
Windows automatically changes 

the color scheme of desktop items to 
match the background, but you can 
also force your own choice of color via 
“Settings > Personalization > Colors.” 
You can switch between light and dark 
modes here, too.

05 Create Custom  
Color Palette

Fed up with having to click “Custom Color” 
to choose a different one to Windows’ own 

offerings? Fire up Winaero Tweaker and 
go to “Appearance > Custom Accents,” 
where you can define up to eight custom 
colors of your own. These appear under 
“Recent Colors” in the “Personalization” 
dialog box for easy access.

06 Pick a Theme
The quickest way to change 

your desktop appearance is through the 
“Themes” section under “Settings > 
Personalization.” Several are provided, 
or click “Get More Themes in Microsoft 
Store” to browse hundreds more—click 
“Get” followed by “Install” to add one to 
your collection. Some themes change 
the mouse pointer and desktop icons—
you can prevent them from doing so in 
Winaero Tweaker under “Appearance > 
Theme Behavior.” 

07 Change Your  
Account Picture

Open a photo of yourself in an image editor 
like Paint.NET (www.getpaint.net), then 
crop in to a headshot (make the selection 
tool 1:1 for a perfectly square crop), and 
save the image. Now navigate to “Start 
> Settings > Accounts,” and click your 
current photo under “Your Info” to select 
the new one. Previous shots are kept, 
enabling you to switch between them.

08 Set Up a Screensaver
Energy-saving LCD monitors 

have largely rendered screensavers 
redundant, but if you’re still hankering 
after one, head to “Personalization > 
Lock Screen,” then scroll down and 
click “Screensaver Settings” to set one 

Desktop, Taskbar, & Start Menu

John’s Background Switcher is perfect for adding more pizzazz to your desktop backdrop.

Winaero Tweaker provides 

dozens of tweaks to help you 

customize your PC’s appearance.
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15 Organize Your Desktop Icons

up. Download more screensavers from 
www.screensaversplanet.com (many of 
which are free)—save the EXE file to your 
computer, then double-click it to add the 
screensaver to the available list.

09 Start Menu Precautions
Before making major changes to 

your Start menu, navigate to “Desktop and 
Taskbar > Backup/Restore Start Menu 
Layout” in Winaero Tweaker to export the 
current layout—just in case.

10 Customize the  
Start Menu

Use the “Personalization > Start” section 
of “Settings” to configure certain aspects 
of the Start menu. Tiles can be added by 
right-clicking items and choosing “Pin to 
Start Menu.” You can then click and drag 
items around to rearrange them, or click 
and drag items on top of each other to 
group them in a folder.

11 Lock the Start Menu
After you’ve set up the tiles to your 

satisfaction, open Ultimate Windows 
Tweaker and navigate to “Customization 
> Universal UI,” then check “Lock Start 
Tiles” to prevent accidentally rearranging 
them in future.

12 Ditch the Start Menu
Still hankering after the Windows 

7 Start menu? Our old favorite alternative 
Start menu—Classic Start—has been 
resurrected under a new name, and 
updated to work with the latest version of 
Windows 10. Download and install Open-

A INSTALL ICONS
Download and install Vi-Pad 

(http://lee-soft.com/vipad)—if the 

SmartScreen filter appears, click 

“More” and unblock the program. 

During installation, click “Yes” when 

prompted to copy all existing desktop 

icons to the Vi-Pad window, which will 

happen in real time as you watch.

B ORGANIZE ICONS
All shortcut apps appear in a single 

tab—“New Tab”—spread over multiple 

pages. Right-click “New Tab” to rename 

it, or use the “+” button to create 

additional tabs, so that you can organize 

your apps into more categories. Once 

that’s done, right-click an app icon to 

move it to that tab.

C ADD NEW ICONS
You can drag new shortcuts into 

any tab from the desktop or from File 

Explorer. Right-click the program’s 

Taskbar notification area, and choose 

“Settings.” Uncheck “Use Windows 

DWM” to make it translucent. You can 

also make the icons larger or smaller, 

using the slider at the top of the menu.

Shell from https://open-shell.github.io/
Open-Shell-Menu—during installation, 
click “Classic Explorer” and “Classic 
IE,” and choose “Entire feature will be 
unavailable” to avoid installing them.

13 Customize the  
Quick Access Menu

Press Win-X to access the alternative 
Start menu. You can choose which options 
appear on it by downloading and running 

the portable Win + X Menu Editor (https://
winaero.com/download.php?view.21). 
 

14 Restore Desktop Gadgets
Do you miss the old Windows 7 

gadgets that provide extra functionality 
on the desktop? Visit http://win10widgets.
com to download Win10 Widgets, a 
customized version of Rainmeter (www.
rainmeter.net), with the gadgets pre-
installed and running.

Still hankering after the old Start menu? Open-Shell is the new name for Classic Start.
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16 Make Use of the Taskbar
The Taskbar is the best location 

for any, and all, shortcuts that you need. 
Right-click your existing desktop or Start 
menu shortcuts, and choose “Pin to 
Taskbar” to add them. You can then drag 
and drop icons within the bar to order 
them logically.

17 Minimize the Search Box
Does the new search bar take up 

too much room on your Taskbar? Right-
click an empty part of the Taskbar, and 
choose “Cortana > Show Cortana Icon” to 
replace it with a clickable icon; or choose 
“Cortana > Hidden” if you never use it.

18 Resize the Taskbar
Running out of space for shortcut 

icons? Make them smaller by right-
clicking the Taskbar, choosing “Taskbar 
Settings,” and flicking the “Use Small 
Taskbar Buttons” switch to “On.” Or right-
click the Taskbar and uncheck “Lock the 
Taskbar.” Click the top edge of the Taskbar 
and drag up to add space for an extra row.

19 Move the Taskbar
While it’s unlocked, you can also 

click and drag the Taskbar to a different 
edge of the screen—pin it left or right for a 
vertical list, or at the top if it suits your way 
of working better.

20 Show Labels
If you only have a handful of icons 

on the Taskbar, open Taskbar settings, 
scroll down, and change “Combine 
Taskbar Buttons” to “When the Taskbar 
is Full” or “Never” to view a label, which 
helps you to easily view—and switch 
between—open documents within the 
same application.

21 Add Toolbars
Right-click the Taskbar and you’ll 

see a Toolbars menu, enabling you to 
add extra features to it—you can select 
“Address” to add a URL bar for opening 
websites in your default web browser, for 
example. To add easy access to your entire 
PC, choose “Toolbars > New Toolbar.” 
Select “This PC” and click “Select Folder.” 
From here, click “>>” next to “This PC” 
to access any folder or drive with just a 
few clicks.

22 Increase the Size of  
Taskbar Peek Thumbnails

When you roll your mouse over an 
open program’s Taskbar icon, you get a 
pop-up thumbnail of open document(s)—
it’s a bit small, so open Ultimate Windows 
Tweaker, navigate to “Customization > 
Taskbar,” and try setting the minimum 
and maximum thumbnail size sliders to 
400. Click “Apply Tweaks,” and after File 
Explorer restarts, you should instantly 
see an improvement.

23 Tweak the  
Notification Area

You don’t need to delve deep into Taskbar 
settings to change the behavior of the 
Taskbar’s notification icons. Simply drag 
icons between the notification area and 
its “holding area” (click “^” to reveal it). 
To remove icons permanently without 
closing the parent application, check out 
the program’s own settings.

24 Clear System Icons
Windows places several icons of 

its own in the Taskbar notification area—
some elements, such as the touchpad or 

Taskbar and Notifications

Increase the size of Taskbar Peek thumbnails to make them easier to read on screen.

WinStep Nexus is a visually slick—and practical—alternative to the Taskbar.
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30 Launch Programs Quickly

touch keyboard, can be shown or hidden 
via the Taskbar’s right-click menu; others, 
including the clock and the Action Center 
button, can be removed under Taskbar 
settings (click “Turn System Icons On or 
Off” under “Notification Area”).

25 Adjust Notification  
Pop-Ups

While you can tweak many aspects 
of the Action Center on your PC via 
“Settings > System > Notifications & 
Actions,” one thing you can’t do from 
here is adjust how long—five seconds—

A GETTING STARTED
Download Launchy from www.

launchy.net—you can either install it 

or run it on demand as a portable app. 

Once Launchy has, er, launched, it sits 

unobtrusively in the Taskbar notification 

area. To bring it into focus, press Alt-

Spacebar, then start typing the name of 

what you’re looking for.

B SEARCH AND SELECT
An icon representing a program 

pops up—if it’s the correct one, press 

Enter. Wait a few seconds, and more 

matching results—including web 

links—appear via a drop-down menu. 

Click one or use the arrow keys to scroll 

through the list, pressing Enter when 

you find your match.

C WIDEN LAUNCHY’S  
SEARCH REMIT

Right-click the Launchy notification area 

icon and choose the “Options > Catalog” 

tab. Click “+” under “Directories” to add 

additional folders to include, then with 

the directory selected, click “+” under 

“File Types” to list file types to search. 

Finally, click “Rescan Catalog.”

individual notifications appear on screen. 
To change this setting, open Universal 
Windows Tweaker to the “Customization 
> Universal UI” tab. The slider enables 
you to increase the time from five seconds 
right up to 300 seconds. Alternatively, 
you can disable them completely (check 
“Disable Toast Notifications”).

26 Replace Your Taskbar
The Windows Taskbar is efficient, 

but not exactly visually pleasing. Fans of 
the macOS dock should examine the free 
version of WinStep Nexus (www.winstep.

net), which combines a more eye-catching 
aesthetic with functionality that renders 
the Taskbar redundant. Not only does it 
include all the expected features—drag 
and drop shortcuts from your Start menu 
or desktop to add them to the dock—but 
you can also add modules such as email 
checker and weather forecast gadgets.

27 Tweak the  
Alt-Tab Menu

It may not be as glamorous as the new 
Timeline, but the Alt-Tab feature is still the 
quickest way to switch between open apps 
and windows on your PC. Tweak its looks 
courtesy of Winaero Tweaker: Navigate to 
“Appearance > Alt + Tab Appearance,” 
where you’ll find sliders to adjust its 
transparency, plus make the desktop 
darker when it’s invoked.

28 Minimalist Alt-Tab
You’ll also see an option to 

“Enable Classic Alt + Tab Dialog”—check 
this, then click “Restart Explorer” to 
replace the thumbnails with a minimalist 
icon-based task switcher, with the 
currently selected icon’s window title 
displayed beneath it to help you navigate.

29 Multi-Display Settings
If you have two monitors 

connected to your PC, head over to the 
Taskbar settings, where you’ll see options 
for configuring the Taskbar independently 
on each display—we recommend 
selecting “Taskbar Where Window is 
Open” on the “Show Taskbar Buttons On” 
drop-down menu, to avoid confusion.

Adjust the time notifications appear (or disable them) using Ultimate Windows Tweaker.
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31 Customize Folder 
Behavior

Windows can be instructed to treat 
folders in a specific way depending on the 
contents inside. Right-click a folder and 
choose “Properties > Customize,” where 
you can optimize it for a specific file type, 
such as pictures or documents.

32 Change the Folder Icon
You’ll also see an option to change 

the folder icon—useful if you want a more 
visual prompt as to the folder’s contents. 
Click “Change Icon” to browse files for 
any icons they contain (“shell32.dll” is 
selected by default, with lots of options). 
You can also select previously created 
or downloaded icon (ICO) files—see the 
step-by-step guide on the page opposite 
for a way to extract icons from other 
files. Alternatively, click “Choose File” to 
choose a picture to display instead—this 
is perfect for photo folders, where you’d 
rather focus on one of the photos inside 
than have Windows display several of 
them at once.

33 Set up Individual  
Folder Views

Windows also remembers any individual 
customizations that you perform on a 
folder, so after opening it, switch to the 
“View” tab on the File Explorer’s Ribbon, 
where you can experiment with the 
“Layout” and “Current View” sections to 
apply settings that will remain specific 
to that particular folder whenever you 
reopen it.

34 Adjust Icon Spacing
Further tweaks can be 

performed using Winaero Tweaker—
navigate to the “Advanced Appearance 
Settings > Icons” section, where you can 
adjust the horizontal and vertical spacing 
of icons in both File Explorer and on the 
desktop, plus change the default font used 
to display names. 

35 Tweak File  
Explorer Panes

File Explorer displays two panes—
Navigation and Details—by default, but 
you can also add a Preview pane via the 
Ribbon’s “View” tab, plus restore Libraries 
to the Navigation pane by clicking it and 
choosing “Show Libraries.”

36 Set Up Quick Access
The Quick Access section of the 

Navigation pane is File Explorer’s best 
feature, bar none. You can drag frequently 
accessed folders into here to pin them for 
one-click access from any File Explorer 
location. You can also click and drag 
existing entries to rearrange their running 
order, or right-click to unpin them.

37 Clean the  
Navigation Pane

The Navigation pane can get cluttered with 
lots of entries you don’t use. The simplest 
way to review and remove these is to open 
up Winaero Tweaker to “File Explorer > 
Navigation Pane—Default Items.” Want 
to add your own links? Select “Navigation 
Pane—Custom Items” to do so.

38 Customize Navigation  
Pane Items

You can rename the “Quick Access,” 
“Libraries,” and “This PC” icons in the 
Navigation pane via Winaero Tweaker’s 
“File Explorer” section, too. You can also 
change their icons in the same way that 
you edit any folder icon.

39 Customize the  
“This PC” View

Given that most of us open File Explorer 
to “This PC” by default, it helps if you 
can tailor it to your exact needs. Fire up 
Ultimate Windows Tweaker, and navigate 
to the “Customization > This PC” option, 
where you can decide which user folders 
should be displayed, as well as adding 
various useful system shortcuts at the 
same time.

File Explorer

Adjust the spacing between 

icons using Winaero 

Tweaker—you’ll need to 

log off and on again.

Customize folders using icons or images to help provide a visual reference to their contents.
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45 Extract Program Icons

40 Add Tabs to  
File Explorer

Your web browser has tabs to reduce 
window clutter, so why not File Explorer? 
We’ve been using QTTabBar (http://
qttabbar.wikidot.com) for the best part of 
a year to do just that. Once installed, tabs 
appear beneath the Ribbon—click “+” to 
browse for a new tab, or press Ctrl-N to 
duplicate the current tab.

41 Navigate Subfolders 
Quickly

There’s another fringe benefit to using 
QTTabBar: After installation, roll your 
mouse over a folder icon and click the 
drop-down arrow that appears over it to 
drill down through the folder’s contents 
using a series of drop-down menus.

42 Pop-Up File Previews
QTTabBar also enables you to 

ditch the preview bar; instead, roll your 
mouse over a supported file type, and 
after a short pause a pop-up preview 
appears. You can configure the size of 
the thumbnail (and other QTTabBar 
options) by right-clicking an empty space 
on its tab bar in File Explorer, and then 
choosing “QTTabBar Options”—look 
under “Preview > Windowing.”

43 Customize Context 
Menus

The right-click menu is a handy place 
to stash useful—if not frequently 
needed—tools. You can add numerous 
entries to this using Winaero Tweaker’s 
“Context Menu” section—you can access 

A CHOOSE WHERE TO SEARCH
Download Icons Extractor as a 

ZIP file from www.nirsoft.net/utils/

iconsext.html, then extract its contents, 

and double-click “iconsext.exe” to 

launch the program. You have the option 

of choosing to search a specific file, all 

the files inside a folder, or a running 

process for icons.

B SEARCH AND BROWSE
Click “Search For Icons” and wait 

while the folder is searched—doing 

so can take some time, and a counter 

indicates how many matches have been 

found. You can click “Stop” at any time 

to halt the search and view the matches 

found so far. Double-click a match to 

view the available icons.

C BROWSE AND EXTRACT
If a suitably large (128x128 or 

preferably 256x256 pixels) icon 

exists, you can either select it and click 

“Copy Selected Image” to copy it to 

the clipboard, or close the dialog box, 

right-click the icon, and choose “Save 

Selected Icons” to save it as an ICO file 

for use elsewhere.

the new Clipboard History feature, for 
example, or restore access to classic 
appearance options in Windows 10 (see 
“Personalization”). It also contains system 
tools that enable you to do things such as 
claim ownership of a folder or reset its 
permissions to the default.

44 Clean Out the  
Context Menu

Select “Remove Default Entries” in 
Winaero Tweaker to clear out unused 

entries added by Windows, such as 
BitLocker entries. Most clutter, however, 
comes from third-party tools. If you 
can’t find options to remove them within 
those programs, use a tool such as 
ShellMenuView (www.nirsoft.net/utils/
shell_menu_view.html) to review and 
remove unwanted entries. Doing so 
can be daunting, but ShellMenuView is 
comprehensive, and all its options are 
grouped by app, making them easy to 
detect and, if necessary, remove in bulk.

Tabbed browsing and pop-up previews are just some of QTTabBar’s many highlights.
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46 Take Precautions
We’re now entering potential 

risk territory with some of these tips. 
Therefore, make sure you have some 
kind of system backup in place—either a 
rollback option such as System Restore 
or Rollback Rx (https://horizondatasys.
com/download), or an up-to-date drive 
image using Macrium Reflect Free  
(www.macrium.com/reflectfree.aspx). 
Done that? Good, let’s move on….

47 Customize Lock Screen
Can’t tweak the lock screen to 

your satisfaction using the options found 
under “Settings > Personalization > 
Lock Screen”? Then take a look at the 
“Boot and Logon” section of Winaero 
Tweaker for more possibilities, such 
as not automatically selecting the last 
logged-on user by default, or adding a 
limit to how long the slideshow feature 
plays for.

48 Grab Lock Screen 
Images

If you’re using the Windows Spotlight 
feature to display rotating background 
images, and you’d like a permanent copy 
of any or all of them, select “Find Lock 
Screen Images” in Winaero Tweaker, 
followed by “Get this one” under the 
current photo (if it’s displayed) to save it, 
or “Get all images stored on this PC” to 
copy them to a desktop folder.

49 Apply the  
Aero Lite Theme

Aero Lite is a no-frills theme particularly 
suited for low-end PCs, such as 2-in-1 
tablets. If you think it might help with 
performance—or want to see if its clean 
and simple lines appeal—open Winaero 
Tweaker and click “Enable Aero Lite 
(default)” under “Appearance > Aero 
Lite.” You can undo it from here, too.

50 Customize Aero Lite
Once enabled, select “Window 

Borders” under “Advanced Appearance 

Settings” to change the width and padding 
of windows—changes are performed in 
real time. You can also change the height of 
the window title bar and change the font—
this requires logging off and on again, but 
also works with other desktop themes, too.

51 Change Windows’  
Start-Up Sound

You can customize your Windows 
sound scheme by typing “sounds” into 
the Settings search box and selecting 
“Change system sounds.” What you can’t 
do from here is change the Windows 
start-up sound. Instead, navigate to 
“Appearance > Startup Sound” in 
Winaero Tweaker, where you can apply 
your own choice of WAV file in place of the 
default. If your chosen file is in another 
audio format, convert it using Pazera Free 
Audio Extractor (www.pazera-software.
com/products/audio-extractor). 

52 Switch System Fonts
Tired of the rather conservative 

Segoe UI font used by Windows for its 
desktop components? Then swap it out 
for something more glamorous (but 
legible) via Winaero Tweaker’s “Advanced 
Appearance Settings > System Font” 
screen. Log out and back in again to see 
the effect.

53 Reduce Window Clutter
You’ve added tabs to File 

Explorer, how about grouping application 
windows in a single multi-tabbed window, 
too? TidyTabs (www.nurgo-software.com) 
enables you to drag up to three windows 

Take Things to the Next Level   

Give your low-end PC a breather by trying the svelte Aero Lite theme. 

There are plenty of failsafes and reset options built into our tweak tools.
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60 Transform Your Desktop with WindowBlinds

on top of each other to group them, then 
use the tabs to switch. Upgrade to the 
Pro version (a measly $9) and you can 
automatically group windows from the 
same application together, plus group 
more than three windows at once.

54 Get the Aero Glass Look
If you’re a tech-savvy Windows 8.1 

user, head to www.glass8.eu to download 
Aero Glass for Windows 8 if you’d like to 
restore the translucent Aero effects from 
Windows 7. Aero Glass technically works 
with Windows 10, too, although we haven’t 

A DOWNLOAD AND INSTALL
Download the trial version of 

WindowBlinds from www.stardock.

com/products/windowblinds—after 

the program has installed, choose the 

30-day trial, and enter your email 

address. Once activated, pick a 

style from the “Style” section of the 

program to preview it.

B MODIFY SKIN
Click “Modify Style” to make 

changes—work through the “Colors,” 

“Transparency,” “Textures,” and 

“Fonts” sections to customize it exactly 

the way you want it to look. Aching to 

recreate the old Windows 7 glass-like 

style? Select “Diamond” and choose 

“One click blur” under “Transparency.”

C APPLY NEW SKIN
Once you’ve finished making your 

changes in WindowBlinds, click “Stop 

modifying” followed by “Apply style to 

desktop.” After a short pause, you’ll see 

the Windows desktop update. Continue 

making tweaks—increase transparency 

using the sliders, for example—and 

apply them in real time. 

had much luck in getting any of the effects 
to work.

55 Try a New Shell
The most radical change you 

can make to Windows is to replace the 
default shell with another one. One of 
the simplest to deploy is Cairo (https://
cairodesktop.com)—during installation, 
leave the default settings, so it installs 
alongside File Explorer, not in place of it.

56 Set Up Apps
After installation, Cairo opens 

the App Grabber to enable you to choose 
which app shortcuts to add to the 
Programs menu at the top of the screen. 
Drag those you want into the left-hand 
pane, then click “Continue” to place them 
in subfolders such as “System Tools” or 
“Office.” Click “Finish.”

57 Use the Menu Bar
Cairo’s menu bar offers shortcuts 

to Programs, Places (user folders, This 
PC, Program Files, and the Recycle bin), 
Documents, and Downloads. There are 
various system tools and shortcuts on 
the right—click “<” to reveal your Taskbar 
notification area icons. Click the Cairo 
menu button in the top-left corner for a 
slimmed-down Start menu (plus access 
to Cairo’s settings, or choose “Exit Cairo” 
to return to the regular desktop).

58 Navigate Folders  
with Cairo

You’ll see a list of files and folders on 
the desktop that correspond to those 
that are on your desktop. A floating bar 
enables you to change the folder shown 
using the navigation buttons to move 
up and down the folder tree, go back to 
the “home” desktop folder, or jump to a 
different folder.

59 Cairo’s Dock
Last, but not least, is Cairo’s 

dock—its replacement for the Taskbar. 
It exclusively displays shortcut icons and 
open windows—click to open, right-click 
for more options, or “=” to open Task 
View for a preview of open windows.

The Cairo desktop offers a completely different way of navigating and working with your PC.
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4K Netflix. In the middle of 
nowhere. That’s the sales 
pitch for 5G networking. 
But, as Jeremy Laird 
discovered, 5G is going to 
be much bigger than that...

A ZILLION INTERNET of Things devices all connected 
at once. Lagless cloud-based gaming. Cable-free 
connections for home Internet. Doctors operating 
remotely on patients. Smart farms. An end to traffic 
jams. And, yes, 10Gb/s in your pocket. All of that and 
way, way more is the promise of 5G. If it delivers—
and it’s a big “if”—5G is going to change our lives.

Simply put, 5G is just the inevitable progression 
of cellular wireless communication networks. It’s 
the fifth such generation, hence the name. As for 
5G’s sales pitch, it goes like this: 5G will be vastly 
faster than previous networks; it will achieve 
dramatically lower latencies; and it will support a 
far larger number of devices connected in parallel.

The precise impact of all that will be complex. 
Early demos of 5G technology involving multiple ©
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gigabits of bandwidth delivered to smartphones 
have inevitably grabbed the headlines, as have 
teething problems that hint at real-world 
limitations for the new technology. But it will 
likely be the more nuanced capabilities of the 
new network, rather than YouTubers firing up 
Speedtest on their 5G handsets, that will have a 
greater impact on how we live and work. 

For instance, future visions of a vast array 
of connected devices—including the so-called 
Internet of Things—will depend on it. Potentially 
world-altering technologies, such as autonomous 
cars, fall into that category. Similarly, much 
lower latencies will hugely reduce the need for 
wired connections to client devices of almost 
any kind. Wireless local delivery of really fast 

home connections will also change the core 
infrastructure of the Internet for domestic users. 
Rolling out new 5G home services should be far 
quicker and easier than digging up roads to supply 
optical fiber to every house.

At its best, 5G promises to be something 
of an end game. All the bandwidth you’ll ever 
need, delivered with the lowest possible latency, 
pretty much wherever you are. Truly ubiquitous 
connectivity—in every sense of the word. If all that 
sounds great, it won’t happen overnight. Nor will 
5G deliver on everything it promises immediately, 
if indeed ever. So, while 5G networks are already 
being rolled out in the US and across the globe, like 
pretty much all previous generations of cellular, it’s 
a piecemeal affair rather than a big bang.

4K Netflix from here? 

Well, possibly, but 

that’s missing the 

really important things 

about 5G.
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We can all agree 5G is the next big thing in cellular 
comms. It’s also fair to say it promises to radically 
impact digital connectivity on a much broader basis. 
So, let’s kick off by investigating 5G’s technical 
characteristics and how, ultimately, it works.

At the highest level you can divide 5G into 
two main elements, both of which are critical to 
delivering its benefits. Most obvious is the Radio 
Access Network. That’s the collection of wireless 
access points to which client devices connect: small 
local cells, larger towers and masts, and dedicated 
in-building and home access points that connect 
users and wireless devices to the core network.

It’s that core network that forms the other half 
of the equation. It combines the mobile exchange 
and data network that supports the network’s 
functionality of voice, data, and Internet connectivity. 
For 5G, this core network is designed to hook in 
seamlessly with the Internet and cloud-based 
services, and include infrastructure and software 
expressly intended to not just increase bandwidth, 
but also reduce latency and lag.

The initial frequency bands for 5G will be around 
600–700MHz, 3–4GHz, 26–28GHz, and 38–42GHz. 
In basic terms, that will add much more capacity 
compared to current mobile technologies, enabling 
more users, more data, and faster connections. 

One significant new feature on 5G networks from 
a wireless access perspective involves a new class 
of small millimeter wave (mmWave) cells designed 
for short-range connections of roughly 10 to a few 
hundred yards. These local cells are designed to be 
positioned in clusters where there are high numbers 
of users, and complement the macro network that 
delivers the wide-area coverage. One of the earliest 
movers in 5G in the US, Verizon, has built some of 
these smaller nodes into street lighting in Chicago.

Larger 5G macro cells, meanwhile, use what’s 
known as MIMO (multiple input, multiple output) 
antennas that have an array of elements to support 
more users and bandwidth. MIMO antennas are 
sometimes spoken of as “Massive MIMO,” thanks 
to the really large number of antenna elements, but 
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their actual physical size is comparable to existing 
3G and 4G base station antennas.

Operators in the US will initially integrate 5G with 
existing 4G networks. The 5G radio system, known 
as 5G-NR, isn’t compatible with 4G technology, but 
all early 5G devices in the US will use 4G for initial 
connections and control signaling, before hooking 
up to 5G for fast data where available. In terms of 
time to roll out, expect reasonably widespread 5G 
availability in 2022, and what you might call truly 
blanket 5G coverage by 2025 or thereabouts.

CLOSE TO THE EDGE
If wireless connectivity via the Radio Access 
Network is the most visible aspect of 5G, it’s the 
upgrades it brings to the core network that will be 
critical for improving latency. Central to that is the 
idea of “edge” computing, which is all about bringing 
computing closer to the end user. In other words, 
instead of relying on huge public cloud computing 
infrastructure, located centrally and at distance 
from end users, the idea is to install “cloudlet” 
servers and other computing resources much more 
locally, to move the application or content close to 
the radio at the “edge” of the network.

It’s a radical change. It can mean installing 
servers in 5G base stations to host content and 
run applications much closer to end users. For 
consumers, the impact would be felt in areas such 
as near-instant response when firing up video 
streams, or reduced lag in streamed games. But it’s 
in enabling whole new usage cases that 5G’s edge 
computing approach will have its biggest impact.

Which brings us to the broader subject of what 5G 
is for. The whole 4K-Netflix-up-a-mountain thing 
gets the basic idea of speed across, and represents 
one of the three main prongs of 5G, that of enhanced 
mobile broadband, but there’s so much more 
to 5G. Next up is massive machine-to-machine 
connectivity, and support for an unprecedented 
number of devices. Whether it’s sensors or IoT 
(Internet of Things) devices, the implication is 
billions of devices connected and communicating 
without immediate human intervention.

The third and final major usage model involves 
applications where low latency is critical. That 
means real-time control of devices, industrial 
robotics, car-to-car comms and autonomous 

Game streaming services 

like Google’s Stadia will 

benefit from 5G’s low- 

latency “edge” computing.

5G is a key technology in 

enabling an autonomous 

future for cars, and 

solving both safety 

and traffic problems.

the 5G dream
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ROLLING OUT WHERE CAN YOU 
GET 5G IN THE USA TODAY?

AT&T
What’s on offer: Mobile 
5G to a small number 
of business customers
Where:
Los Angeles, California
San Diego, California
San Francisco, 

California
San Jose, California
Jacksonville, Florida
Orlando, Florida 
Atlanta, Georgia
Indianapolis, Indiana
Louisville, Kentucky
New Orleans, Louisiana
Charlotte,  

North Carolina
Raleigh, North Carolina
Oklahoma City, 

Oklahoma
Nashville, Tennessee
Austin, Texas

Dallas, Texas
Houston, Texas
San Antonio, Texas
Waco, Texas

SPRINT
What’s on offer: Mobile 
5G to consumers and  
business customers
Where:
Atlanta, Georgia
Overland Park, Kansas
Kansas City, Missouri
Dallas, Texas
Fort Worth, Texas
Houston, Texas

T-MOBILE
What’s on offer: Mobile 
5G to consumers and  
business customers
Where:
Los Angeles, California

Atlanta, Georgia
Las Vegas, Nevada
New York, New York
Cleveland, Ohio
Dallas, Texas

VERIZON
What’s on offer: Mobile 
5G to consumers and 
business customers, 
plus a separate  
home 5G service
Where:
Verizon Mobile

Denver, Colorado
Chicago, Illinois
Minneapolis, Minnesota

Verizon 5G Home

Los Angeles, California
Sacramento, California
Indianapolis, Indiana
Houston, Texas

Ookla’s 5G map 

is a good guide 

to coverage.
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In October 2018, Verizon beat other carriers to the punch by rolling out 
its Verizon Home 5G service in a handful of cities, including Houston, 
Indianapolis, Los Angeles, and Sacramento, and also offers a full retail 
service for mobile 5G users in a handful of cities. AT&T turned on 5G in 12 
cities at the end of 2018, adding more since, but only offers the service to 
a select number of business customers. Sprint launched its network in 
May, and like Verizon has gone for a more limited initial offering in terms 
of locations, but with full availability to consumers. As we go to press, 
here are some of the currently available locations and services.

driving, safety systems, smart rail networks, 
and, of course, gaming. If those are the three key 
5G usage models, real-world applications will 
often straddle categories. An obvious example is, 
indeed, game streaming. For that you want lots of 
bandwidth. But you also want low latency. 

The same convergence of factors applies to the 
emerging field of telemedicine. Delivering medical 
services remotely, even surgery, isn’t a novel idea, 
but 5G promises to radically expand the range of 
medical services that can be delivered over the 
Internet. One more specific innovation involves 
something called the “tactile Internet.” The idea is 
to combine a range of existing robotic, sensor, and 
haptic feedback technologies with the ultra-low 
latency of 5G, plus some predictive algorithms to 
compensate for what latency remains, to transmit 
touch over the Internet in real time. The upshot 
could change the way medicine is delivered.

MAKING CONNECTIONS
If that kind of technology is likely years away, the 
5G-powered Internet of Things is much, much 
closer. Analyst outfit Gartner, for instance, reckons 
that by next year, over 20 billion devices will be 
connected to the Internet. That number is growing 
rapidly. Some research suggests 2025 could see 
as many as 100 billion connected devices, which is 
why 5G’s support for a huge increase in connected 
devices is so critical. The IMT-2020 5G standard 
set by the International Telecommunication Union 
dictates a minimum requirement of at least one 
million connected devices per square kilometer. 
Yes, that’s a minimum. Meanwhile the maximum 
number of connections supported by 4G tops out 
at around 100,000 per square kilometer.

Those are impressive numbers, but what 
will these devices be? Today’s Internet of Things 
includes devices such as fitness monitors, and 
smart devices, like connected thermostats 
and light bulbs. But that’s just the beginning. One 
obvious near-future example involves logistics and 
tracking. Currently, most couriers use a system of 
visible tags, which are optically scanned. It works 
pretty well, but leaves room for error. However, 
if every item or package had its own Internet 
connection, its individual position could be known 
in real time, even if it falls off the back of a truck. 

In agriculture, meanwhile, 5G will enable a 
huge array of sensors to be located in the ground 
and in crops, on livestock, and on farm machinery. 
Combined with data from weather satellites and 
drones, farmers will have a far, far more accurate 
picture of when and how much to water, fertilize, 
and use pesticides. That will make farming more 
efficient and more environmentally friendly, by 
using chemicals only as and when needed.

Then there’s the whole autonomous car thing. 
For truly self-driving cars to be possible, a very 
large array of innovations and technologies is 
required. Any fully autonomous car would need 
the capability to sense and react to vehicles and 
other hazards without communicating, especially 

in a world where autonomous cars will initially have 
to share the roads with human-driven vehicles, 
cyclists, and pedestrians. But the ability to send 
and receive large amounts of data with low latency 
will be a huge advantage.

An autonomous car would know about traffic 
problems miles away, because of the data it pulls 
in from other vehicles and the cloud. It will know 
where the cars in front and behind are going, and 
which lane they will be joining at the next set of 
traffic lights. It will know when the cars around it 5G is set to revolutionize the world of personal health.
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HOW ABOUT THE HANDSETS?
If you’ve motored through the main feature, 
you’ll know that 5G is about way more than 
putting gigabits of bandwidth in your pocket, 
but that’s still one of the most immediate 
benefits. So, which 5G-capable handsets can 
you buy right now?

Arguably the default option is the Samsung 
Galaxy S10 5G, available on Verizon, Sprint, 
and T-Mobile. It’s a 6.7-inch beast with the 
same CPU and three of the same cameras as 
the regular Galaxy S10 and S10 Plus, but adds 
depth-sensing time-of-flight sensors front and 
back. Nice. The catch? It’s $1,299 for the 256GB 
version and $1,399 for the 512GB model. Ouch.

Next is LG’s V50 ThinQ 5G, available from 
Sprint for $1,152. It’s a 6.4-incher with a notch-
style display, three cameras on the back, and 
6GB of RAM. And that’s it, bar pairing a Moto Z3 
or Z4 with the 5G Moto Mod, which is a kludge. 

By the end of 2019, a whole slew of handsets will be available, including 
the OnePlus 7 Pro 5G, Oppo Reno 5G, the Xiaomi Mi Mix 3 5G, and more.

As for Apple, rumor has it that its annual September refresh of 
handsets this year will not include 5G support. If so, that’s not a huge 
surprise. Going back to the very first iPhone, which launched with 
2.5G support, despite 3G services already being in existence, Apple 
has always taken a conservative approach to adopting new network 
technology. For most consumers, that probably makes sense. By the time 
5G becomes widely available, Apple will have compatible handsets.

The first full 5G 

handset: Samsung’s 

Galaxy S10.

are about to change lanes on the highway before 
that begins to happen. The benefits to everything 
from traffic flow to safety are obvious enough.

On a more personal level, 5G-powered IoT 
gadgets will likely include smart clothing, 
prosthetic devices, and even ingestible health 
monitors. Here’s one potential real-world example 
to consider. A start-up based in Utah, known 
as Veristride, has been working on smart shoe 
technology since 2012. What on earth is a smart 
shoe useful for? The feedback from its sensors can 

be used to do everything from helping people learn 
to walk again following major surgery or a stroke to 
predicting the onset of a serious illness based on 
nuanced changes in their movement.

The list of emerging applications is immense 
when you combine the Internet of Things with 
5G. Connected crime reporting, smart street 
lights, air quality sensors, parking spaces, garbage 
collection, home security and automation, factories 
with unprecedented levels of production oversight 
and efficiency—you name it, it’s coming. And, 
yes, the refrigerator that reorders groceries when 
they run out is on the list, too. 

UP TO SPEED
So, now we know how 5G works. We know what it’s 
good for, and how it is and could be used. But what 
do we know about its real-world performance? 
Speed is one of the main selling points of 5G 
technology, but how fast is it? Inevitably, there is 
no simple answer. But there is plenty of hype. The 
sales pitch for 5G involves claims of speeds of at 
least 10 gigabits per second, making it about 100 
times faster than standard 4G, and 30 times quicker 
even than upgraded 4G tech, such as LTE-A.

At launch, operators in the US are making 
much more modest claims. Think very low single 
digits in gigabits per second, and you’ll have the 
right idea. That’s still a very nice upgrade over the 
circa 100Mb/s of a conventional 4G connection. 
Of course, there are several 5G networks already 
in operation in US cities. So, early performance 
figures are available. Independent tests of AT&T’s 
limited-availability network in Los Angeles 
returned figures of around 1.8Gb/s, while Verizon’s 
more fully functioning and consumer-available 
service in Chicago was a little lower at 1.3Gb/s.

To put a tangible spin on the fastest of those 
speeds, you’re looking at a 2GB file download in 
under 30 seconds. Or you could download multiple 
episodes of your favorite Netflix show in under a 
minute. Of course, the reality of 5G, just like any 
network generation, is that when it comes to speed, 
your mileage will vary. Among the early reviews of 

For 5G networks, large 

cell towers, like this, 

will be augmented by 

smaller millimeter 

wave cells.

Coated heat-

efficient glass poses 

a problem for 5G 

connectivity.

the 5G dream

48 SEP 2019 maximumpc.comMAXIMUMPC



©
 V

E
R

IZ
O

N
 &

 I
N

S
E

E
G

O
. 
P

IX
A

B
A

Y.

HOME AND AWAY

5G handsets are grabbing the early YouTube and social media bandwidth, 
but 5G is actually far from just a mobile technology. Indeed, when 
Verizon launched its first 5G services last year, it actually implemented 
its home 5G product first, following with a mobile service later.

The immediate benefits of home 5G are obvious enough. It enables 
fast broadband to be delivered without the need to connect to a wired 
infrastructure. In other words, no more digging up streets to lay cables 
and fiber. 

Verizon charges either $70 dollars a month for a standalone service 
or $50 to its mobile customers who have an existing plan of at least $30 
per month. The first three months are currently free, and there are no 
other up-front fees. For that you get claimed speeds of 300Mb/s. The 
service can also fall back to 4G connectivity if there are issues with the 
local 5G cells.

Early reports from customers suggest the performance claims are 
fairly realistic, while latencies in the very low double digits are often 
reported, meaning there’s little if any penalty in that area versus a wired 
connection. If that all sounds good, the service’s roll-out hasn’t been 
entirely smooth. In fact, Verizon has put the brakes on adding coverage. 
Verizon said in January that it was waiting on new standards-compliant 
hardware before resuming the roll-out. However, some commentators 
reckon the problem is more serious. 

According to a report by research analysts at MoffettNathanson, 
the effective range of the small millimeter wave cells is smaller than 
expected, so more cells will be required at greater cost to Verizon. 
Allegedly, Verizon has installed 200 cells in one of its initial locations, 
in Sacramento, California, but that covers just 10 percent of the city.

Verizon’s first 5G 

service was actually 

for homes, not mobile.

the first 5G services in the US, some noted that 
speeds seemed to drop off behind plate glass. 
That’s likely because of a combination of what’s 
known as low-E glass and millimeter wave signals 
used to provide high-speed local 5G connections. 

The problem is that many modern buildings 
now use low-E glass. That’s glass with a special 
metallic coating that reduces heat radiation and 
thus provides improved insulation. Unfortunately, 
millimeter wave radio doesn’t penetrate low-E glass 
terribly well. However, there are workarounds that 
can solve the problem, including active antennas 
fitted to window surfaces, but they do increase the 
complexity of implementing 5G, and it’s not clear 
how much latency they introduce.

Speaking of latency, that’s arguably an even 
more complicated question. 3G networks offer 
approximate latencies of around 65ms, while 
4G clocks in anywhere from 30 to 50ms. For 5G, 
figures of just 1ms are being mooted. But that’s 
a highly theoretical number. Ultimately, there’s a 
limit to how far latencies can be reduced. The laws 
of physics, including the speed of light, make sure 
of that. That oft-touted 1ms spec for 5G buys you a 
little under 100 miles in each direction of a round 
trip in terms of the distance that can be pinged 
at the speed of light. Much, then, depends on the 
location of the physical client and the data source 
it’s connected to.

By way of example of the physical limitations 
involved, the fiber-optic link between the 
Chicago and New York stock exchanges has been 
painstakingly optimized for low latency, even to the 
point of ensuring the paths of the cabling are as 
straight as possible. Even then, the round trip for 
pinging the opposite exchange could not be reduced 
below 13ms. The take home point here is that 5G 
can’t remove the baked-in latencies associated 
with significant geographical distance.

In some ways, then, 5G has been overhyped. 
You’re not going to get 10Gb/s and 1ms latency. Not 
today and, in most realities, not ever. But 5G is still 
going to change the world. It’s going to make the 
Internet even more ubiquitous, power a whole new 
class of connectivity, and enable new applications 
that have yet to be dreamt up. It’s not going to 
happen tomorrow, next week, or next year. But over 
the next decade, 5G is going to revolutionize not 
just the Internet, but the way we live and work. 

Yes, even farming is set to 

be revolutionized by the 

combination of 5G and the 

Internet of Things.
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TIP OF THE MONTH

MAKE – USE – CREATE

STEP-BY-STEP GUIDES TO IMPROVING YOUR PC

CHRISTIAN GUYTON
STAFF WRITER

SUPED UP
I’ve been toying with the idea of 
a GPU upgrade, but decided to 
hold off until the new AMD and 
Nvidia cards landed. I’m I glad I 
did; I imagine there’s more than 
a few angry PC gamers trying to 
get their RTX 2070 cards refunded 
now Nvidia has officially revealed 
the Super variant, boasting 
moderately better performance 
at exactly the same price.

So, the original 2070 and 
2080 have been marked for 
death, though the RTX 2060 
Super won’t be pushing out its 
predecessor. It was with mild 
annoyance that I noted the specs 
and benchmarking scores for the 
Super cards, as I was hopeful that 
the threat of new cards from AMD 
would kick Nvidia into overdrive. 
However, it feels like the Super 
GPUs only stand to secure Nvidia’s 
position as top dog in the graphics 
market; there’s no real innovation, 
just a mild performance bump, 
and a continuation of reliance on 
the ray-tracing USP.

Looking at the details of the 
new RDNA cards, it sadly looks 
as though AMD isn’t attempting 
to shake things up too much 
either. One possible glimmer of 
excitement comes from Intel, 
which is promising to make an 
appearance in the GPU game 
next year. Will it go budget and 
compete with AMD, or go high-
end in an attempt to bring down 
Nvidia? Only time will tell.

WRITE BETTER WITH GRAMMARLY
If you use your PC for word processing, you might be familiar 
with Grammarly, a program for simplifying and improving 
your writing. Well, there’s a Chrome extension, too—install it, 
and it actively works to turn whatever typing you do online into 
concise, typo-free writing worthy of Hemingway himself. It 
works for messages, comments, documents, and even social 
media posts, and the standard version is completely free.

↘ submit your How To project idea to: comments@maximumpc.com

62 
Design your own 
celestial bodies in 
Abode Photoshop
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Build a better 
home server 
with Docker

66 
Build your own 
NAS box, with the 
magic of open source
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THIS MONTH WE DISSECT...

presents:

MacBook Pro 15-inch 
Touch Bar 2019

About iFixit
iFixit is a global community of tinkerers 
dedicated to helping people fix things through 
free online repair manuals and teardowns. 
iFixit believes that everyone has the right to 
maintain and repair their own products. To 
learn more, visit www.ifixit.com.

Underneath 

the dome 

switch are six 

metal pads. 

A keystroke 

registers 

whenever the 

top-center pad 

is shorted to 

any of the other 

five pads.
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BACKGROUND
Apple’s newest MacBook Pro is its fastest yet, featuring an 
optional eight-core processor—a first in a MacBook—and 
a mysterious new keyboard material. As it’s unlikely that 
Apple’s going to expound on this “material,” and we’re never 
satisfied with an unsolved mystery, it’s time to take a closer 
look at the infamous butterfly keyboard. 

MAJOR TECH SPECS
•  15.4-inch LED-backlit IPS Retina display with True Tone, 

2880x1800 resolution (220 dpi), P3 wide color gamut

•  2.6GHz six-core Intel Core i7 (Turbo Boost up to 4.5GHz) 
paired with a Radeon Pro 555X

•  16GB of 2,400MHz DDR4 SDRAM

•  256GB PCIe-based SSD

•  802.11ac Wi-Fi and Bluetooth 5.0

•  Four Thunderbolt 3 (USB-C) ports

KEY FINDINGS
•  The butterfly keyboard landed on the MacBook Pro line for 

the first time in 2016. Designed to be super-thin, it proved 
controversial because of its extremely short throw—but 
soon proved unreliable as well. In summer of 2018, Apple 
launched a repair program and released updated models 
with a silicone membrane protecting the key switches. 
But problems have persisted. 2019’s revision keeps the 
silicone membrane, but tweaks the materials in the metal 
dome and the plasticky material that covers it.

•  Topping off 2019’s butterfly switch is the key cap. A hinged 
white bracket is the “butterfly” mechanism controlling the 
key’s motion. Nestling within that bracket is a transparent 
cover that flexes with each key press, while keeping 
contaminants away from the dome switch beneath.

•  The switch cover in the 2018 model was semi-opaque, 
somewhat tacky, and felt like silicone. The new model is 
clearer and smooth to the touch. The 2018 model was 
either polyacetylene with aromatic urethane side groups, 
or a type of TPU (which seems more likely). The 2019 
model is polyamide—commonly known as nylon.

•  We also think the metal dome switch may have changed. 
It’s like a tiny Snapple cap: Press down and it springs back 
up. If the dome is cracked or deformed, the key may 
behave erratically. If the prongs break or bend, the key 
stops working. These switches are also magnetized from 
the factory. Best guess as to their composition: ferritic 
stainless steel, with a thin polymer coating on the bottom. 

•  The fundamental problem with this laptop remains—with 
zero modular components, it means that if the slightest 
thing goes wrong, you’ll be replacing half the machine. 
Even if the keyboard is perfect this time, you’re taking a 
gamble on the rest. Our advice? Save your money. 

•  Repairability Score: 1 out of 10 (10 is easiest to repair). The 
trackpad can be removed and replaced with little drama. 
The processor, RAM, and flash memory are soldered to 
the logic board. Repairs and upgrades are impractical at 
best. The top case assembly, including keyboard, battery, 
speakers, and Touch Bar, is glued together, making those 
components difficult to replace. The Touch ID sensor 
doubles as the power switch, and is paired with the T2 chip 
on the logic board. Fixing a broken power switch may 
require help from Apple, or a new logic board.  

If you’re curious about how 

to get inside, it’s exactly 

the same procedure as the 

2018 edition.



Build a Better Home
Server With Docker

1 PICK A PLATFORM

You’re probably running Windows on your main PC, but 
while Docker is available for Windows machines, using it on 

Windows is not worth the effort. It sits much more comfortably 
on Linux, and as you’re going to dig up some old hardware and 
run a dedicated machine for your containers, that’s the way to 
go. Your first step, then, is to get that hardware (or a virtual 
machine, if you’re just looking to test things out) running Linux. 
We used the desktop spin of Lubuntu 19.04—download it from  
http://lubuntu.net [Image A], write it to a USB stick with Rufus 
(http://rufus.ie), boot up your machine, and install it, ensuring 
you use a very strong password if you’re likely to open the server 
up to the Internet in the future. You can run Docker just fine on a 
Raspberry Pi, but the power available to its individual containers 
may not be adequate to tease strong performance out of them.

2 SET THE CONNECTION

It’s obviously a good idea to set up headless access to your 
server, so you can administer it from your main PC, and do 

away with the monitor and keyboard. Open up a terminal window, 
and run sudo apt update  followed by sudo apt install openssh-
server  to install a decent SSH server; run sudo systemctl status 
ssh  when you’re done to check it’s running. It’s also handy to 
have a fixed IP address, so your server doesn’t go walkabout if 
you reboot: While still at the desktop, you can set this by heading 

EVERY GOOD HOME NEEDS A SERVER. It doesn’t really matter what you intend to use it for. 
Whether you’re throwing media around, performing backups, running game servers, or doing 
any other nebulous serving work, a dedicated machine is the best way to go about it—it leaves 
your main box free to work its hardest, and means those services are available whenever you 
need them. But the worst thing about a server is when it isn’t there any more. If one of your 
software components forces a reboot, crashes the machine completely, or if it decides it likes 
system resources so much that it would like to take them all, everything else falls to bits along 
with it. Unless, that is, you manage your server properly.

Predictably, this brings us to Docker. Essentially, it’s a way to compartmentalize everything 
on your server—each Docker container you run sits in its own sandboxed space, only reaching 
out as far as you let it, which means that while Docker containers can interact with each other, 
they’re also able to be completely insulated. They’re like little servers in their own right: If 
something goes wrong, just reboot the container. And it’s so simple to get started…. –ALEX COX

YOU’LL NEED THIS

SERVER HARDWARE 
Use whatever spare silicon 

works for you.

LUBUNTU 
Grab it from http://lubuntu.net.

DOCKER COMMUNITY 
EDITION 

You can find out more at 
www.docker.com.

to the network manager via the icon in the top-right of the 
screen, selecting wired or wireless settings (depending 
on your connection), clicking the gear icon, and filling in 
the appropriate boxes. Reboot your server machine, and 
you should be ready to go.

3 HOOK YOURSELF UP

Frustratingly, the best SSH tool for Windows still 
seems to be the aging PuTTY (http://putty.org), 

though if you’re cunning, you could also run the distro of 
your choice over the top of Microsoft’s Linux Subsystem 
for Windows and access SSH from the command line. 
Head to your main PC, fire up PuTTY, and connect to the 
IP address you set earlier. On your first connect, select 
“Yes” to add the host key to PuTTY’s cache, and log in 
with the username and password you set earlier. 

4 DOING DOCKER

Next, install Docker, which, due to our awkward 
choice of OS, means grabbing an older version. 

Start by adding the Docker GPG key to your server with  
curl -fsSL https://download.docker.com/linux/ubuntu/

gpg | sudo apt-key add -  then add the Docker repository, 
so your server knows where to find the files, with sudo 
add-apt-repository “deb [arch=amd64] https://download.
docker.com/linux/ubuntu cosmic stable edge” . Once 
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that’s done, update the package manager ( sudo apt-get update ), 
then check that your system is getting Docker from the right 
place by typing  apt-cache policy docker-ce  and scrutinizing 
the results. Happy? Fire off  sudo apt-get install -y docker-ce  to 
install the Docker Community Edition.

5 OUT OF CONTAINMENT

Docker tends to keep to itself, but it should now be installed, 
and its service should be running in the background—try  

 sudo systemctl status docker  to see if it is indeed running. 
It’s important to note that the service, or daemon, is a separate 
entity from the command-line tool—the service will run when 
your system boots up, which means that once you’ve set up a 
Docker container, it’ll stay active until you explicitly kill it. Let’s 
try that now: Run  sudo docker run hello-world —the command-
line app will prod the daemon, which will first check for a local 
container, then (as it hasn’t found one) head to Docker’s servers, 
download the “hello-world” package, add it to its own database 
(allocating it the relevant storage and resources as it does so), 
then run it, spewing its output [Image B] to the command line. 

6 PICKING PORTS

Running a “hello world” does nothing for us, other than 
prove that Docker is working, but it’s an example of how 

simple it can be to get a Docker container up and running. Let’s 
install something slightly more practical to show off Docker’s 
power: Try running the command  sudo docker run -d --name 
wiki -p 8181:8080 mkodockx/docker-wiki . This tells Docker, in 
order, that we want to run something, we want it detached ( -d ) or 
running in the background, we want to call the container “wiki,” 
and that we want to connect TCP port 8181 on our host machine to 

C D

8080 inside our container. Finally, we tell Docker where 
to find the image to use for our container. Just like that, 
your server is playing host to a full-blown wiki running 
on top of NodeJS—all the installation, all the folder 
structure, all the messing around with LAMP stacks is 
done for you. One command, and it’s running. Connect to 
the appropriate port of your server in a web browser (in 
our case, this is 192.168.1.224:8181), and it’ll be there—
and if you wanted to run a second instance of the wiki, 
just run the same command, switching out the name for, 
say, “wiki2,” and connecting it to a different port. Run  
 sudo docker ps  to see what containers you have 
running [Image C].

7 TAKE IT FURTHER

So, what to do with your new-found powers? 
Realistically, whatever you like. There’s a vast 

catalog of tools available at http://hub.docker.com, 
some of which will likely be less useful than others. That 
said, you can pick up the likes of Plex (turning your server 
into a media hub) [Image D], OwnCloud (for convenient 
network file storage), OpenVPN (connect through your 
home network from afar), and much more—and there 
are other resources to check out, too, such as the 
excellent www.linuxserver.io. We’re also running a 
pair of servers for Brutal Doom via https://hub.docker.
com/r/rcdailey/zandronum-server. In this case, Docker 
is handy for setup and isolation, but since the server 
announces your IP address on a global browser, it does 
expose you somewhat, so you’ll want to make sure your 
router’s firewall is in good shape. 

What’s running on your Docker box? 
Given how easy it is to fire up a new 
container, the answer quickly becomes 
“quite a lot.” Managing those individual 
software appliances is key to having an 
efficient time with everything. If you’re 
using the command line, typing  sudo 
docker ps  lists all the processes that 
Docker is currently managing; once 
you’ve got that information, you can use  
 sudo docker kill  followed by the 
process ID to shut things down as 
required. Basics of management 
covered, then, but there’s much more 

to it than that. Creating a “docker-
compose” file for all of your apps is 
a great way to make sure they’re all 
configured properly (see http://docs.
docker.com/compose for more on that) 
and to run a large collection of them 
with a single command. And if you want 
to see what your server is up to, there’s 
a number of management containers 
that can help: The likes of Portainer, 
Grafana, and Prometheus can help 
you keep tabs on system resources 
and manage running containers with a 
point-and-click web interface.

CONTAINERS UPON CONTAINERS
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Set Up a Secure
Shell Honeypot

1 READY YOUR BOX

You may be familiar with Docker, particularly if you’ve read 
the tutorial on page 54. We’re going to use it here to manage 

our honeypot, because it makes restoring a destroyed system as 
simple as a single command. And given that we’re actively trying 
to make something disposable, destructible, and dedicated, 
the ideal platform is a Raspberry Pi; we tried the Pi Zero, but a 
combination of its ARM v6 processor, low power, and the staunch 
refusal of the latest Raspbian Buster to play nice drove us toward 
a RPi 3 Model B—don’t let that stop you trying, but be aware that 
you may be in for some heartache. You may, if you don’t want to 
draw attention to the rest of your network, run your honeypot 
on someone else’s hardware: A VPS, or virtual private server, 
is generally cheap to rent, and grants you access to a full Linux 
shell. We’re going to take the risk, but that’s definitely an option. 

2 INSTALL A HOST OS

First up, prepare your RPi. Grab a microSD card, head to 
www.raspberrypi.org, download Raspbian Lite (where 

we’re going, we don’t need desktops), then install it on the card 
[Image A]. Just for a change, use the excellent Balena Etcher 
(www.balena.io/etcher) this time. But don’t pop the card in 
your RPi quite yet—ignore Windows’ protestations about the 
card needing formatting, and open up the drive volume marked 
“boot.” Create a blank text document in the root folder—we’re 
going to use this file, in an area completely inaccessible to your 
honeypot, to preload your Wi-Fi credentials, so you can boot the 
Pi headless. Skip this step if you’re attached by Ethernet. Open 

WHETHER THEY’RE OPPORTUNISTIC “SCRIPT KIDDIES,” actual paid hackers on some Chinese 
payroll, or zombie computers compromised by malware, there’s a huge number of forces trying 
to sniff around your network. A quick browse of your router’s firewall logs (or those of Windows’ 
own second-line-of-defense firewall) will likely make for worrying reading: Your ports are 
probably being scanned, probed, and poked to within an inch of their lives. There’s little you 
can do, save for sleuthing out the snoopers and stopping them in real life (something we don’t 
endorse). Instead, how about taking the path of least resistance, and just letting them in?

Crazy talk, right? Not so much. Setting up a honeypot, a sandboxed and safe area of your 
network, running on disposable hardware, which appears from the outside to be a juicy server 
worthy of exploitation, is an interesting idea with a nefarious side effect: Hackers can poke 
around and ideally feel as if they have accomplished something, thus thoroughly and fruitlessly 
wasting their time. If that doesn’t make you feel good, your heart needs hacking. –ALEX COX

YOU’LL NEED THIS

A RASPBERRY PI 
Version 2 or better.

RASPBIAN BUSTER 
The latest spin on the Pi OS.

COWRIE 
A great honeypot (see https://

github.com/cowrie).

the file, and insert the following (replacing <name> and 
<password> for your SSID and network key).
country=US
ctrl_interface=DIR=/var/run/wpa_supplicant 
GROUP=netdev
update_config=1

network={
  ssid="<name>”
  psk="<password>”
  key_mgmt=WPA-PSK
}

>> Save it with the name  wpa_supplicant.conf . Then 
create a second empty file (Ethernet users, you’ll need 
to do this, too) called simply  ssh , which tells Raspbian 
you want SSH (Secure Shell) switched on. Put the card 
in your Pi, power it up, and boot up your headless system.

3 FIND IT

You need to find the IP address of your Pi in order 
to connect—try using your router’s web interface 

to see what’s connected. You’ll need this interface later, 
so now is a good time to get connected. Log in to your Pi 
via SSH using PuTTY (www.putty.org) with the username 
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“pi” and the password “raspberry.” Before we go further, let’s 
add a sliver of security and change that password [Image B] by 
running  passwd  and entering something non-default.

4 DO DOCKER

Now it’s time to install Docker—easy on the Pi, right? 
Kinda. At print time, with the recent upgrade to Raspbian 

Buster, Docker’s devs have yet to release a new stable version. 
No problem, though: We can use a little sidestep to get things 
working. First, run  sudo apt update  to make sure all your core 
packages are up to date, then run  curl -sL get.docker.com | sed 
‘s/9)/10)/’ | sh , which pulls an install script from Docker’s servers, 
tweaks a couple of values, and runs it—this should install it 
without issue. Try  sudo docker run hello-world  to test it out. 

5 PORT PROTECTION

Before we install our SSH honeypot, we need to change 
the default port that the Pi uses for SSH communication, 

lest we lock ourselves out. This is good practice whether you’re 
running a honeypot or not—hiding the entrance can make 
servers more resilient to attack. Run  sudo nano /etc/ssh/sshd_
config , scroll down to the line marked  #Port 22 , remove the 
octothorpe, and change the port number to something you’ll 
remember—2121 is a decent unused port, if you’re looking for 
inspiration. Hit Ctrl-X followed by Y to save and exit, then run  
 service sshd restart  to restart the SSH daemon. It should kick 
you from your PuTTY session, so log back on, this time changing 
the SSH port to match your new one.

6 TASTE THE HONEY

There are various honeypot containers that have already 
been put together by Docker users, but we’re going to go 

with Cowrie, a long-developed and mature honeypot coded in 

Python—and we’re going to build a version specifically 
for the Raspberry Pi. Run  sudo apt install git , then  
 sudo git clone https://github.com/cowrie/docker-
cowrie.git  to download the appropriate files. Use  cd 
docker-cowrie  to enter the appropriate directory, then  
sudo make all  to start the Raspberry Pi grinding away at 
the source code. This takes a while (particularly running 
on the ARM architecture of the Pi), but it’s necessary 
because there’s no up-to-date ARM package on the 
Docker Hub—and it ensures (all being well) that every 
file works on the hardware you’re running. When it’s 
done, run  sudo docker images  to check that it’s there.

7 HACK ON IN

With the honeypot built, you can run your container 
with  docker run -d --name honeypot -p 22:2222 

cowrie:devel , noting the  -p 22:2222  portion, which 
maps the internal 2222 port that its SSH server runs on 
to 22 on your local machine. This means anyone looking 
for a standard SSH server will find your honeypot, rather 
than the actual SSH path to your host machine, which is 
why we changed it earlier. Test it yourself: Open a new 
instance of PuTTY, log in to port 22 of your Raspberry 
Pi, and you should see a login screen [Image C]. Using 
the username “root” and literally any password you like 
will get you into the simulated command line. Cause 
chaos, do what you like, because you’re in a safe space 
now. Isn’t that nice? The final step is to head over to your 
router’s port-forwarding page (and this is going to differ 
for every router, so we’ll leave the specifics to you), 
and pipe any incoming traffic on port 22 to the local IP 
address of your Raspberry Pi [Image D], thus capturing 
that horrible hacker traffic in the right place. 
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Having a honeypot to keep hackers 
busy is one thing, but it’s far more 
interesting if you can actually see 
what those interlopers are up to. We 
can take that to the extreme: Let’s see 
exactly what was input into Cowrie 
with the exact timing at which it was 
input. The container keeps its own 
logs, and even includes a tool that can 
play them back in real time. Start by 
opening up a bash shell within your 
Cowrie container using  sudo docker 
exec -it honeypot bash —this basically 

gives you a command line running 
entirely inside the container. Then type 
the following without hitting Return:  
 playlog /cowrie/cowrie-git/var/lib/
cowrie/tty/ . Now hit Tab, and you’ll see 
a bunch of files listed with awkward-to 
remember hashed file names: Type the 
first couple of characters, hit Tab again 
to autocomplete, then hit Return to see 
that access played back. At first, you’ll 
only see your own basic fumblings, but 
as the list grows, you may see some 
very interesting shenanigans….

MONITORING YOUR HONEYPOT
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Build a Blog with 
Open Live Writer

1 SIMPLE SETUP

Open Live Writer can be installed via the Microsoft Store 
or downloaded directly from (http://openlivewriter.org). On 

first launch, the app asks you to select which blogging services 
you already use. Click the radio button next to a service to 
select it. You can add further blogging platforms once setup is 
complete. The setup wizard now asks for the web address of your 
blog, along with your username and password. Click “Next” to 
continue. Open Live Writer immediately begins analyzing and 
synching your blog. For certain platforms, the app offers to 
publish a temporary post. This is a fast and simple way for Open 
Live Writer to download your blog theme, enabling you to view 
posts as web users see them. Click “Yes” to agree. Once setup 
is complete, Open Live Writer prompts you to set a nickname for 
the blog (the default is the blog name). Click “Finish” to confirm. 

2 YOUR FIRST POST

Once setup is complete, Open Live writer prompts you to 
create a new blog post. Fill in the field marked “Enter a 

Post Title,” then enter your post text below. 
>> You can access text editing options such as “Bold” or 

“Center Align” using the taskbar at the top. Click the “Picture” 
icon to add an image from your PC or the web. Highlight text and 
click the hyperlink icon to insert URLs; if a web address has been 

THE WORLD HAS YET to reach “peak blog.” Until it does, the Internet will continue to be swamped 
with bloggers sharing their obsessions, from exotic vacations to rare bottle caps. There are 
hundreds of platforms to choose from, many of which offer free tiers. 

Open Live Writer is a lightweight, open-source fork of the popular Windows Live Writer. 
It’s designed to bring order to the madness of juggling various blogs. On first launch, you’re 
asked to connect your blogging account—a number of popular platforms, such as WordPress, 
Blogger, and DashBlog, are supported. 

Once logged in, you can use the word processor-style interface to create and edit blog posts. 
The application supports basic features, such as changing fonts, adding pictures, and inserting 
hyperlinks, as well as more advanced tools, such as adding categories and tags, embedding 
videos, and scheduling posts for later publication.

Open Live Writer can support any number of blog accounts, enabling you to switch effortlessly 
between various platforms. Aside from consolidating your blogging, the app can also be used to 
prepare and save posts offline. In this guide, you’ll discover how to get started with Open Live 
Writer, as well as how to use some of its more advanced editing features. –NATE DRAKE

YOU’LL NEED THIS

OPEN LIVE WRITER
Download it from the Microsoft 

Store or directly from http://
openlivewriter.org.

copied to the clipboard, it displays automatically. To save 
a draft, go to “File > Save.” From this submenu, choose 
“Save” to save a draft to your computer; to save a post to 
the online draft section of your blog, select “Post Draft 
to Blog.” If you choose this, you may be asked to sign in 
again [Image A]. Check the box marked “Remember Your 
Password” to avoid this in the future.

3 REVIEW AND PUBLISH YOUR POST

Once you’ve created your post, click the “Preview” 
tab at the bottom-left to see your blog as it would 

appear with your latest news. If you’ve previously chosen 
to save a post to online drafts, you can also view this in 
your browser by clicking the draft post title. Click the 
“Edit” tab to make any last-minute changes. Power 
users can edit raw page code via the “Source” tab. When 
ready, click “Publish” in the taskbar at the top. Open Live 
Writer automatically launches your blog in your browser 
once the post is uploaded, so you can review it.

4 ADDING MULTIPLE BLOGS

Open Live Writer supports multiple platforms 
and accounts. If you manage another blog, open 

the “Home” tab, click the name of your current blog in the 
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taskbar, then select “Add Blog Account.” This reopens the wizard 
you saw when you first launched Open Live Writer. Select your 
blogging platform and fill in your credentials as outlined earlier. 
By default, when you click “Finish” [Image B], the app switches 
automatically to the blog you just added. Click “File > New” to 
create a blank post. In future, be sure to select the correct blog 
from the taskbar at the top-left before clicking “Publish.” 

5 SCHEDULING POSTS

Open Live Writer supports publishing posts at a later date 
or time. To do this, visit the “Edit” tab and prepare your 

post for publication. Next, click the box marked “Set Post Date” 
at the top-right. A mini calendar drops down, enabling you to 
choose a publication date [Image C]. Click the “Time” field and 
use the up and down arrows to choose a specific time. Posts listed 
for publication are uploaded automatically to the “Scheduled” 
section of your blog platform. This means there’s no need for 
you to keep Open Live Writer running until the publication date. 

6 SETTING CATEGORIES

Although categorizing blog posts is not essential, doing so 
is helpful for both visitors to your site and search engines, 

as they make your blog much easier to navigate. Open Live Writer 
supports creating categories from the “Edit” tab. Simply click 
the drop-down menu in the “Set Categories” pane on the left. 
From here, you can choose “Add Category.” If you’ve previously 
published a post with a category, such as “Cats,” you can set 
this as a parent for your new category—“Semi-longhair,” for 
example—using the drop-down menu at the bottom [Image D].  

7 CUSTOMIZE BLOG PREFERENCES

You can fine-tune your blog settings even further by 
accessing “Blog Account” at the top-left of the screen. 

Choose “Blog Options” to view your account settings. From here 

D

you can change your blog title using the “Blog Name” 
field. Use the “Pictures” section to choose between 
uploading images directly to your blog or via FTP. If 
you’ve recently changed your blog theme via the website, 
click “Update Theme” to reload this into Open Live 
Writer. Use the “Advanced” section to alter your blog’s 
default character set or markup language [Image E]. 

>> If you need to make more radical changes, select 
“Dashboard” to open your blog configuration page in the 
browser. You can also view the comments section via 
the “Manage Comments” button. Remember that not all 
features are supported by every blogging platform, so 
some options will be disabled. 

EC

The overall look and feel of Open Live Writer is very similar 
to that of popular word processors, such as Microsoft 
Word. If you need to edit an existing post for any reason, 
simply go to “File > Open Recent Post,” then choose your 
previous entry. Open Live Writer only supports editing 
posts that were originally created in the app itself. 

Highlight any text, then you can choose a new font from 
the drop-down menu in the taskbar. The fonts available 
should match those on your blog platform.

For more advanced editing, click the “Insert” tab. From 
here, you can add tables, insert maps, and even embed 
videos. You can hugely boost your posts’ SEO ranking by 
using tags. To start doing this, first select a tag provider, 
such as “LiveJournal,” from the drop-down menu at the 
bottom of the screen. Once you’ve made your changes, 
return to the “Home” tab, then click the “Publish” button in 
the taskbar. Your post is re-uploaded automatically.

EDITING TIPS & TRICKS
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Synchronize Your Life 
With Wunderlist

1 GETTING STARTED 

Wunderlist is available on a variety of platforms; there is 
a web-based version (www.wunderlist.com), or you can 

download the app, which can be found in the Microsoft Store. 
>> To install Wunderlist, open the Microsoft Store, then type in 

“Wunderlist” and select “Get.” Click “Launch”—on the first run, 
you need to sign in or create an account. If you don’t want to use 
your Microsoft account, you can sign in via Gmail. Alternatively, 
access the web-based version of Wunderlist at (www.wunderlist.
com). This guide focuses on the desktop application.

 

2 YOUR FIRST TO-DO LIST 

Wunderlist displays your To-Do Inbox on the right. Tap 
“Add a To-Do” and input the name of the list you’d like to 

create. Once you’ve completed the details, press Enter to confirm. 
The item appears in your Inbox in the “To-Do” section. To rename 
an item, click it. A pop-up box appears. Click to highlight an item 
name to edit it. Press Enter to save changes. 

>> To mark a task as complete, click the checkbox beside it. The 
task is moved to “Completed To-Dos.” Uncheck a completed task 
to restore it. To delete a task, right-click, and choose “Delete.” 

 

3 SET DUE DATES AND REMINDERS

Wunderlist supports both single and recurring reminders. 
The app can display notifications and/or send you an 

WHEN IT COMES TO MANAGING YOUR LIFE, Wunderlist offers a number of benefits over writing 
down everything you need to do on the back of an envelope. In the first place, when you sign up, 
you’ll see that you can access Wunderlist via the dedicated desktop app or the website, so your 
to-do items are safely synched to the cloud. You can also have Wunderlist prompt you via push 
notification and/or email about important things you need to do.

If you’re planning a major project, Wunderlist also supports dividing activities into subtasks 
and annotating them with your own notes. You can create as many lists as you want and even 
share them with friends and family for comments and completion.

There’s a basic free version of Wunderlist, but for $4.99 a month, you can upgrade to Pro. 
This enables you to assign an unlimited number of tasks to others, as well as create an infinite 
number of subtasks. This may useful if you’re planning a large undertaking, such as charity 
work or running a small business. Larger organizations can also benefit from Wunderlist—for 
$4.99 a month per user, the Business version supports all the Pro features, plus centralized 
billing and team management. –NATE DRAKE

YOU’LL NEED THIS

WUNDERLIST 
Download the app from the 
Microsoft Store, or use the 

web-based version at  
www.wunderlist.com. 

email when an item is due. To set a reminder, right-click 
on a task, then scroll to “Due Today” or “Due Tomorrow.” 
To set a different time, click a to-do item, then in the 
pop-up box that appears, select “Set Date & Reminder” 
[Image A]. For recurring tasks, click the arrow below the 
reminder’s new due date. From here, you can choose 
“Never repeat,” “Repeat every day,” “Repeat every 
week,” “Repeat every month,” or “Repeat every year.” 

>> To change notification settings, click your name 
on the left-hand side of the app, then click “Settings.” 
Scroll to “Notifications.” By default, both email and 
push notifications are enabled. Toggle the button next to 
each notification type to enable or disable. 

 

4 SUBTASKS AND NOTES

Wunderlist enables you to add subtasks to each 
task you create. You can also add explanatory 

notes if you wish. 
>> Click the “To-do” list you want to edit. In the pop-

up box, select “Add a Subtask.” Type in the extra to-do 
item, then press Enter to create your subtask. You can 
add as many subtasks as you wish. Click the “x” beside a 
subtask to delete it. 

>> To add a note to your task, click “Add Note” below 
the “Subtask” field. Write the note, then press Enter 
once you are done. This note is now added to your  
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“To-Do” event. If you need to edit an existing note, you can do so 
by returning here. 

 

5 SMART LISTS 

Smart Lists are a type of filter view, which group certain 
tasks together based on specific criteria. For example, all 

“Starred” to-do lists are grouped together, as are any tasks that 
have been assigned to you personally. Smart Lists appear at the 
top of the left-hand pane. 

>> To set up Smart Lists, go to your settings. From here, you 
can choose from “Auto,” “Visible,” and “Hidden.” “Auto” Smart 
Lists only appear if relevant. “Visible” smart lists always appear 
in the left-hand pane.  

>> You can choose which lists are displayed. By default, most 
options are set to “Auto.” The “All” section and “Week & Today 
Settings” are set to “Hidden” and “Show All To-Dos” respectively. 
You can switch between “Auto,” “Visible,” and “Hidden” for each 
option via the drop-down menu.  

 

6 SHARING 

You can add lists by clicking “Create List” at the bottom-
left. These lists can be shared with friends, colleagues, 

and family members. To do this, select the list on the right-hand 
side. Choose the “Share” button. Enter your recipient’s name or 
email address in the pop-up box, then click “Save” [Image B]. An 
invite to view the list is then sent. While your recipient can see  
to-do items, they need a Wunderlist account to be able to edit 
them or mark them as complete. 

C

7 ACTIVITIES CENTER 

If you choose to share a list with a fellow 
Wunderlist user, you can collaborate on tasks 

together. Any tasks or subtasks completed by your 
contact appear in the Activity Center. Simply click the bell 
icon at the top-right of the screen to view notifications. 
Each time you open Wunderlist, a red number appears 
next to the Activity Center icon—this shows how many 
unread notifications you have. 

>> Click the “Conversations” on the left-hand side to 
view any comments made on tasks by collaborators 
[Image C]. Click a comment to view the entire 
conversation and add replies of your own. 

 

8 OTHER FEATURES 

If you have a large number of to-dos, Wunderlist 
supports organizing them into folders. Move your 

mouse over the to-do list you want to move, then drag 
and drop it into your chosen category in the left-hand 
pane—for example, “Assigned to Me.” 

>> You can add a task to the “Starred” list [Image D] by 
navigating to the “To-Do” in the inbox, and clicking the 
star icon beside the name of the task.

>> If you would like to change the appearance of 
your app, first click your name, then select “Change 
Background.” From here, you can choose from a variety 
of images. Just click on your preference, and the 
background changes. 

D

Google Chrome users can install the 
Wunderlist extension. This enables 
you to quickly bookmark items and 
save links to your Wunderlist account 
from sites such as Amazon, Gmail, and 
Outlook.com. 

To add the extension, go to https://
chrome.google.com/webstore and click 
“Add to Chrome.” Once installed, the 
Wunderlist icon appears to the right of 
your address bar. Click this, then log in 
to your Wunderlist account. Once this 
is done, click the Wunderlist extension 
icon again to automatically create a 
new to-do item from the current URL. 
Use the drop-down menu to choose 
which list you want to add the item 

to. Alternatively, choose “Create New 
List” to begin a new list—“Christmas 
Shopping,” for example. The URL itself 
is stored in the “Notes” section for 

each task. Click the link to launch it in 
your browser. At the time of writing, 
there were no extensions available for 
Microsoft Edge or Mozilla Firefox.

BROWSER EXTENSION FOR CHROME
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Design Your Own
Celestial Bodies

1 LET THERE BE LIGHT

Create a new document at an appropriate size—we’ve gone 
for 1920x1080 pixels—and create a new layer from the 

Layers palette, then delete the background layer, so you have a 
single, floating, transparent layer. For the first planet, use the 
Elliptical Marquee tool to create a circle (hold Shift) in the center 
of the canvas—use Smart Guides to find the center—and head 
to “Edit > Fill.” Click “Custom Pattern” and choose “Ant Farm” 
or “Water” (we’ve used the latter) [Image A]. The circle fills with 
your pattern, but it’s repetitive and looks artificial—we’ll deal 
with this later, but you could use a custom non-repeating texture 
image, drawing your circle on it, before cutting it to a new layer. 

2 A VAULT BETWEEN THE WATERS

To break up the repetition, and to make the planet look 
more like a planet, use filters. It’s worth converting the 

layer for Smart Filters (from the “Filter” menu) first—this allows 
you to come back and edit them later. Following this, and with 
the selection still in place, open “Filter > Filter Gallery.” We’re 
going to build up three layers of filters, beginning with Stained 
Glass (from “Texture”). Add a new filter layer using the button at 
the bottom-right of the Filter Gallery, and add Diffuse Glow from 
“Distort.” Add a new layer and apply Bas Relief from “Sketch.” 
Play with the settings for all three until you’ve got something 
you’re happy with. Ours looks like one of the moon’s maria, and 

THE FINAL FRONTIER IS NOT, as we’d previously supposed, a custom loop of hard-piped water 
cooling, but space itself. Until we can use miniature stable wormholes to employ the chilly 
temperatures of a hard vacuum to cool our CPUs (give it time, it’ll happen), we have to resort to 
our imagination to conjure planetscapes around distant stars.

Photoshop is well placed for this kind of digital background painting, as it contains all the 
tools you need to create a reasonably lifelike solar system view. If you want to import your own 
textures, you can, but we’ve chosen to use the app’s own features, and fix their shortcomings.

Good textures for a planet’s surface can be anything from a rusty patch on the fender of 
a truck to a weatherbeaten sidewalk being forced apart by weeds. Anything can become a 
texture, and it will be especially challenging to find one if you want to have a network of cities 
visible on your planet. 

If you’re interested in rendering spaceships, this is the perfect sort of background to show 
off your creations. Otherwise, you can use it as a backdrop for text, or just as a relaxing screen 
wallpaper. –IAN EVENDEN

YOU’LL NEED THIS

ADOBE PHOTOSHOP 
Subscribe to a suitable 

package at www.adobe.com.

if we darken off the red color using “Levels” or “Hue/
Saturation,” it’ll look a bit like Pluto [Image B].

3 LET THE DRY LAND APPEAR

If your planet looks flat, use “Filter > Distort > 
Spherize” to give it some bulge—this is why the 

original circle had to be in the center, as Spherize works 
from the center out. When happy, create a new layer, fill it 
with black, and move it to the bottom of the layers stack. 
That’s your howling void. Back on dry land, we’re going 
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to add Layer Styles to our planet—double click its layer, and 
add Inner and Outer glows from the “Styles” window to give the 
impression of a diffuse atmosphere. Don’t make them white—we 
want them to transition from the darkness of space, so choose a 
mid-gray, and keep them soft and noise-free [Image C].

4 GIVE LIGHT UPON THE EARTH

Or the red planet, anyway. The local star in this system is 
off to the top-right, so to create a planetary crescent, we 

can create a new layer, put it on top of the stack, and bring back 
the circular selection (“Select > Reselect”). On the new layer, 
fill the circle with black, then deselect, and use the Move tool to 
drag the circle to one side, revealing the planet. Use Gaussian 
Blur (“Filter > Blur”) on the layer to soften its edge (convert for 
Smart Filters if you want) and you get a nice crescent [Image D].

5 HE MADE THE STARS ALSO

To make a starry background, select the plain black layer 
at the bottom of the Layers palette, and use “Filter > 

Noise > Add Noise.” Use Levels on the layer to clip the black 
and white ends of the histogram—this reduces the number of 
dots, for a more realistic look [Image E]. It’ll still look wrong 
when the planet is in the center, so select the layers that make 
up the planet and shadow, and pull them to the bottom-left with 
the Move tool. Group these layers, and duplicate the group, and 
you have another planet to position and resize. Use Filter Gallery 
(editable as a Smart Filter) and Hue/Saturation to change its 
look, and Free Transform (“Edit” menu) to move and scale it.

6 LET THERE BE MORE LIGHT

Finally, we’ll add a light source. Place a new layer at 
the top of the stack, and draw a rough star shape with 
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the Polygonal Lasso, filled with white. Deselect, and 
apply “Filter > Blur > Radial Blur” in Zoom mode and 
at 100% and Best quality. Then apply a Gaussian Blur. 
Duplicate the layer a few times (we did three), and use 
Free Transform on each to rotate it around until you have 
a bright-centered, diffuse light object rising above the 
large planet’s edge [Image F].

7 LET THERE BE LENS FLARE

If your space movie is directed by J.J. Abrams, it 
needs a little lens flare. Happily, Photoshop has a 

filter that can do that, in “Filter > Render.” If you try to 
use it on the layer containing your sun, however, you’re 
going to be disappointed. For a far better effect, use it on 
the black background layer with the noise on it. Run the 
filter, and see what different effects you can create in the 
tiny preview window. Our example is of the 50–300mm 
zoom type at around 85% brightness [Image G], but use 
whatever looks good. Now all the scene is waiting for is 
for you to place a 3D rendered spaceship in it. 

F

If you’re going to use your own textures, it’s worth loading 
them into Photoshop as Smart Objects rather than as 
straightforward raster layers, and making them in the 
highest resolution possible. A Smart Object provides a link 
to the source file, going back to it as a reference every time 
you manipulate it, so you can shrink it and enlarge it again 
without the loss of quality you’d usually associate with 
such a maneuver. Along with Smart Filters, this is one of 
Photoshop’s biggest steps toward non-destructive editing. 
A layer converted to use Smart Filters becomes a Smart 
Object in its own right, giving you the best of both worlds.

SMART OBJECTS  
AND FILTERS
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Get Started With 
Google Drive

1 SIGN UP FOR AN ACCOUNT

Go to https://drive.google.com, and click “Go to Google Drive.” 
If you already have a Google account, you can sign in and start 

using Google Drive, but if not, click the “Create account” link to 
get started. You’re guided through the process of choosing a 
Gmail email address and securing it with a password.

2 DOWNLOAD BACKUP AND SYNC

When you are signed in to Google Drive, look to the lower-
left of the page, and click the button labeled “Get Backup 

and Sync for Windows.” You’re taken to the download page, 
where you need to click the “Download” button in the “Personal” 
section. Save the file, then run through the installation. Launch 
the program, and you’re invited to sign in to your Google account.

3 CONFIGURE BACKUP AND SYNC

Choose which folders you would like to synchronize 
between your computer and Google Drive. Backup and 

Sync automatically selects your Desktop, Documents, and 
Pictures folders, but you can deselect these. You can also add 
more folders with the “Choose Folder” button [Image A]. There’s 
no limit to the number of folders you can sync, other than the 
amount of space available. 

4 FILE AND PHOTO OPTIONS

By default, all files in your selected folders are backed 
up, but you can adjust this with the “Change” button. You 

can opt to only back up the image files in those folders, or click 

TALK OF “THE CLOUD” CAN BE CONFUSING if you’re unfamiliar with the term, but it’s really 
just a way of referring to storing files online. You may want to store a second copy of important 
files online to serve as a backup, for instance, or you may want to access your files from any 
computer connected to the Internet. Storing files in the cloud also makes them easier to share.

There are numerous cloud storage services to choose from, but perhaps the most well 
known is Google Drive. You can use it in a couple of ways, the first being to employ your web 
browser to explore, create, and edit files online. Perhaps more useful is to download the 
desktop software—called Backup and Sync—because this enables you to select a folder on 
your computer’s hard drive that will be synchronized to Google Drive online, and you can sync 
with multiple computers, so the same files are available everywhere. –MARK WYCIŚLIK-WILSON

YOU’LL NEED THIS

GOOGLE ACCOUNT 
If you don’t have one, sign up at 

https://drive.google.com.

“Advanced Settings” to specify file types to ignore. To 
avoid filling all your storage with photos and videos, you 
can opt to drop their quality to High, and you are given 
free, unlimited storage for them.

5 YOUR GOOGLE DRIVE FOLDER

Click “Next,” and you’re prompted to choose a 
folder on your hard drive where Google Drive files 

should be stored. Any files and folders you add to this 
folder are automatically sent to Google Drive online, and 
any files you create online—or that are synchronized 
from other computers or devices, such as phones and 
tablets—are synchronized to this folder.

6 NAVIGATE FILES ONLINE

You can continue to create and edit files on your 
computer as normal, and any files you place in 

the Google Drive folder are then synchronized to the 
cloud. Many types of files can be viewed or even edited 
online. Visit Google Drive in a web browser, and you can 
navigate through your files. Double-click a file to open it, 
or right-click to choose an online app that can be used to 
edit the file [Image B].

7 SHARE FILES WITH OTHERS

One of the great things about Google Drive is that 
it enables you to easily share files with friends and 

family. On the Google Drive website, or on your computer, 
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you can right-click a file or folder, and select the “Share” option 
(in the “Google Drive” submenu on your computer) before 
entering someone’s email address. You can also add a note to be 
included in an email that is sent out.

8 
ADVANCED SHARING OPTIONS

By default, people you share files with can edit them, but 
this can be changed. Having selected the “Share” option, 

C

enter someone’s email address, then click the button to 
the right before deciding whether they should be able 
to view, edit, or comment on the file [Image C]. You can 
also click the “Advanced” link to see other options, such 
as making files publicly available.

9 EDIT FILES ONLINE

Google has a number of online tools to create 
and edit files—including a word processor and a 

spreadsheet. Thanks to these, you can edit files online 
without the need to download them and load them into 
specific programs. Despite being online apps, they are 
surprisingly feature-packed, and you should find that 
you are able to accomplish pretty much everything you 
would expect.

10 GET MORE STORAGE

You are given 15GB of space for free with 
Google Drive, but the time may come when 

you need more—and you need to pay for this. You can 
upgrade your storage by clicking the “Upgrade” link 
in Backup and Sync, or in Google Drive online. You can 
then select the amount of storage you want, and choose 
between paying on a monthly or annual basis. 

1. BACKUP AND SYNC SETTINGS
Configure which folders should be 
synchronized, or opt to back up your 
entire computer.

2. LOCAL GOOGLE DRIVE FOLDER
The contents of the folders you specify 
are synchronized between your PC and 
the cloud.

3. WEB SHORTCUTS
Shortcuts to the web-based version of 
Google Drive, as well as Google Photos 
and your local Drive folder.

4. AVAILABLE SPACE
There is a storage limit to which you 
need to stick. Here, you can see how 
much space you have used up.

5. SYNC UPDATES
Keep an eye on synchronization activity. 
How long files take to sync depends on 
size and connection speed.

6. BACKUP AND SYNC
To synchronize files between your PC 
and Google Drive, you need to have this 
app running in the background.

DIVE INTO GOOGLE DRIVE

1
2

3
4

5

6
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JONNI BIDWELL, CONTRIBUTING EDITOR

OFF-THE-SHELF NAS units are easy to 
come by, but they’re often underpowered, 
overpriced, or otherwise disappointing. 
Many of them run some kind of Linux 
(usually on quite modestly powered ARM 
hardware), and it’s pretty straightforward 
to build a Linux box, and cram it with as 
many hard drives as geometry permits. 
You may even have enough spare parts 
lying around to get most of the way there 
(we did). You don’t need anything special 
hardware-wise (4GB of RAM and a CPU 
sometime from the last decade is fine), 
but several large hard drives help. Many 

consumer-level NAS devices come in 
attractive small form factors, and thanks 
to their low power consumption, don’t 
require noisy cooling. So, we thought 
we’d try our hand at mimicking this.

If the prospect of using Linux makes 
you cringe, don’t worry—we’re going to 
use the fantastic OpenMediaVault, which 
(all going to plan) means you won’t have 
to touch a command line, and everything 
can be controlled from a friendly web 
interface. Next-gen filesystems, RAID, 
and LVM don’t need abstruse incantations 
(or sacrifices) at the terminal. Best of 

all, OpenMediaVault can be customized 
and added to as much as you want. Read 
all about it at www.openmediavault.org. 
The Plex extension (available via the OMV-
Extras.org repository) is particularly 
great, and will turn your NAS into a full-
fledged DAAP media server. Beyond that, 
OMV can run Docker images, so you can 
host any popular Linux application you 
like, whether it’s Nextcloud, Mastodon, 
BitTorrent, or anything else you care to 
name. OMV is also based on Debian Linux, 
so you can do pretty much whatever you’d 
do there with it.

THE CONCEPT

LENGTH OF TIME: 2 HOURS

Home on 
the RAID

LEVEL OF DIFFICULTY: MEDIUM

Build your own NAS box, with stuff you have lying 
around, and the magic of open source
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FRACTAL DESIGN was good enough to send us its Node 304 case 
for this build, which may be an aging model, but we were glamored 
by its teeny-weenyness. It’s surprisingly difficult to find an ITX form 
factor case that can fit lots of hard drives in it; the Node 304 has 
room for six 3.5-inch drives, but is no bigger than two shoeboxes, 
so is ideal for hiding under the stairs. It’s a little tricky to work with 
if you have a large heatsink, but it has excellent airflow, with two 
fans at the front and a large fan at the back. It’s always tempting 
to opt for cheaper components, or even second-hand ones—
and that’s what we did, using an MSI-88X AC motherboard and 
an Athlon A10-7800K APU, circa 2014. Integrated graphics are 
certainly de rigueur here, because this device will probably run 
headless for most of its life. We used three 1TB Hitachi drives and 
a spare 240GB SSD for OMV. This is entirely overkill, because the 
initial installation is only around half a gigabyte, but we can use 
that space for something later. To get OMV installed, we used the 
cross-platform Etcher utility (https://etcher.io) to write the ISO to 
a USB stick. You can download said ISO from the OMV website. 
We got OMV to set our drives up as a RAID 5 array, having a total 
capacity of 2TB, and the ability to rebuild itself if any one of the 
drives fails. Power-wise, we used a Be Quiet! Pure Power 11, 
capable of delivering a totally unnecessary 650W. Again, we just 
used what was to hand, and so can you.

THE FRACTAL DESIGN NODE 304 CASE is small, but 
perfectly formed. It takes a little bit of deft fingerwork 
in places, but if you don’t use a crazy tall heatsink like 
us, there’s actually plenty of room to work with. First, 
remove the thumbscrews and gently slide back the 
case’s hood, before lifting it over the chassis and putting 
it somewhere out of harm’s reach. Next, remove the 
white hard drive caddies, which are each secured with 
two thumbscrews and a top-facing regular screw.  
Before you proceed, look at how the SATA, fan, and ATX 
connectors are arranged on the motherboard, and think 
about how best to route cables. If you’re going to use all 
three drive bays, think very hard about this, because 
it’s difficult to envisage how little space will be left to 
accommodate anything once they’re in place. Remove 
the 140mm fan from the rear of the case, otherwise 
getting the motherboard in will be tricky at best.

WE OPTED TO FIT the CPU and heatsink before interring 
the motherboard in the case. This is usually the best 
way to do things, because it can be tricky accessing the 
heatsink mounting screws from outside. Unfortunately, 
the combination of large heatsink and small case 
made life a little sweary later on; the Node 304 can 
accommodate coolers up to 165mm high, and the Hyper 
212 stands at about 160mm. You’ll want to unclip the 
fan from the heatsink before fitting it, so that it doesn’t 
obstruct access to the mounting screws. Depending 
on your CPU choice, a long screwdriver may be handy, 
because the mounting screws may end up pretty close 
to the (thoughtfully grooved) corners of the heatsink. 
Fitting it to the old FM2+ socket, in particular, required a 
little more force than we were comfortable with, but it’s 
probably easier on newer CPU sockets. Reattach the fan, 
and don’t forget to connect it to the motherboard.

CASE IN POINT A TALL ORDER

INGREDIENTS

PART
STREET 

PRICE

Case Fractal Design Node 304 $82

Motherboard MSI A88XI AC $40  

(pre-owned)

CPU Athlon A10-7800K $50  

(pre-owned)

CPU Cooler Cooler Master Hyper 212 Black Edition $35

GPU Integrated $0

Memory 2x 2GB Corsair XMS3 $30  

(pre-owned)

PSU Be Quiet! 650W $100

Storage (OS) Intel DC S3510 240GB $50  

(pre-owned)

Storage (RAID) 3x Hitachi 1TB drives $105

OS OpenMediaVault $0

Total $492

REUSE AND RECYCLE
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ONCE AGAIN, this should be the correct order of 
proceedings, but it made life a little claustrophobic for 
us in the next step. Fit the PSU and screw it securely 
in place. The PSU’s kettle connector is extended to the 
rear of the case with a well-designed right-angled cable 
that will lie alongside the motherboard. If your PSU’s 
connector is close to its edge, though, this will be a bit 
of a tight fit. Don’t be tempted to fit the PSU upside down 
to work around this—the resulting updraft of hot air into 
the case (actually aimed right at the hard drives) will 
properly mess up the airflow. The connector can handle 
being gently squished, and it may be worth connecting 
it before securing the PSU. Remove the central bar (or 
is it more of a beam?) that until recently held the drive 
trays in place. Fit the four motherboard standoffs in the 
corners, ready to support our tiny motherboard.

MEMORY IS THE EASIEST component to fry, so discharge 
any static you’ve accumulated by grounding yourself on a 
heating pipe (or use an antistatic strap connected to the 
case). Insert the RAM and ensure it’s seated correctly. 
If your motherboard has a speaker, connect it now—its 
beeps may be useful if anything goes awry. Place the 
backplate over the mobo connectors and wrangle the 
motherboard into place. If your SATA data connectors 
are going to be hard to reach after the mobo is interred, 
connect those cables first. Ensure the backplate is fitted 
flush in the case, and screw the mobo in place. If you have 
a modular PSU, plug in the cables you need or discard 
the ones you don’t. You’d run into space issues trying to 
fit a full-length graphics card and a modular PSU.

FIRSTLY ROUTE THE ATX POWER CABLE carefully 
alongside the heatsink and connect it to the motherboard. 
It looks like an alternate route is possible along the top of 
the PSU (beneath the front fans), but our cable was just 
too chunky, and didn’t leave enough room to fit the drives 
atop it. Fit the case connectors (this can be tricky), and 
connect the CPU fan if you haven’t already. Reattach the 
140mm case fan, ensuring the orientation is correct, so 
it will vent hot air from the rear of the case. The two front 
fans connect to two of the three-pin connectors at the 
rear, and all connect to the PSU via the four-pin Molex 
connector at the back. There’s a three-position switch on 
the case to govern fan speeds and balance temperature 
and noise. Make sure the cables don’t interfere with 
any of the fans’ ability to spin; secure them with the 
generously provided miniature cable ties if need be.

EACH HANGING TRAY can hold two drives (2.5 or 3.5-
inch). We only used two of the three trays (with our three 
hard drives and one SSD), which worked out pretty well, 
as it allows some extra breathing (or cable-stuffing) 
space. You’ll need this space if you’re fitting a long 
graphics card, too. It takes a bit of dexterity to fit a second 
3.5-inch drive into each tray, but once you’ve got one 
screw in (use the large-headed ones for 3.5-inch drives), 
it’s straightforward. Just be mindful not to bump drives 
into one another during installation. Once the trays are 
secured, put the lid back on the case, attach a monitor, 
cross your fingers, and power up your glorious NAS box. 
If it works, try to convince it to boot OpenMediaVault from 
a USB stick. The NAS should display its IP address once 
booted, at which point you can log in from your browser.

POWER TRIP OF MEMORY AND MOBO

OUR MANY FANS HARD DRIVIN’
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WELL, THAT WAS FUN. Except for the 
building part. Before you embark on such 
a project, consider this: Do you really need 
a case this small? Life is much easier when 
you have room to breathe. The final build 
was certainly messy, but perhaps with 
a differently arranged motherboard and 
PSU, it would be less of a plastic jungle. 
The fans in the Node 304 aren’t the quietest 
creatures, but with them set on low, noise 
was tolerable, and idle temperatures stayed 
well below 40 C. Incidentally, if on first boot 
OMV tells you that it can’t see the network 
(and the network cable is definitely plugged 
in), it’s possible that DHCP negotiations 
just took a little too long. You can log in 
locally with the username “admin” and 
password “openmediavault” then type 
“ip a” (everything without quotes here) to 
see the correct IP. From then on, you can do 
anything you want by visiting that IP address 
in a browser, and using the slick web 
interface. As is customary with all things 
Linux, reading the relevant documentation 
is a good idea, but your first port of call 
should be “Storage > Disks” to wipe the 
drives (this is especially important if they 
have been involved in a RAID array before), 
and then create your RAID array. You have 
a few choices filesystem-wise—we went 
for traditional Ext4, but on a larger array, 
Btrfs might be a better idea. To be honest, 
we would wait for OMV 5.0 until you did that, 
because it will have much better support 
for the new filesystem’s manifold bells and 

whistles (in particular, its built-in RAID 
pooling and magical self-healing abilities).

It was a shame not to be able to fit the 
case with its full complement of six drives. 
Indeed, it’s possible to run the OS from a 
USB stick, so we could have had a four-
drive array (RAID 6 or 10), with two “hot” 
spare drives. That was all moot thanks to 
our motherboard’s weak offering of just four 
SATA ports. RAID 5 is probably fine for our 
purposes, but on larger (or older) drives, the 
relentless reading that a rebuild (if the array 
fails) necessitates will probably kill another 

drive as well as your redundancy. And by 
extension all your data. Oh yes—RAID is not 
backup, so back up your precious files. It 
left very little room behind the hard drives, 
and with the case full, there probably would 
have been airflow issues. Perhaps a modern 
CPU and smaller cooler (say a Ryzen 
2200G with stock cooling) would be more 
suitable. It would also have been fun to use 
the experimental SnapRAID and MergerFS 
plugins (see June 2019 issue, pg. 17). But in 
the end, we were impressed with OMV, and 
pleased to make use of old hardware. 

NAUGHTY BUT NAS

1  
The Hyper 212 is one of the best 

budget coolers there is, and we 

liked that it just fitted into our case and 

no more. Just being a NAS doesn’t 

require much of the CPU, so it shouldn’t 

generate much heat. We never saw 

temperatures exceed 50 C, which was 

achieved while streaming hi-res movies 

with the Plex plugin.

2
Be Quiet! makes lovely PSUs, but 

650W is far more than we needed—

400W would probably have been fine. 

The fan ends up exhausting a little close 

to the ground, so carpeted floors are no 

friend of this machine.

3
Using old drives like this is a little 

risky, and consumer drives in 

general aren’t meant for serious data 

storage. We just wanted the drives out of 

our main machine, and probably would 

survive if the data on them was lost. OMV 

can monitor SMART statistics, which can 

warn you about impending drive failure.

1

2

3
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THE BUILD-UP to AMD’s launch party for its 
Ryzen 3000 CPUs, aka third-gen Ryzen, 
aka Zen 2, has been huge. The Ryzen 3000 
processors are the first mainstream 
CPUs to utilize a 7nm manufacturing 
process, and after flirting with the crown 
for the first two Ryzen generations, this 
could be the day AMD claims an outright 
victory. Will the Ryzen 9 3900X be the 
best CPU for gaming—and everything 
else? It’s time to find out.

Zen 2 adds an improved L2 TAGE 
branch predictor, has a larger micro-op 
cache, doubles the maximum size of the 
L3 cache, and doubles the AVX floating 
point performance. There’s also a third 
address generation unit, larger buffers, 
multiplication latency is reduced to three 
cycles, and there are wider buses to 
improve bandwidth. PCIe Gen 4 support 
is included, along with changes to the 
Infinity Fabric that links everything 
together, and there are improvements 
in memory compatibility. Wrap all of that 
up in a 7nm bow, then move the memory 
controller out of the main CPU chiplet 
and into a secondary IO chiplet, with 
the option to have dual CPU chiplets on 
higher-tier models. That’s the Ryzen 
3000 family, with the current king of the 
hill being the Ryzen 9 3900X: 24 threads 
spread out over two CPU chiplets. Whew!

So, how does third-gen Ryzen perform? 
That’s the question we’ve been waiting to 
answer for several months. In particular, 
we want to see if AMD can truly close 
the gap. The good news is that gaming 
performance is improved by nearly 10 

AMD’s third-gen Ryzen vies for the CPU throne
AMD Ryzen 9 3900X

9
VERDICT AMD Ryzen 9 3900X

 TO THE NINES Great 
multithreaded performance; 
PCIe Gen 4; comes with an 
excellent Wraith Prism cooler.

 HARD TIMES Still beaten by Intel for 
high-end gaming; not much potential 
for overclocking.

$500, www.amd.com

SPECIFICATIONS

Base/Turbo Clock 3.8/4.6GHz

Cores/Threads 12/24

Lithography 7nm

Cache 64MB L3

Memory Support 128GB DDR4

Memory Channels 2

Max PCIe Lanes 16

Graphics N/A

TDP 105W

AMD Ryzen 9 3900X Intel Core i9-9900K

Blender 2.80 Beta BMW (pps) 4,348 3,281

Cinebench R15 Single/Multi (Index) 203/3,086 221/2,073

POV-Ray 3.7.1 Single/Multi (pps) 516/6,474 624/5,477

Shadow of the Tomb Raider (fps) 128 150

Metro Exodus (fps) 91 95

Division 2 (fps) 145 152

Total War: Warhammer II (fps) 98 108

BENCHMARKS

Best scores are in bold. Our test bed consists of an Asus ROG Crosshair VIII Hero Wi-Fi (X570) motherboard, 16GB 
of G.Skill TridentZ Royal DDR4-3600, an Nvidia GeForce RTX 2080 Ti, and a Gigabyte Aorus NVMe Gen 4 1TB SSD. 
All games are tested at their highest graphical profile, at 1080p.

percent on average relative to the Ryzen 
7 2700X. The bad news is that the Core 
i9-9900K is still about 10 percent faster 
overall. The other good news is that 
the difference in gaming performance 
between AMD and Intel CPUs really only 
matters at 1080p ultra with an RTX 2080 
Ti—maybe you’re aiming for 144fps and 
above. If you run a slightly slower GPU, 
even an RTX 2080 or 2070 Super, the 
gaming performance gap shrinks.

PICKING UP SPEED
That’s not to say that Intel’s CPUs aren’t 
faster—they are. AMD loses in absolute 
gaming performance, again, but not by 
much. We wish that weren’t the case, 
because even if AMD just tied Intel in 
gaming performance, it would make this 
a clean sweep. As it stands, the Zen 2 
architecture improves performance 
compared to Zen+, but doesn’t fully close 
the gaming performance gap.

The other side of the coin is non-
gaming performance, and here AMD 
makes massive inroads against Intel. The 
Core i7-8700K was slower overall than 
the Ryzen 7 2700X last year, which is why 
Intel released the Core i9-9900K. That’s 
an eight-core/16-thread CPU, and going 
up against the 12-core/24-thread Ryzen 
9 3900X, it’s not even close; AMD’s 3900X 
is 21 percent faster than Intel’s Core i9-
9900K, at the same nominal price.

How much do those differences really 
matter? It depends on how you use your 
PC. 3D rendering and video encoding 
aren’t things most people do on a regular 

basis. The reality is that most non-
enthusiasts and non-professionals likely 
wouldn’t notice a difference between 
any of the Core i5/i7/i9 and Ryzen 5/7/9 
products in day-to-day use. We have 
definitely hit a plateau in terms of what 
“typical” people ask of their PCs.

If you’ve been debating between an 
AMD or Intel rig for your next build, AMD 
is the better pick now. You can get 
excellent multithreaded performance, 
gaming performance is close enough 
that only benchmarks or extremely 
competitive gamers would likely notice 
(and then only with an extreme GPU, 
such as a 2080 Ti). Price and features 
are also in AMD’s favor. You get PCIe 
Gen 4, a dedicated x4 PCIe connection 
for your primary M.2 SSD, more cores, 
even lower power use. What’s more, 
you get all of that at equivalent or lower 
prices than you’d pay for Intel. If you’re an 
enthusiast or professional, and your PC 
has a pre-Ryzen AMD or Intel seventh-
gen or earlier CPU, now is a great time to 
upgrade to Ryzen 3000. –JARRED WALTON

in the lab
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The Zen 2 architecture is 
making great strides.
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The grooved shroud with its 
curved section has resulted in 
more than a few “dented” jokes.

in the lab
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AFTER MONTHS OF WAITING and 
speculation, AMD’s Radeon RX 5700 XT is 
finally here, joining the ranks of the best 
graphics cards. Sporting a new RDNA 
architecture that boosts performance 
while reducing power requirements, 
and with a price drop to keep AMD 
competitive with Nvidia’s new RTX 2060 
Super, expectations from the faithful have 
been high. This is AMD’s first new GPU 
architecture since 2012, and the company 
has focused on improving efficiency, 
reworking the Compute Units to boost 
utilization and performance, and shifting 
to TSMC’s 7nm process technology. 

All three RX 5700 models use the 
same Navi 10 GPU, with the 5700 XT cards 
sporting fully enabled chips, while the RX 
5700 disables four CUs and 256 cores. 
Clock speeds also vary, but the GDDR6 
memory in all cases runs at 14Gb/s. The 
new Navi 10 GPUs end up with a die size 
slightly larger than the previous Polaris 
GPUs, with only a few extra CUs. However, 
each CU has been reworked with the new 
RDNA architecture, and the result is that 
even with fewer cores, the RX 5700 XT 
easily outperforms the Vega 64—and 
does so using substantially less power.

AMD says the new cooling is better than 
its previous-generation cards, but we’re 
not fully convinced. It’s not extremely 
loud, but that probably has more to do 
with the lower power requirements than 
any massive change in the cooling design. 
Idle noise and thermals tend to be about 
the same for most GPUs, but playing a 
game is a different matter. Compared to 

A compelling blend of 7nm technology, RDNA 
architecture updates, and a last-minute price drop

AMD Radeon RX 5700 XT

8
VERDICT AMD Radeon RX 5700 XT

 NA’VI More efficient RDNA 
architecture; beats Vega 64 

and 2060 Super; good performance at both 
1080p and 1440p.

 UNOBTAINIUM No ray-tracing support; 
higher temps and power than Nvidia; 
“dented” shroud looks weird.

$400, www.amd.com 

the RTX 2060 Super, the RX 5700 XT runs 
just as quiet, but uses about 25W more 
power, and runs about 11 C hotter.

Just because pricing is the same on the 
RX 5700 XT and RTX 2060 Super, it doesn’t 
mean performance, features, and API 
support are the same. AMD has opted not 
to support ray tracing here—there’s no 
hardware-level RT acceleration and 
no Tensor processing clusters for AI 
and machine learning. Just as critically, 
even though it’s possible to support DXR 
via drivers and shader calculations, AMD 
isn’t doing that either (at least not yet). If 
you want an AMD GPU with hardware DXR 
support, you need to wait for Navi 20.

FAST VS. FEATURES
Performance is close enough that it 
shouldn’t be the overriding factor when 
choosing between AMD and Nvidia. 
AMD is slightly faster and uses slightly 
more power, while Nvidia counters with 
features such as DXR support that AMD 
currently chooses to ignore. The RX 5700 
XT easily handles 1080p ultra and even 
1440p ultra. There may be individual 
games where settings will have to be 
dropped if you want a steady 60fps at 
1440p, but in most games, the 5700 XT 
is hitting 60fps, and in some cases, even 
100fps or more is viable.

There’s plenty to like with AMD’s new 
Navi GPUs and the RDNA architecture. 
Performance and efficiency are 
substantially improved relative to the 
previous-generation Vega and Polaris 
cards. Some of that is thanks to the 

SPECIFICATIONS

GPU Navi 10

Lithography 7nm

Transistor Count 10.3 billion

CUDA Cores 2,560

Texture Units 160

ROPs 64

Core/Boost Clock 1,605/1,905MHz

Memory Capacity & Type 8GB GDDR6

Memory Speed 14GT/s

Memory Bus 256-bit

AMD Radeon RX 5700 XT Nvidia GeForce RTX 2070

Tom Clancy’s The Division 2 (Avg fps) 106/69 100/66

Assassin’s Creed Odyssey (Avg fps) 69/54 66/56

Far Cry 5 (Avg fps) 127/103 125/93

Shadow of the Tomb Raider (Avg fps) 126/97 115/86

Middle Earth: Shadow of War (Avg fps) 107/69 108/77

Metro Exodus (Avg fps) 78/65 77/58

Total War: Warhammer II (Avg fps) 87/67 99/81

BENCHMARKS

Best scores are in bold. Our test bed consists of an Intel Core i7-8700K, 16GB of G.Skill DDR4-3200, a Gigabyte 
Z370 Aorus Gaming 7, and a 1TB Samsung Evo M.2 SSD. All games are tested at their highest graphical profile 
with AA turned on, at 1080p and 1440p respectively. 

7nm manufacturing process, a good 
portion is thanks to the architectural 
improvements, and the reduced launch 
price is certainly a step in the right 
direction. The Navi GPUs have some 
features that could be worth exploring, 
including anti-lag, FidelityFX, and Radeon 
Image Sharpening (for games that don’t 
directly include FidelityFX support).

The good news is that AMD is now 
competitive with Nvidia’s lower-tier 
RTX cards, in both performance and 
pricing. It still can’t touch the RTX 2080 
and 2080 Ti, but it doesn’t really need to 
right now. Some people might be willing 
to spend $700 or $1,200 on an extreme 
graphics card, but far more people will be 
interested in a $350-$400 high-end card. 
For those users, AMD’s Radeon RX 5700 
XT is a welcome addition. You may not get 
fancy ray-tracing support, but if you’ve 
been hoping for a new graphics card 
upgrade that doesn’t require supporting 
Nvidia, this is currently the best AMD 
has to offer, and it’s definitely worth 
considering. –JARRED WALTON
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NINE MONTHS AFTER the RTX 2070 went 
on sale, yields have likely improved and 
Nvidia now has a reason to improve 
performance. The result is the RTX 2070 
Super, moving up to the TU104 GPU with 
additional cores and performance. Silly 
branding aside (seriously, “Super” was 
the best name Nvidia could come up 
with?), there’s not much new to report. 
The GeForce RTX 2070 Super uses the 
same Turing architecture as the existing 
RTX cards, and the summary is that 
additional CUDA cores and higher clock 
speeds make it faster than the outgoing 
RTX 2070. Unlike the vanilla RTX 2060, 
which will remain on sale even though 
there’s an RTX 2060 Super, vanilla 2070 
and 2080 cards are being phased out.

The 2060 Super has the advantage of 
being able to add more memory and thus 
increase bandwidth relative to the vanilla 
2060. The RTX 2070 already uses a fully 
enabled TU106 chip, so Nvidia needs to 
look elsewhere if it’s going to improve 
performance by adding more cores. And 
“elsewhere” means moving to the larger 
TU104 chip that’s also in the RTX 2080.

The RTX 2070 Super’s reference boost 
clock is 1,770MHz, which is higher than 
even the overclocked 2070 Founders 
Edition boost clock of 1,710MHz. Since 
the 2070 Super has the same memory 
bandwidth and configuration, in practice 
the performance improvement ends up 
being around 10–15 percent.

The good news is that any added 
performance relative to the RTX 2070 

A modest boost to performance

Nvidia GeForce RTX 
2070 Super

8
VERDICT Nvidia GeForce RTX 2070 Super 

 SUPER Close to a 2080 for 
less money; no more Founders 

Edition premium; same Turing features.

 POOPER Only slightly faster than an RTX 
2070; nothing new to see here; Nvidia still 
needs a killer RTX game.

$500, www.nvidia.com 

SPECIFICATIONS

GPU Turing TU104

Lithography TSMC 12nm FinFET

Transistor Count 13.6 billion

CUDA Cores 2,560

Texture Units 160

ROPs 64

Core/Boost Clock 1,605/1,770MHz

Memory Capacity & Type 8GB GDDR6

Memory Speed 14GT/s

Memory Bus 256-bit

Nvidia GeForce RTX 2070 Super Nvidia GeForce RTX 2070

Tom Clancy’s The Division 2 (Avg fps) 117/78 100/66

Assassin’s Creed Odyssey (Avg fps) 69/57 66/56

Far Cry 5 (Avg fps) 131/103 125/93

Shadow of the Tomb Raider (Avg fps) 127/93 115/86

Middle Earth: Shadow of War (Avg fps) 114/83 108/77

Metro Exodus (Avg fps) 88/67 77/58

Total War: Warhammer II (Avg fps) 101/83 99/81

BENCHMARKS

Best scores are in bold. Our test bed consists of an Intel Core i7-8700K, 16GB of G.Skill DDR4-3200, a Gigabyte 
Z370 Aorus Gaming 7, and a 1TB Samsung Evo M.2 SSD. All games are tested at their highest graphical profile 
with AA turned on, at 1080p and 1440p respectively. 

comes without an accompanying increase 
in price. Even the 2070 Super Founders 
Edition sticks with a base price of $499. 
Of course, RTX 2070 cards have gone on 
sale for as little as $450 over the past 
nine months, but we’ll probably see the 
Super cards sell for less than the launch 
price at some point.

Performance is pretty much as 
expected. The 2070 Super is 6 percent 
faster than the 2070 FE at 1080p 
medium, but many games are hitting CPU 
bottlenecks. Only the most demanding 
games can’t reach 144fps average frame 
rates. 1080p ultra drops performance 
by about a third on average compared 
to 1080p medium, but the RTX 2070 
Super remains comfortably above 
60fps. Compared to the 2070 FE, it’s now 
8 percent faster overall, which would 
make it about 15 percent faster than a 
reference clocked RTX 2070. It continues 
to perform well at 1440p ultra. Finally, 
at 4K ultra, the performance advantage 
over the 2070 FE increases to 10 percent.

Not surprisingly, keeping frame rates 
above 60fps at 4K ultra proves very 
difficult—not even the Titan RTX and RTX 
2080 Ti can manage that feat in some 
games. If you’re serious about gaming 
at 4K, you’ll also want to plan on running 
high or even medium settings in some 
games if you want smooth performance. 
There’s nothing too surprising about 
the RTX 2070 Super. Enable a few more 
cores, increase clock speeds, and you 
get improved performance. It’s also 

only 5–10 percent slower than the RTX 
2080 (although the 2080 Super will 
change that).

In terms of value, the 2070 Super is a 
great option for people looking to build 
a high-end gaming PC. For those who 
haven’t felt the need to upgrade to one 
of Nvidia’s RTX cards already, though, 
we don’t think the 2070 Super is going 
to change things. The bigger issue is the 
future adoption of ray tracing by games 
and game engines. Maybe you don’t 
think you’ll ever want to play a game 
with DXR ray-tracing effects enabled, 
but at least you have that option with an 
Nvidia GPU. We’re likely still years away 
from widespread ray-tracing use within 
games, but the number of upcoming 
titles that support Nvidia’s RTX cards 
keeps growing. If you can keep using 
your current card a while longer, that’s 
almost always better than plunking down 
a wad of cash on a graphics card upgrade. 
And when the time comes to move on, 
there will inevitably be something better, 
faster, or cheaper. –JARRED WALTON 

in the lab
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There’s no Founders 
Edition premium 

here—you can buy 
this card direct 

from Nvidia.
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THIS ISN’T SOMETHING that we’d normally 
review. It’s not a component, nor a game, 
nor is it a full-fledged multi-thousand-
dollar gaming rig. But it’s undeniable 
that the Raspberry Pi has only been 
improving in recent years, getting ever 
closer to becoming a proper desktop 
computer in its own right. The Pi 4 
Model B is the newest iteration in the 
Raspberry Pi saga, taking the product 
from a basic programming education 
tool to a genuinely brilliant little PC.

All the software remains backward 
compatible, as does the shape of the 
little board itself; the Pi 4 can be easily 
dropped into any existing projects you 
might have if you’re a Pi fanatic. The 
hardware also represents a significant 
step up. The processor is a 1.5GHz quad-
core Cortex-A72 from Broadcom, an 
upgrade from the 1.4GHz A53 chip in the 
Pi 3 B+, while graphics are handled by 
VideoCore VI, as opposed to VideoCore IV. 
This enables the Pi 4 to support 4K 
resolution at 60Hz, or at lower refresh 
rates across two monitors at once.

The biggest step up is the RAM: While 
the Pi 3 B+ offered 1GB of LPDDR2, the 
Pi 4 comes in 1GB, 2GB, and 4GB models, 
all in low-power DDR4. We’ve got the 
4GB version in for review, which costs 
$55, but if you’re looking for a more 
budget version, the 1GB will only set 
you back $35. This version of the Pi is 
more capable than previous models—
not quite able to fully replace a desktop, 
but expanding significantly on the 
possibilities presented by previous 
models. The 40-pin GPIO header from 
the Raspberry Pi 3 returns, too, ready for 
expansion and building purposes.

If you want to get going straight away, 
there’s also a “desktop kit” available 
for $120. This comes packing a 4GB 
Pi 4 Model B with Raspbian Buster pre-
installed on a 16GB microSD card, two 

Everyone’s 
favorite tiny 
computer is 
back—and it’s 
better than ever

Raspberry Pi 4 
Model B

9
VERDICT Raspberry Pi 4 Model B 4GB

 LIFE OF PI Huge hardware 
improvements; 4K and dual-
monitor support; USB 3.0 ports.

 BLOWING RASPBERRIES USB-C 
power supply issues; struggles with high-
res video playback.

$55, www.raspberrypi.org

SPECIFICATIONS

Processor Broadcom BCM2711 
Cortex-A72

Graphics VideoCore VI with OpenGL  
ES 1.1, 2.0, 3.0

Memory 4GB LPDDR4

Ports
 
 

2x USB 3.0, 2x USB 2.0,  
2x Micro HDMI, 1x Ethernet, 
1x 3.5mm AVI, 1x MIPI DSI, 
1x MIPI CSI

Connectivity Bluetooth 5.0, dual-band 
802.11 Wi-Fi

Power 
Requirements

 
3A, 5V

Dimensions 3.4 x 2.2 inches

Weight 0.1lb

1m Micro HDMI to HDMI cables, a USB-C 
power supply, a hefty printed beginner’s 
guide, and a little plastic case for 
containing your Pi. It also comes with a 
wired keyboard and mouse in the quaint 
white and pink colors of the Pi. They’re 
well-branded enough that our editor 
mistook the Pi case itself for the mouse 
during testing, briefly perplexed as to 
why the cursor wasn’t moving.

PORT-ENTOUS
With full Gigabit Ethernet, onboard 
Bluetooth 5.0, and two ports supporting 
USB 3.0, the physical device itself is 
better than ever. Video is delivered via two 
Micro HDMI ports, and there’s a USB-C 
port for power supply. Unfortunately, a 
hardware design flaw means that some 
smart charge cables will identify the 
Pi 4 as an audio device, and fail to supply 
power. While this is likely to be fixed at 
some point, it’s something to bear in 
mind if you’re looking to purchase a Pi 4 
soon (or buy the $8 power cable at the 
same time).

The teething problems don’t end 
there, either. Raspbian Buster, the OS for 
Pi devices, has been updated for Pi 4, and 
while the OS itself functions as expected, 
there are numerous pieces of software 
that currently refuse to work properly. 
Some Python libraries are incompatible 
with the new version of the OS, while 
programs such as the popular Retropie 
fail to run at all. These are problems 
that will be fixed in the not too distant 
future, though. Retropie’s developers 
have already stated that they are working 
on a new version of the software for Pi 4, 
and the Raspberry Pi Foundation itself 

is committed to continual updating and 
improvement of the OS. As such, we 
won’t hold it against the Pi 4 for now. Any 
new product is likely to encounter some 
post-launch software issues, and we can 
expect them to be ironed out in time. With 
that in mind, we feel pretty happy giving 
the Pi 4 a kick-ass rating; it’s the best the 
Raspberry Pi has ever been, and we can’t 
wait to see what crazy things people do 
with it. –CHRISTIAN GUYTON
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Acer’s new 27-inch 4K gaming 
panel ditches full-array local 
dimming, but it’s still pricey.

in the lab
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FOR PROOF THAT the gaming monitor 
market is in total overdrive, look no 
further than the new Acer Predator XB3. 
It looks like a high-end precision panel for 
content product pros, with its sober suit 
and three-sided glare-reduction hood. 
But no, this is a full-on gaming panel, and 
just one of three such monitors Acer now 
sells in the 4K 27-inch segment.

The XB3 represents the tweener in the 
trio, above the Nitro XV3 and below the 
Predator X27. All three offer ostensibly 
the same proposition: a 27-inch 4K IPS 
panel with 144Hz refresh and adaptive 
sync. But drill down into the details, and 
you’ll discover why the XV3 is yours for 
$899, the X27 goes for around $1,650, and 
this XB3 model lands at $1,299. 

Compared to the megabucks X27, the 
big downgrade with the XB3 is hinted at 
by the HDR400 spec versus the X27’s 
HDR1000. The numbers imply a big gap in 
outright brightness—400 nits for the XB3 
and 1,000 nits for the X27. But arguably the 
really significant difference is the XB3’s 
lack of full-array local dimming. The X27 
has a 384-zone backlight, a feature that’s 
complex and expensive. The new XB3 has 
a big, dumb, conventional backlight.

In practice, however, local dimming 
is overhyped. At least, early iterations 
have proved underwhelming. Moreover, 
local dimming tech, and HDR support in 
general, is only relevant for HDR content. 
Granted, there are at least 60-plus PC 
games that support HDR, including 
everything from Fortnite to Far Cry 5, 
Forza, and Final Fantasy XV, but HDR is 
far from ubiquitous. For the record, the 
XB3’s main advantage over the cheaper 
XV3 is full-spec Nvidia G-Sync rather than 
AMD FreeSync adaptive refresh tech.

Anywho, fire the XB3 up in SDR mode, 
and it’s pretty much a dead ringer for the 
X27. So, the immediate impression is of 
plenty of pop and highly saturated colors, 
plus the tight pixel pitch that comes 
with a 3840x2160 native resolution on a 
relatively compact 27-inch panel.

The default factory calibration is a 
little wonky, with notable compression at 
the top end of the white scale, but that’s 
easily dialed out, and the OSD menu is 
nothing if not comprehensive. 

The 144Hz experience is as sweet as 
ever, even if you need one heck of a GPU to 

Acer makes 4K, HDR, and 144Hz 
IPS goodness a tiny bit cheaper

Acer Predator XB3

8
VERDICT Acer Predator XB3

 GAME CHANGER Fabulous 
4K IPS panel; superb combo 

of speed and precision.

 GAME OVER Small for price; not true HDR.

$1,299, www.acer.com 

SPECIFICATIONS

Panel Size 27-inch

Native Resolution 3840x2160

Pixel Density 163 ppi

Panel Type IPS

Maximum Refresh 144Hz

Response 4ms

Contrast 1,000:1

Display Inputs DisplayPort, HDMI

Connectivity USB-A hub

VESA Mount 100 x 100mm

Warranty Three years

make the most of it. Subjectively, there’s 
zero input lag, and the pixel response in 
the lower range of the overdrive options 
is quick enough, and doesn’t introduce 
any inverse ghosting nasties.

It’s a damn fine gaming experience. 
If we have reservations, it’s the scale of 
the proposition. At this money, you have 
a lot of options, many of them bigger 
and bolder. Ultimately, it’s a question of 
preference. If you like the wraparound 
feel of a big, curved ultrawide monitor, 
this conventional 27-incher with a flat 16:9 
panel could seem dowdy. But go bigger 
and wider, and you lose sharpness, detail, 
and precision. Until 8K gaming at 120Hz-
plus becomes realistic, you’re going to 
have to make a compromise somewhere.

What else? The all-plastic chassis 
looks and feels cheap, plasticky, and 
anonymous, especially at this price. The 
bar of configurable “mood” LEDs along 
the bottom of the lower bezel don’t help 
much with that. The antiglare hood is a 
dubious accessory, too. On the plus side, 
it’s easy to fit, but it doesn’t do a great deal 
to reduce glare or improve aesthetics. 
The lack of USB-C is a downer for laptop-
based gamers, too. –JEREMY LAIRD
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Get set for gaming on the 
go with the Triton 500.

in the lab
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ONE OF THE FIRST things we did upon 
unboxing Acer’s newest gaming laptop 
was fire up the included software, 
PredatorSense (which, for some reason, 
has its own dedicated button on the 
keyboard). Like many programs of its 
type, PredatorSense collates a suite of 
tools useful to gamers: fan controls, 
automatic overclocking functions, 
temperature and voltage monitors, and 
so on. The first feature to catch our eye 
was the fan boost function, so of course 
we merrily clicked the “Max Speed” 
button. Oh, there it goes—the Triton 500 
has launched itself out of the window, 
propelled by its almighty GPU fans.

So yes, it can be a bit loud. But 
that’s only if you’re really stressing the 
hardware. For day-to-day operation, we 
found that this laptop is actually fairly 
quiet—impressive, given that our review 
unit comes packing a GeForce RTX 
2060 Max-Q and 16GB of dual-channel 
RAM. An RTX 2080 Max-Q version with 
twice the memory is also available, 
but at an appropriately steeper price. 
The model we’ve got is still a capable 
gaming machine, Nvidia’s Max-Q 
design only clocking in slightly below 
the desktop variant of the RTX 2060, 
while implementing superior thermal 
design and improved efficiency. For 
storage, it’s fitted with a 512GB M.2 
drive, guaranteeing speedy load times in 
games. The eighth-gen Core i7 processor 
in this machine is nothing out of the 
ordinary, but it gets the job done.

In terms of physical design, the Triton 
500 is easy on the eye. Acer’s Predator 
brand logo illuminates on the rear of the 

Ready to go on the hunt...
Acer Predator Triton 500

8
VERDICT Acer Predator Triton 500 

PT515-51-71VV

 STALKING PREY Solid 
performance; pleasingly thin design; 
multi-monitor support.

 NOT TODAY Automatic overclocking lacks 
luster; noisy fans; a little pricey.

$1,800, www.acer.com 

SPECIFICATIONS

CPU Intel Core i7-8750H

Graphics Nvidia GeForce RTX 2060 Max-Q

RAM 16GB DDR4-2666

Screen 15.6-inch 1080p @ 144Hz

Storage 512GB PCIe NVMe M.2 SSD

Ports Thunderbolt 3, 3x USB 3.1, 
HDMI, Mini DisplayPort, audio

Connectivity Gigabit Ethernet, 802.11ac, 
Bluetooth 5.0

Weight 4.4lb

Size 14.1 x 10 x 0.7 inchesOur laptop zero-point is the Asus GL502VS-DS71, with an Intel Core i7-7700HQ CPU, 8GB GTX 1070, and 16GB of 
DDR4. All game tests are performed at 1080p at the highest graphical profile.

BENCHMARKS
ZERO- 
POINT

Cinebench R15 Multi (Index) 743 1,030  (39%)  

CrystalDisk QD32  
Sequential Read (MB/s)

563 3,374  (499%)

CrystalDisk QD32  
Sequential Write (MB/s)

133 2,530  (1,802%)

3DMark: Fire Strike (Index) 13,202 13,610  (3%)

Rise of the Tomb Raider (fps) 99 92  (-7%)

Total War: Warhammer II (fps) 62 62  (0%)

Tom Clancy’s Ghost Recon: 
Wildlands (fps)

48    49  (2%)

0% 10% 20% 30% 40%  50% 60% 70% 80% 90% 100%

screen, while the backlit keyboard can 
be customized with an assortment of 
multicolored effects. In case you were in 
any doubt that this was a gaming laptop, 
the WASD and arrow keys are constructed 
from translucent blue plastic, as opposed 
to the clean white of the other keys. 
There’s a huge amount of ventilation—on 
the sides, base, rear, and just above the 
keyboard—so while it might run loud, 
those fans are working hard to dissipate 
heat. On the whole, this laptop is well put 
together; it feels sturdy, but it’s lighter 
and thinner than many of its ilk.

SCREEN TEST
The screen is undeniably a delight. It’s a 
1080p, 15.6-inch display, not the biggest 
we’ve seen, but comfortable enough for 
gaming on the go. Acer is quite proud 
to tout the 81.3 percent screen-to-body 
ratio, although the more impressive 
feature is the 144Hz refresh rate with 
3ms Overdrive response time—perfect 
for fast-paced gaming. In practice, the 
screen is clear and sharp, showing 
both shadows and vibrant colors well. 
If the display isn’t to your liking, though, 
there’s support for up to three additional 
monitors via HDMI, Mini DisplayPort, and 
Thunderbolt 3 connections.

The included automatic overclocking 
functions in the PredatorSense menu do 
make a difference to performance, but 
it’s fairly minimal. Running 3DMark’s 
Fire Strike benchmarking software at the 
“Extreme” overclocking preset resulted 
in a score only 5 percent higher than the 
non-overclocked mode. The difference 
in noise was extremely noticeable, 

however. The overclocking presets are 
also only available while the laptop is 
plugged in to an external power source, 
but this isn’t really a deal-breaker.

There are a few annoying quirks of 
the Triton 500’s design. For instance, the 
power button is located on the keyboard, 
just to the right of the delete key, making 
it all too easy to potentially hit in the heat 
of an intense competitive match [stop 
flaying so much—Ed]. There’s a “Turbo” 
button located just above the keyboard for 
instant overclocking, but it’s a bit finicky; 
our tests demonstrated that while the 
function improved performance in some 
games, it had little to no effect in others. 
The integrated webcam also doesn’t have 
any physical security features, which is 
frustrating in a world of potential digital 
security risks.

It might be starting to sound like we 
don’t like the Triton 500; that couldn’t be 
further from the truth. These criticisms 
are minor imperfections, like scuff marks 
on the armrests of a comfortable couch. 
The Triton 500 feels good to use, plain and 
simple. It’s not cheap, but if you’re looking 
for a reliable gaming laptop, this could be 
the way to go. –CHRISTIAN GUYTON
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RAZER HAS NOT NECESSARILY been quick 
in updating its heavy-hitting Blade Pro 
line—we last saw it a good two years 
ago—but the jump to RTX cards is 
far from a straight component swap. 
Outwardly, things have been significantly 
redesigned, with the soft-edged heft of 
the previous model replaced by a far 
more slimline body, both thinner and less 
wide than before, which brings the Blade 
Pro 17 into design line with the rest of 
the company’s laptop pack. Not that the 
guts have been ignored; things have been 
seriously cooked up, in terms of both 
the RTX 2080 and hex-core i7-9750H in 
our review model, and strengthening its 
position as a laptop for people who love 
games, speed, and spending wads of cash 
in equal measure. This is a refresh, sure, 
but it’s definitely a new Blade Pro. The 
real question is whether it’s a success.

That visual upgrade certainly works 
in its favor. The bezel of the previous 
version has been chopped down to such 
an extent that it’s hard to believe this 
carries a 17.3-inch panel; the closed 
case has a slick, unfussy profile that 
earns the “Pro” moniker about as handily 
as the specs do. There are downsides to 
the more conventional design—the RGB-
ringed right-mounted touchpad of the 
previous generation has been swapped 
out for a boring (but pleasant) centrally-
aligned glass number, the keyboard is 
no longer mechanical, and there’s no 
volume roller, but the now centralized 
RGB-lit keyboard allows more room for a 

The Blade Pro is dead, long live the Blade Pro!
Razer Blade Pro 17 (2019)

8
VERDICT Razer Blade Pro 17 (2019)

 RAZER-THIN Gorgeous chassis 
redesign; great screen; 

effective cooling; excellent speed.

 HEAVYWEIGHT Extremely expensive;  
some features lost.

$3,119, www.razer.com 

SPECIFICATIONS

CPU Intel Core i7-9750H

Graphics Nvidia GeForce RTX 2080 Max-Q

RAM 16GB dual-channel  
DDR4 2,667MHz

Screen 17.3-inch, 144Hz IPS

Storage 512GB NVMe SSD

Ports 
 

3x USB 3.2, USB-C, 
Thunderbolt 3 (USB-C),  
SD reader, 3.5mm audio

Connectivity 2.5Gb Ethernet, 802.11ax Wi-Fi, 
Bluetooth 5.0

Weight 6lb 1oz

Size 0.78 x 10.24 x 15.55 inchesOur laptop zero-point is the Asus GL502VS-DS71, with an Intel Core i7-7700HQ CPU, 8GB GTX 1070, and 16GB of 
DDR4. All game tests are performed at 1080p and the highest graphical profile.

BENCHMARKS
ZERO- 
POINT

Cinebench R15 Multi (Index) 743 922  (24%)  

CrystalDisk QD32  
Sequential Read (MB/s)

563 3,228  (473%)

CrystalDisk QD32  
Sequential Write (MB/s)

133 1,969 (1,380%)

3DMark: Fire Strike (Index) 13,202 17,244  (31%)

Rise of the Tomb Raider (fps) 99 113  (14%)

Total War: Warhammer II (fps) 62 80  (29%)

Tom Clancy’s Ghost Recon: 
Wildlands (fps)

48    62  (29%)

0% 10% 20% 30% 40%  50% 60% 70% 80% 90% 100%

pair of up-firing speakers, which belt out 
audio with impressive weight.

Between the bezels sits a matte 
FHD 144Hz IPS panel, which is initially 
baffling. Considering that both Razer’s 
13 and 15-inch flagships carry 4K panels, 
and this carries the “Pro” moniker, we’d 
have thought it a natural choice for a 
greater resolution than 1080p. Truthfully, 
we’re not all that offended by the screen, 
though: It’s bright, viewing angles are 
good, colors are absolutely awesome, 
and the 144Hz refresh rate is frequently 
tested, given the power that’s driving it. 
A comparatively lower resolution might 
make this a lesser work machine, but it 
does wonders for its gaming potential.

VAPOR TRAIL 
Forsaking wacky cooling designs, such 
as the pop-up ventilation seen on the 
Asus Zephyrus, and indeed shunning the 
large rear-mounted exhaust ports on 
offer from most other manufacturers, 
Razer has instead employed an internal 
vapor cooling system, which pulls in air 
from the front of the base, and outputs 
it through a pair of inconspicuous vents 
at the rear. It’s tidy, certainly, though the 
four fans can get loud under heavy load. 
Bringing the heat is a ninth-gen Core i7-
9750H running at 2.6GHz; continuing the 
theme of what Razer could have done, 
there’s little doubt that a Core i9 could 
have been made to work and thrown out 
half as much performance again, but 
there’s no true reason for one to be there 

beyond luxury. This is a snappy enough 
chip for the job at hand.

The company has also (predictably) 
opted to put the graphics in the hands of 
the dialed-back Max-Q design of the RTX 
2080, clocked at a boost of 1,230MHz. 
That’s a good drop in speed from the 
desktop equivalent, but comparing 
its benchmark results to the similarly 
specced Asus Zephyrus S GX701GX shows 
that Razer’s smaller, lighter cooling 
solution doesn’t mean more throttling—
the numbers here are almost identical, 
sometimes a touch better, and gaming on 
the Razer Blade Pro 17 is a true joy. 

Although the price is somewhat 
horrific, Razer at least knows that this 
is an investment, making upgrading the 
RAM and storage options easy should you 
wish, and including 802.11ax wireless, 
USB 3.2, and a 2.5Gb Ethernet port for 
some forward-thinking connectivity. 
That’s the capper to a redesign which, 
while lesser in some ways to its 
predecessor, results in one of the most 
handsome and capable big-screen 
laptops we’ve ever seen. –ALEX COX

in the lab
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Sharper edges, tight design. It’s 
hard not to love the Blade Pro.
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CAST YOUR MIND BACK one whole issue, and 
you’ll remember our review of Logitech’s 
G502 Lightspeed, a tremendous wireless 
reimagining of a mouse design, which 
has attracted enough reverence to stay a 
top-line choice for many years. Corsair’s 
Nightsword isn’t a G502, but boy, would 
it like to be. It’s laid out in almost 
precisely the same way in terms of 
buttons and thumb shelf, it also features 
customizable weighting, and Corsair’s 
engineers are no doubt looking very 
pleased with themselves for besting the 
G502’s ludicrous 16,000 dpi sensor with 
an even sillier 18,000 dpi eye, last spotted 
in Corsair’s Ironclaw wireless mouse.

As much as we’d like to shove this aside 
as some kind of wannabe clone of the 
king, though, it’s also very much its own 
beast. It avoids some of the pitfalls the 
G502 fell into. Notably, the scroll wheel, 
which eschews switchable freewheeling 
for a comfortably resistant notched-
only mechanism, is a whole lot better 
than that of its rival. The button layout is 
slightly closer, meaning less stretching 
and more in-the-moment immediacy. 
The shell is just slightly wider, and the 
thumb cradle a little deeper, making this 
more suited to larger hands. 

It also doesn’t do certain things quite 
as well. Despite its size, it seems to have 
been built, as is tradition, for a cartoon 
world in which little fingers do not exist. 
You’ll be trailing yours on the desk. While 
there’s a huge DPI-slashing sniper button, 
the Nightsword’s upper side buttons 
are tapered to a point, making them 
indistinct and difficult to press. There 
are no side-click functions on the scroll 
wheel, which is nestled slightly lower in 
the shell than is entirely comfortable. 
And the weighting is concentrated on a 
single cluster around the sensor, rather 
than being spread over the whole body of 
the mouse. Whether the idea of mouse 
balance is a placebo or not, the fact is 
that placebos can work if you’re told they 
do—and the Nightsword is smart enough 

Live by the sword,  
die by the Nightsword

Corsair  
Nightsword RGB

8
VERDICT Corsair Nightsword RGB

 NIGHTSWORD Great lighting; 
mostly comfortable design; 

outrageous sensor; clever weighting.

 NIGHT SOIL Some awkward buttons and 
positioning; reasonably expensive.

$80, www.corsair.com

SPECIFICATIONS

Sensor Optical

Sensitivity 18,000 dpi

Sensor Model Pixart PMW3391

Polling Rate 1,000Hz

Programmable Buttons 10

LEDs RGB, four-zone

Cable Length 6 feet

Weight 4.05–4.83oz

to recognize which weights have been 
put where, with Corsair’s iCue software 
working out the center of mass, as well 
as helping to manage macros, lighting, 
and surface calibration.

For a moment, though, let’s stop 
comparing apples to apples, and look at 
this fruit on its own. The Nightsword is 
an exceptionally pretty mouse, with RGB 
lighting delightfully presented through 
one palm light, from deep within the 
scroll wheel chasm, and through seven 
translucent windows around its base. 
These are covered in a circle-cut mesh, 
which (while entirely pointless) does add 
to the premium feel. It’s heavily textured, 
with everything but the buttons on the 
top shell stippled for grip, some stickyish 
rubber grips on either side, and those 
main buttons (which are well dished 
and feel just great) are independent of 
the shell. It’s also pretty chunky—even 
unburdened by the optional weights, the 
Nightsword is at the heavier end of 
the mouse spectrum.

In the guts we’ve got gaming-standard 
Omron switches, which we can’t complain 
about one bit, and the Nightsword’s 
sensor didn’t falter even slightly in our 
tests. Neither did we expect it to. It’s a 
custom version of a Pixart PMW3391, 
and it’s great. There’s no need to drive it 
as hard as it’ll go, unless you’re a lunatic 
with particularly exact wrist control, but 
it’s perfect at lower resolutions, copes 
well with black and reflective surfaces, 

and the adjustable lift height means it's 
suitable for anyone’s style. We’re not 
going to say the Nightsword is better 
than the G502, because that’s a pinnacle 
mouse at a far higher price. We can’t 
even call it better than the Ironclaw from 
which much of its hardware has been 
culled; it’s probably on equal footing 
with its sibling. But the Nightsword is, 
in its own right, a quality, smart, and 
comfortable mouse with some serious 
chops—niggles be damned. –ALEX COX
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THE HEADSET MARKET has changed a 
lot in the past few years, spurred on by 
streamers and YouTubers, and by the 
increasing popularity of esports. You 
know this, of course. But does Roccat?

We ask because this new Noz headset 
feels like a great budget offering from, 
well, a few years back now. Yes, it’s 
unfussy and affordably priced, and it 
certainly has its plus points. But we can’t 
help but think back to the days of Vine, 
ice bucket challenge videos, and Miley 
Cyrus’s foam finger when we use the 
Noz. It would have earned an appreciative 
budget recommendation not so long ago, 
but times have changed.

Let’s start with the spec sheet. There’s 
certainly nothing wrong with the 50mm 
neodymium magnet drivers on paper, 
as they offer a 10Hz–20KHz frequency 
response, and have enough size to power 
an authoritative low end. Going beyond 
the usual 20Hz–20KHz range brings 
real benefits to the sound, although it’s 
not specced out for hi-res audio. Those 
extra 10Hz way down beyond the limits 
of human hearing give the Noz’s drivers 
the power to add thumping subharmonic 
bass frequencies you can really feel, 
even if you can’t technically hear them.

At just 7.4oz, it’s also an incredibly 
light headset, and we couldn’t be happier 
that RGB lighting is an increasingly rare 
feature on headsets now—one area that 
the unintentionally throwback Noz feels 
bang on trend with. It’s a decent looking 
headset for the price, unfussy and 
restrained, even compared to Roccat’s 
pricier Khan. 

At the back of the left-hand closed-
back earcup, you’ll find a mic mute switch 
and a volume thumbwheel, while at the 
other end of the cable, separate mic-in 
and audio-in mini-jacks can be combined 
into a single input. And, really, that’s 
the long and short of the Noz’s offering. 
Again, there’s nothing inherently wrong 
with keeping things simple.

The trouble starts with the sound. 
In fact, momentarily before that. When 
you first don the Noz, you’ll notice 
that “seashell effect” as the earcups 
close in over your ears. It’s slight—just 

Budget-oriented cans 
with serious low 
end—hot or Noz?

Roccat Noz

6
VERDICT Roccat Noz

 ROCCAT ROLL Good bass 
response; restrained design.

 JUST SAY NOZ Muddy sound; seashell 
effect when worn.

$55, http://en.roccat.org

SPECIFICATIONS

Driver Type 50mm neodymium

Frequency Response 10Hz–20KHz

Design Style Closed back

Microphone Type Electret condenser

Weight 7.4oz

Connectivity Mini-jack

Cord Length 8 feet

a faint muffled reverberation as you 
hear outside noise—but it’s there. Not 
to labor the point, but this used to be a 
problem we listened out for in headsets 
in 2012. Somewhere along the timeline, 
manufacturers cracked it with better 
contact-point materials, better earcup 
shapes, and a better fit using smarter 
hinges. But it’s crept back in, just to a 
faintly perceptible degree, with the Noz.

And that affects the sound when you 
press play, be that in games, music, or 
movies. There’s an imprecise character 
that colors the overall sound, especially 
noticeable in speech, which really is a 
shame, because Roccat is more than 
capable of delivering great-sounding, 
precise audio. Its higher-end Khan 
cans suffer none of the above issues, 
supporting hi-res audio, and bringing out 
more rumble and sparkle in compressed 
sound in the process. It hasn’t dripped 
down to this set. 

More’s the shame, because that’s 
really our only grumble with this model. 
Sure, it may not feel luxurious against 
your head, but we’ve endured much, 
much worse below the $60 price point, 
and it’s obvious that careful design and 
construction material selection has 
gone into this lightweight and adjustable 
design. It may not be the coolest or most 
breathable headset we’ve tested, but it 

stays comfortable for hours thanks again 
to that skinny design and ample padding. 

Can we recommend it? Not as it is. It 
feels one iteration away from genuine 
go-to budget headset contention. It 
doesn’t sound like the driver architecture 
is at fault, but something about the shape 
and fit of the earcup chamber. You could 
do worse for the price, but Corsair’s 
sub-$75 offerings give a clearer, more 
precise sound. –PHIL IWANIUK

in the lab

88 MAXIMUMPC maximumpc.comSEP 2019



THE COMMANDER C35 is a big ’un. While 
it’s only a standard ATX mid-tower case, 
it weighs a lot more than some of its 
counterparts, thanks to the steel and 
tempered glass. Yet when we peel off the 
protective film on the glass window and 
peek inside, we’re not overly impressed.

There are a lot of visible screw points 
inside, along with the exposed circuit 
board of the front I/O, giving the initial 
appearance a slapdash look. It looks a 
bit better once we’ve assembled a build 
inside, but only marginally. The PSU 
shroud helps, concealing a lot of the 
potential mess under a layer of painted 
black steel. It’s nothing new, though. 
Indeed, it’s hard to see exactly what the 
C35 brings to the table when compared to 
other cases. It’s not cheap, which forces 
it to justify its price tag with features that 
set it aside from the competition.

The most eye-catching of these are 
the two large ARGB fans mounted in the 
front. At 200mm, they are beefier than 
anything you’d normally consider for 
case airflow. The front of the case has an 
integrated dust filter behind the hexagon-
patterned plastic panel, too. The on-
board fan control unit connects to an RGB 
control button on the front I/O, allowing 
for quick customization of your PC’s color 
scheme. These fans can sync with RGB 
tech from other manufacturers, enabling 
smooth color co-ordination. The fans 
are noisy at full speed, however. Their 
cabling is strangely long and winding 
inside the case, too, leaving a lot of slack 
to be managed—strange, considering 
that they come built into the case.

At the rear, there's another fan: a 
basic 120mm affair. No fancy lighting 
here, then. In fact, the rear fan looks 
annoyingly basic compared to the high-
quality materials in the rest of the case; 
a cheap orange sticker bearing the 
Thermaltake logo almost adds insult to 
injury. There’s ample space for fitting 
radiators, at least. The roof can take a 

Introducing the 
Commander-in-Grief

Thermaltake 
Commander 
C35

7
VERDICT Thermaltake Commander C35

 COMMAND Powerful front 
case fans; good ARGB features; 

plenty of clearance.

 UNMANNED Loud fans; heavy and bulky; 
limited front I/O; unattractive interior.

$110, www.thermaltake.com

SPECIFICATIONS

Form Factor Mid-tower

Motherboard Support ATX, mATX, ITX

Colors Available Black

Window Available Yes

3.5-Inch Support 3

2.5-Inch Support 5

Radiator Support 360mm front, 280mm 
roof, 120mm rear

Fan Support 2x 200mm front,  
2x 140mm roof,  
1x 120mm rear

Dimensions 18.2 x 9.2 x 21 inches

Graphics Card 
Clearance

16.1 inches (12.2 with 
coolant reservoir)

CPU Tower Clearance 7.1 inches

Weight 17.3lb

radiator with two 140mm fans, and the 
front can take another two 140mm fans, 
or three 120mm fans instead. Fitting a 
radiator to the front of the case demands 
a lot of work, though, as the fitted 200mm 
fans need to be removed first. Ideally, this 
case would suit a straightforward AIO-
cooled build utilizing 280mm of radiator 
space in the ceiling. So, it’s functional—
but not particularly impressive.

Drive storage options are scattered 
haphazardly around. There are two flat 
mounts of 2.5-inch SSDs on the rear of 
the motherboard plate, which should be 
familiar to any seasoned system builder. 
The 3.5-inch HDD mounting panels 
(which can also accommodate a 2.5-inch 
drive, if preferred), on the other hand, are 
divided; two are positioned on the rear of 
the plate below the I/O, to the front of the 
case, but one sits flat on the bottom, 
behind the front fans. A large hole is cut 
in the PSU shroud to allow access, but it 
just results in a huge amount of negative 
space that is difficult to use effectively. 
A reservoir can be mounted in this hole 
for liquid-cooled custom loops, but 
otherwise it’s poor use of space. A drive 
cage could have been fitted here instead, 
allowing for additional HDD storage 
space, while still leaving room for a 
coolant reservoir on top.

There are other concerns, too. The 
mounting pegs that support the PSU are 
hard plastic, not the rubber or foam we’ve 
seen in other cases to mitigate noise from 
vibrations. The RGB control button on the 
front I/O feels oddly cheap compared 
to the satisfying click of the power and 

reset buttons, and the I/O only supports 
two USB 3.0 Type-A connectors. Cable 
management is at least straightforward, 
thanks to plenty of clips to secure cables. 
On the whole, it’s not terrible; it’s just 
hard to see what the C35 offers that we 
can’t get elsewhere. –CHRISTIAN GUYTON 
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Contains very little actual romance
Total War: Three Kingdoms
AFTER THE STRIPPED-BACK nature of 
Thrones of Britannia comes the full-fat, 
heavyweight, no-holds-barred game. 
Three Kingdoms is as expansive as the 
name suggests, taking inspiration from a 
14th-century historical novel chronicling 
the events at the end of the Han dynasty 
and the steps toward Chinese unification.

The Romance of the Three Kingdoms 
novel contains nearly 1,000 characters 
and 800,000 words, and it feels like the 
game does, too. On the surface is the 
classic Total War structure: a turn-based 
strategy game in which armies and 
generals prowl the map, capturing cities 
and building them up, before rooting out 
enemies and rebellions, and a real-time 
tactical battle game when armies clash.

You’re offered a choice: Do you play 
in Records mode, in which generals and 
other characters are quite powerful but 
need retinues of bodyguards to fight 
for them, or Romance mode, in which 
generals are supermen, capable of 
flattening an entire regiment of archers, 
and more politically astute characters 
can foment a war out of thin air? Romance 
mode feels more like the way the game 
is intended to be played, all the playful 
manipulations and Tekken-like one-
on-one battles adding so much to the 

Battles are huge melees, but 
superpowered characters add 
visual interest.

down with a well-designed army while 
your cavalry mop up archers and wheel 
around to slam into the back of enemy 
infantry. The focus on characters means 
the loss of a general is strongly felt, 
but it almost seems a shame to send a 
regiment after an enemy leader when you 
could send one of your own and watch the 
fireworks of a duel.

This series constantly evolves, 
never afraid to cut back or embrace 
new settings. The return to history—
albeit a fictionalized version of it—after 
the Warhammer games has led to the 
developer throwing everything it can 
at Three Kingdoms. It’s a huge game, 
completely open-ended, and with enough 
starting positions that you’ll need a few 
centuries free to complete it. –IAN EVENDEN

experience on both maps. How long will 
it be before we can take direct control of 
our general as he (or she) duels with an 
enemy leader, picking up a gamepad to 
tap out combos and special moves?

For Warhammer or Britannia veterans, 
this is slower, as you spend more time on 
the strategy map and in the diplomacy 
screens—where a new button works out 
what it will take to get what you want from 
the other side, removing the need to make 
leaps in the dark. Now it’s clear: gold, 
trade goods, and a daughter in return for 
a defensive alliance? Fine. Just beware 
that daughter doesn’t come back in 10 
turns as a high-powered enemy general.

The focus on individual characters may 
be an even larger change than the return 
of the game’s full systems. You’re asked 
to choose a character at the beginning, 
your choice dictating starting position 
and difficulty. From then on, you’re not 
fighting other factions as much as other 
leaders, looking at their personality traits 
along with the disposition of their armies. 

Things feel more familiar on the 
battlefield. The camera system hasn’t 
changed, you still get some time to deploy 
before the battle begins, making use of 
the terrain, and the enemy AI is still 
straightforward enough to bog infantry 

Total War: Three Kingdoms

 ASPIRANT Sharply rendered 
mass battles with eye-catching 

character duels.

 TYRANT Needs a monster system to play 
at 4K at Ultra 60fps.

 RECOMMENDED SPECS i5-6600/Ryzen 5 
2600X; 8GB RAM; GTX 970/R9 Fury X.

$60, www.totalwar.com, ESRB: T
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AIs can still scream in space
Observation
BRING HER. That’s all you’re told. But 
where? And why? The strange force 
interfering with the self-aware AI of the 
space station Observation, whisking it 
across the solar system and making all 
but one of its crew disappear, couldn’t 
possibly have nefarious intent, could it? 

Despite there being one human still 
alive on the Observation, it’s the AI you 
play as, seeing and interacting with the 
world through security cameras in a rare 
example of a second-person game. 

It’s a subtle backdrop for a sci-fi 
thriller, almost silent apart from the hum 
of life support, and the click and whir of 
the cameras. Fisher, the surviving crew 
member, fights fires and carries out 
repairs with SAM the AI’s help, getting 
you to open hatches and vent fumes. You 
jump between cameras, your point of view 
limited to their positions and arcs. 

The cameras provide a distinctive 
visual style, as interference and distortion 
course across the feed. Exterior cameras 
allow you to inspect the outside of the 
station, the feeling of being millimeters 
away from the void almost tangible. 
Sections in which you fly freely through 
the station in a camera sphere allow the 
naturalistic lighting to shine, the cramped 
Observation and the calm flatness of 

the luckiest are those who can dedicate 
a day-long session to it. An AI should be 
unfeeling, but an AI played by a human 
can never be that way. When you fail 
Fisher, locking her out after a glitchy 
voice print analysis, or just failing to open 
a hatch on her count of three, you feel bad 
because you care about her, and don’t 
want her to end up as just another frozen, 
floating piece of space debris. 

And that’s Observation’s genius. The 
relationship between Fisher and SAM is 
a strong one, much like that between the 
characters of Lone Echo. And by setting 
simple goals, with complex solutions, 
against a background of austere white 
spaces as labyrinthine as the plot, it 
foregrounds the relationship in a hugely 
satisfying way. –IAN EVENDEN

Fisher is the focus of the 
game, but playing as SAM 
gives you more flexibility.

SAM’s voice bringing to mind everything 
from 2001 to Moon to Event Horizon. 

Some jobs are beyond Fisher, and SAM 
must go in alone. The Observation has a 
series of computer systems to manage its 
complex workings, and while some tasks, 
such as correctly firing jets to jettison a 
damaged portion of the station to save the 
rest, are a game of skill against the clock, 
others are more puzzle-like. 

Occasionally, the game falls down in 
its signposting, the interactive object in 
the room not remotely clear, and Fisher 
chiding you as you sweep around with the 
camera. The thought of an AI sitting frozen 
in front of a puzzle, trying to grasp its 
mechanics the same way a human player 
would, can shake you out of the moment, 
but the puzzles are well designed, and the 
game is a patient teacher. 

Exploring is a must, both to find clues 
to help complete the puzzles, and to dig 
out audio logs and other background 
information on the station’s crew. It 
is possible to get lost, but a system of 
waypoints helps you to get around. 

The plot takes you from uneasy 
suspense to actual horror, your limited 
power to interact with the world doing 
much to ramp up the tension. It’s not a 
long game, but it does keep you playing—

Observation

 OBSERVED Fascinating plot 
and characters drag you in.

 RESERVED Too little signposting at times; 
easy to get frustrated.

 RECOMMENDED SPECS Core i5-6600K 
3.5GHz/Ryzen 3 2200G; 8GB RAM; Radeon 
RX 570 8GB/GeForce GTX 960 4GB.

$25, www.observationgame.com, ESRB: M
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The past month has been 
busy in the hardware testing 
labs. Between AMD’s RX 
5700 series, third-gen Ryzen, 
and Nvidia RTX Super cards, 
I’ve had my plate more than 
full. Ryzen looks good, but 
gaming performance still 
trails Intel by a small margin. 
The bigger problem has been 
AMD’s launch drivers (19.7.1) 
for the graphics cards. We 

Nvidia releases new RTX 
Super cards, AMD drops the 
prices of its new GPUs just 
before they hit shelves, and 
Intel announces it will have 
7nm chips by 2021—I’ve been 
enjoying this subtle yet not so 
subtle “we gotta one-up each 
other” war. But I feel bad for 
those who bought a 20-series 
right before the Supers were 
announced; the 2060 Super 

ran into several performance 
anomalies—a nice way of 
saying that we encountered 
driver bugs and performance 
regressions. It’s not clear 
what happened, but the 19.5.2 
drivers were about 5–10 
percent faster than 19.7.1 
with an RX 590. Let’s hope it’s 
sorted soon, as another 10 
percent out of the 5700 cards 
would be awesome.

has on-par performance with 
the 2070 for $100 less. The 
2070 Super’s performance is 
nearly the same as the 2080 
for $200 less. Of course, price 
varies from manufacturer 
to manufacturer, but the 
entire Super line, when 
comparing MSRP and 
performance to the original 
cards, makes the 20-series 
feel unnecessarily bloated.

JARRED WALTON 
Senior Editor

JOANNA NELIUS 
Hardware Staff Writer

EVER BUILT A PC in a cardboard box? OK, 
what I’m talking about today isn’t exactly a 
full PC build, but it was a fully functioning 
PC, and it lived in a giant cardboard box.

I’m not usually the one to do our CPU 
testing and reviews, but due to a number 
of unforeseen complications—namely 
Jarred planning a family vacation and then 
us finding out AMD’s Ryzen 3000 parts 
would be launching in the middle of it—I 
found myself the unlikely benchmarker of 
the Ryzen 7 3700X and Ryzen 9 3900X. As 
I’m not a regular CPU tester (and I work 
from home), I don’t have a full test bench 
area set up for the purpose. So, when AMD 
sent me the Ryzen parts to benchmark, I 
had to make do with what was available: 
the very box they shipped in. 

You can see the cardboard test bench I 
assembled in the image, above-right. Sure, 

it’s not pretty, but it got the job done. And 
when I say “job,” I mostly mean keeping 
my cats from pouncing on the extremely 
tantalizing spinning fans and sparkling 
lights. (Side note: AMD’s Wraith coolers 

are very pretty.) My 
test bench—er, box—
served its purpose, 
though. I would run 
benchmarks by day, 
then close the top flaps 
to keep cats out at 
night. Never mind that 
the whole thing was 
probably a huge fire 
hazard (for the record, 

I did keep it well ventilated while on, and 
unplugged while boxed up). Thankfully, my 
cardboard misadventures didn’t set back 
the testing process at all, and we had our 
Ryzen 3000 reviews ready for launch. 

If you don’t have a spare case, use what’s available

Cardboard 
Benchmark

She may not look like 
much, but she’s got it 
where it counts.

BO MOORE, HARDWARE LEAD
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THIS IS MORE THAN just a soundbar. 
The Sonos Beam is a wireless, 
voice-controlled speaker, capable of 
pumping out brilliant sound quality 
that fills a room or even a house. It’s 
packing four drivers, five amps, and a 
tweeter, laid out along the front of the 
bar to maximize range. There are five 
microphones, which can pick up voice 
commands from across a room, even 
while your music is blaring.

One of the biggest draws of the 
Beam is its ability to play music from 
virtually any source. Whether it’s your 
phone or tablet, a network-connected 
drive, or your streaming service of 
choice (Spotify and Apple Music are 
obviously supported, but the Beam can 
also link to Tidal, Amazon Prime Music, 
Deezer, and more), this bar has got you 
covered. Of course, it can link to your 
TV or monitor, too, and dialogue jumps 
out with exceptional quality. 

The Beam is easy to set up, supports 
HDMI for TV connectivity, and can be 
synched to Amazon Alexa devices for 
more in-depth voice control. iPhone 
users can also connect directly to it, 
and use their phone to issue commands 
to the Beam. The Beam connects to 
other Sonos products as well, should 
you wish to build a network of sonic 
mastery in your home.

Considering that it’s relatively small 
(though weighty—you could knock 
someone out cold with this thing), the 
depth of bass is incredible. We were 
almost afraid of turning the Beam up to 
its maximum volume, lest we disturb 
the neighbors. –CG
$399, www.sonos.com

VSDC FREE VIDEO 

EDITOR

I recently found myself 
needing to pull some 
old cine footage that 
had been transferred 

to DVDs. For numerous reasons, my 
normal video editor no longer worked, so 
I needed to find a tool (preferably free) that 
would help me complete the task in the 
kind of tight deadline that is completely 
normal for such things. After trying a 
few that either failed to see the files, 
produced corrupted images, or had the 
kind of interfaces that needed more time 
to master than I had, I settled on VSDC. 

The interface comes from the intuitive, 
no-nonsense school of design. I was able 
to skip around the movie easily, and pick 
out the parts I needed. It did take a couple of 
attempts to get the output settings spot on, 
but once done, the quality was excellent, 
and the files sizes were manageable (not 
something that could be said of some of 
the programs I tried using). 

Overall, I was impressed with how this 
tool performed. While I was very focused 
on a tight subset of what you’d usually want 
to do with a video editor, VSDC handled 
what was needed and was intuitive enough 
that I’ve left it on my machine for more 
fiddling when I get a few free moments. 
Free, www.videosoftdev.com

HUNT: SHOWDOWN

Thanks to a recent free 
event, I gave Crytek’s 
Hunt: Showdown a go. 
It’s a strange beast, 
blending elements of 

horror, shooter, and battle royale games to 
produce a tense, atmospheric jaunt across 
the marshlands of 1800s Louisiana. It 
doesn’t actually feel like a Crytek game, 
apart from the savage demands it puts 
upon your GPU. Even on the trusty 1070 Ti, 
the game really struggled at max settings.

Graphical fidelity aside, is it fun? Yes, 
but stressful. The gameplay is slow and 
ponderous, punctuated by brief bursts 
of intense action. Ten players are tasked 
with hunting a powerful demonic creature 
before escaping with the loot. Death is 
permanent, so the game demands that you 
recruit new hunters and outfit them with 
gear between sorties. Each hunter also 
levels up independently, unlocking helpful 
new perks as they grow stronger.

The catch? You’re all after the same 
beastie, and there’s nothing to stop you 
gunning down your fellow hunters. Weaker 
monsters roam the map, barely a threat, 
but depleting your limited ammunition. 
And you don’t have to fight; you can venture 
out for a quick recon, then depart the 
match with your loot—and life—intact.
$30, www.huntshowdown.com

Sonos Beam 
Soundbar

Executive editor, Alan Dexter, and staff writer, Christian 
Guyton, have been hunting for free software this month

Editors’ Picks:  
Digital Discoveries
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comments you write, we respond

WE TACKLE TOUGH READER QUESTIONS ON...

94 SEP 2019 maximumpc.comMAXIMUMPC

↘ submit your questions to: comments@maximumpc.com

Cool Winners
I am writing about your 
“Head to Head” article 
comparing cooling options. 
The bottom text shows the 
winner for each category. 
Clearly, “Air” cooling wins 
three of the five categories. 
The “All-in-One” one wins 
once (actually, it tied once). 

Yet, you rate the “All-in-
One” as the winner. How 
can this be possible?

This is a contradiction—
why would you bother 
rating each category, then 
override your own rating?

–Jacob Simpson

EXECUTIVE EDITOR, ALAN 

DEXTER, RESPONDS:

While this may be a little 
confusing initially, if you 
turn your eyes to the “And 
the winner is…” box on the 
pages in question, you’ll 
find that we addressed 
this very issue, and 
explained why we favor 
all-in-one setups over air 
cooling. We don’t attribute 
equal weighting to the 
categories, or simply add 
up the wins; it comes down 
to what we feel is the best 
option overall. We break 
these head-to-heads into 
categories, so that if one 
area is more important 
to you, you can focus on 

that—if you’re mainly 
after performance, for 
example, a custom loop is 
your best option. All three 
methods of cooling have 
their place, and there’s 
absolutely nothing wrong 
with air cooling (or, indeed, 
custom loops), but given 
the choice, we would 
recommend an all-in-one 
for the reasons stated. 

Color Accuracy 
A while back, you had a 
tutorial explaining how 
to use the basic version 
of the Datacolor Spyder5. 
For someone who would 
not only want to create 
a custom setting in their 
PC, but also calibrate 
the display itself (in this 
case, an HDTV, that would 
eventually be upgraded to 
a 4K UHD TV) via its own 
color management settings 
to accommodate multiple 
inputs (gaming consoles, 
TV, and so on), would the 
Datacolor Spyder5PRO be 
a better choice? Or would 
you instead recommend 
the X-Rite i1Display Pro 
or X-Rite ColorMunki 
Display? And, if I upgrade 
to a projector, would any 
of these choices work (I’m 
assuming the Spyder5PRO 
would not), or would I need 

to look at a completely 
different calibration tool?

–Julian Parrilla Grajales

EXECUTIVE EDITOR, ALAN 

DEXTER, RESPONDS:

Hardware calibration 
devices are predominantly 
used by photographers 
and designers who need 
to ensure the images 
they’re working on can be 
accurately replicated—
particularly useful when 
it comes to printing 
out the final image. Given 
the professional remit, 
it should come as no 
surprise that such devices 
command a premium 
(the SpyderX Studio costs 
$500), although older 
units can be picked up for 
much less—which would 
be our recommendation if 
you’re not a professional 
image fiddler. 

As to which of the ones 
you’ve listed is better, that 
largely comes down to 
what you can afford, your 
experience using them, the 
level of support needed, 
speed of operation, and 
what you’re actually using 
it for—the SpyderX Elite 
supports calibrating for 
motion work, for instance. 

Projectors are a slightly 
different ball game, as 

a traditional calibration 
device sits on the display’s 
surface, which in this 
case means it’ll block the 
image you’re trying to 
calibrate. The good news 
is that the latest models 
allow for this: The SpyderX 
Elite can be mounted in 
front of the screen on a 
stand, and can allow for 
the resultant shadow, 
while the X-Rite i1Display 
Pro and ColorMunki can 
calibrate projectors by 
placing them much further 
away, although we suspect 
the SpyderX quality will be 
better in this instance.

4K Video Editing
I want to build a desktop to 
monitor 4K videos off my 
Mavic 2 Pro drone. I didn’t 
see anything current when 
I searched the archives. 
Do you have a component 
list for a good build? I was 
thinking somewhere from 
$1,500 to $2,000 without 
monitor(s), if that will do a 
good job. –Larry Pence

EXECUTIVE EDITOR, ALAN 

DEXTER, RESPONDS: We’ll 
look at piecing together 
a rig like this in a future 
“Build It,” but if you’re 
eager to get building, our 
recommendations would 

> Best Coolers
> Screen Calibration
> Windows Security
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be a fast processor with 
plenty of cores, and as 
much RAM as you can 
muster; at least 32GB 
(64GB would be ideal). 
A graphics card could 
potentially help out on the 
rendering front, depending 
on the software you use, 
plus plenty of storage. 
Our mid-range build at the 
back of the magazine, with 
a lot more RAM, isn’t a bad 
place to start. 

Security as Standard
I need help determining 
how to build my next PC for 
Microsoft’s “Standards for 
a highly secure Windows 10 
device.” You have probably 
seen the Windows Security 
settings, but under “Device 
Security,” Windows tells 
you how it manages the 
security that is built into 
your device.

I’ve spent time looking 
around for motherboards 
that can support everything 
Microsoft wants in order 
to hit all of the security 
requirements, but I don’t 
want to pay many dollars 
and be disappointed that 
the product doesn’t check 
all of the requirements.

This is where I think 
you can help—you most 
likely have access to all 
kinds of motherboards 
and hard drives, so you 
can test them to see what 
Microsoft Windows 10 
is going to check in the 
“Device Security” section. 
There is also a question of 
BIOS settings that I’m not 
too familiar with, so maybe 
you can help with that also. 
This might be a good article 
for your readers.

Here is the link from 
Microsoft: https://docs.
microsoft.com/en-us/
windows-hardware/design/
device-experiences/oem-
highly-secure.
 –Gary Kalwaytis

STAFF WRITER, CHRISTIAN 

GUYTON, RESPONDS: When 
it comes to hardware 
security, it’s a lot more 
straightforward than it may 
initially seem. Essentially, 

the motherboard needs 
to be equipped with a 
connector for a Trusted 
Platform Module 2.0 
(most recently released 
mobos have one) and UEFI 
MAT compatibility. The 
BIOS needs to be fully 
up to date and equipped 
with an eighth or ninth-
generation Intel processor, 
or an eighth-gen or later 
AMD chip. All the security 
settings (including secure 
boot) need to be enabled in 
the BIOS. The system also 
needs to have an activated 
and up-to-date copy of 
Windows 10 installed, to 
ensure that Data Execution 
Protection can function 
properly. In the “Device 
Security” tab of Windows 
settings, “Core Isolation” 
must be running and 
“Memory Integrity” must 
be turned on.

Retro Pleasure
I wanted to let you know 
how much I enjoyed John 
Knight’s “So Retro!” article 
in the June issue. It was 

refreshing to read an 
article for the sheer joy 
of reading something, 
and learning some very 
interesting history, versus 
reading an article for 
research for a potential 
future purchase or build, 
to help troubleshoot a 
problem, or to learn about 
a utility I’ve never heard of 
before and how to use it.

It’s not that I don’t find 
these types of articles 
helpful, because I do, 
and they are the main 
reason I subscribe to your 
magazine. In fact, the 
majority of my purchases 
and utilities I use are 
a result of articles or 
reviews in your magazine. 
However, it was nice to read 
an article primarily for 
pleasure. It was also nice 
because, being an older 
reader, I grew up seeing 
the systems he talked 
about come to market and I 
owned a couple of them.

It was ironic that right 
after reading the article, I 
saw a two-hour program on 

the History channel titled 
Game Changers: Inside 
the Video Game Wars. 
Although the program 
focus was different from 
John’s article, it mentioned 
a couple of the gaming 
systems that his article 
talked about. It was nice 
to have some “insider 
knowledge” about these 
systems prior to watching 
the History channel show.

Kudos to John, for such 
an interesting article, 
and to your magazine for 
publishing it.

–Michael Craddock

EXECUTIVE EDITOR, ALAN 

DEXTER, RESPONDS: We 
do try to mix entertaining 
reads alongside the more 
traditionally beneficial 
pieces, so we’re glad you 
enjoyed it. For those of us 
of a certain age, taking 
a trip down memory 
lane with the benefit of 
hindsight makes for an 
interesting perspective. 

Red Shift
I downloaded RedShiftGUI 
to my Windows 10 1903, but 
it doesn’t work. I tried all 
the compatibility settings 
possible, but no go. What 
type of system did you get 
this “old” dog to run on?

–Derek Hamilton

EXECUTIVE EDITOR, ALAN 

DEXTER, RESPONDS: We’ve 
just tried this on three 
PCs in the office, and had 
no problems with any of 
them, including my system 
running the latest Insider 
build. Without more 
information, we’re limited 
in how to respond, but we 
can recommend another 
course of action, albeit one 
that isn’t so user-friendly. 
Windows 10 comes with its 
own blue-light-banishing 
tool, called Night Light. 
Select “Settings” from 
the “Start” menu, click 
“System,” and you’ll find 
the option to turn on Night 
Light under the “Display” 
menu. Control how and 
when it works by clicking 
the Night Light settings. 

[NOW ONLINE]

NVIDIA LAUNCHES A FRAME 
RATE CAPTURE TOOL FOR 
EASY GPU BENCHMARKING

Integrated power measurement sets this one apart. So, 
you did your research and figured out which is the best 
graphics card for your setup, bought it, and installed it in 
your PC. Now what? Playing games is the natural thing to 
do at this point, and a new frame rate capture tool from 
Nvidia will help you analyze performance to make sure 
your shiny new card is working as it should be.

It's called FrameView, and it’s essentially a modified 
version of PresentMon, with some extra features added 
by Nvidia. For example, you can track power usage with 
FrameView, but you can’t in utilities like FRAPS and AMD’s 
OCAT (Open Capture and Analytics), so it’s a nifty perk.

Read the full article: https://bit.ly/2XGQJUe 
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WE DIDN’T REALLY WANT to admit it, but yes, an AIO cooler for this 
build was overkill. We’re out to make some savings this month, and 
a pricey cooling solution represented the perfect place to trim the 
fat in this build. To that end, we’ve opted for AMD’s high-end air 
cooler, the Wraith Max, which comes with RGB lighting and near-
silent fan operation, while still providing sufficient heat dissipation 
for all but the most savage of overclocking attempts. We’re putting 
that cooler on to a different board, too: the MSI B450M Gaming 
Plus, a slight upgrade from last month’s B450-A for just two 
dollars more. The key change here, though, is going from Nvidia 
to AMD with our graphics card. For no extra cost, the RX 5700 
provides slightly better performance and an extra 2GB of VRAM for 
your system. Right now, it comes bundled with a three-month pass 
for Xbox Game Pass on PC, too.

CHANGES ACROSS THE BOARD were minimal for the budget build this 
month, so it’s unlikely you’ll see much difference in performance. 
The key alteration was the switch from the conventional Ryzen 5 
2600 to the 2600X version, with its expanded overclocking 
potential. The 2600X was inexplicably cheaper this month, even 
though neither item was on sale with any of the big online retailers. 
The max boost frequency is 0.3GHz higher, and despite swapping 
out to Geil’s Evo Potenza RAM, the overall performance should be 
slightly superior to last month’s setup. The 2600X also comes with 
a beefier cooling solution; the AMD Wraith Stealth is replaced by 
the taller Wraith Spire. We’ve also shifted from Gigabyte to EVGA 
on the GPU front; we’re down from two fans to one, and the boost 
clock is a little less impressive, but the EVGA GTX 1660 XC Black is 
quieter and currently the cheapest GTX 1660 card on the market.

INGREDIENTS INGREDIENTS

PART  PRICE

Case Fractal Design Meshify C $90

PSU 550W Cooler Master MasterWatt 550  
80+ Bronze                                                                    

 
$55

Mobo MSI B450M Gaming Plus                                 NEW $102

CPU AMD Ryzen 7 2700 $200

Cooler AMD Wraith Max                                                          NEW $40  

GPU Sapphire Radeon RX 5700 8GB                       NEW $350

RAM 16GB (2x 8GB) Team T-Force Vulcan Z  
@ 3,200MT/s                                                         NEW

 
$70

SSD 250GB Samsung 970 Evo Plus M.2 PCIe $75

HDD 1TB Seagate Constellation ES 3.5-inch $36 

OS Windows 10 Home 64-bit OEM $100

PART  PRICE

Case BitFenix Nova TG $85

PSU Corsair VS450 80+ White 450W                       NEW                   $42

Mobo ASRock B450M R4.0 AM4 $65

CPU AMD Ryzen 5 2600X                                             NEW $160

GPU EVGA GeForce GTX 1660 XC Black 6GB         NEW $220

RAM 8GB (2x 4GB) Geil Evo Potenza  
@ 3,000MT/s                                                           NEW

 
$37

SSD 120GB Crucial BX500 2.5-inch $20

HDD 1TB Seagate Constellation ES 3.5-inch $36

OS Ubuntu Desktop Linux 18.04 LTS 64-bit $15

Approximate Price:                                             $1,118Approximate Price:                                              $680

MID-RANGEBUDGET
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For more of our component recommendations,  
visit www.pcgamer.com/hardware/buying-guides/ Approximate Price:                                             $2,676

INGREDIENTS

PART  PRICE

Case NZXT H700i $190

PSU 850W Corsair TX-M Series 80+ Gold  $110

Mobo ASRock X399 Phantom Gaming 6 $240

CPU AMD Threadripper 2950X $830

Cooler Cooler Master MasterLiquid ML360  
RGB AIO 

 
$130

GPU Zotac Gaming GeForce RTX 2080 8GB       NEW $620

RAM  32GB (2x 16GB) Ballistix Sport LT Red  
@ 3,200MT/s                                                       NEW                                  

 
$156 

SSD 500GB Samsung 970 Evo M.2 NVMe        NEW $140

HDD 2x 3TB Seagate BarraCuda Compute $160

OS Windows 10 Home 64-bit OEM $100

AT THE TIME OF WRITING, we didn’t have access to the RTX 2080 Super 
cards—expect to see one in this build next issue. For now, though, 
Zotac’s twin-fan offering of the original RTX 2080 is significantly 
discounted, so we’ll be swapping to that from last month’s MSI GPU 
to save a sweet 80 dollaroos. Given the 2080 Super will have the 
same baseline price point as the 2080, and won’t be likely to go on 
sale anytime soon, snapping up a discounted high-end card like this 
is a good call right now.

While the Gigabyte Aorus RGB SSD remains great value, we 
decided to use the spare cash from the GPU to splash out, going 
for Samsung’s 970 Evo M.2 drive. While we lost 12GB of storage, 
Samsung remains the king of SSD write speeds, netting us an extra 
300MB/s of maximum transfer rate for just $20 extra. We’ve also 
changed up the RAM, going with Ballistix for a small saving.

As usual, there’s no call to trade out our CPU and motherboard 
here. ASRock’s Phantom Gaming 6 has been the best-value X399 
mobo in the game for a while, and Threadripper prices are staying 
stalwart, even in the face of Ryzen 9. Upgrading the processor 
in this build would throw a significant price hike into the overall 
system; bear in mind that if you’ve got the extra 400 to upgrade to 
the 2970WX, splashing out at extra 80 on a superior motherboard is 
almost always a worthy investment.

UPGRADE OF THE MONTH

The RX 5700 XT might have been the star AMD card this 
issue, but its little brother shouldn’t be disregarded. We’ll 
touch more on the RX 5700 next month, with a full review, 
but for now, just be assured that it’s a quality GPU that 
modestly outperforms the GeForce RTX 2060 for exactly 
the same price. That’s all that needs to be said; gains 
only range from 5–15 percent with various games and 
graphical settings, but that’s an improvement that costs 
not one dollar more. Sapphire is a trusted manufacturer 
of Radeon GPUs—XFX and Asus are good options, too. 
$350, www.sapphiretech.com

SAPPHIRE RADEON RX 5700
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